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17CCU102         INTRODUCTION TO INFORMATION TECHNOLOGY      

 

Course Objective:  

 To equip the students with the basics of computer, operating system, software, MS Office soft 

ware and internet and email. It will enable the students to use MS Office software for different 

documentation purposes. 

Learning Outcomes: 

 To know about the various concepts of information technology. 

 To enable the students to learn about the various functions in information technology. 

 To understand the various applications and information process in information technology. 

 

Unit I 

Introduction to computers: definition, characteristics and limitations of computers – Components of 

Computer System – Elements of Computers – Hardware – Software – Input and Output devices – storage 

devices. 

 

Unit II  

Operating system: Operating systems – Meaning, Definition, Functions and Types of Operating Systems 

– Booting process – Disk Operating System: Internal and External Commands -wild card characters – 

Computer virus, Cryptology. Windows operating system – Desktop, Start menu, Control Panel, Windows 

Accessories. 
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Unit III 

MS Office: Ms Word – Meaning – Word Processing – Meaning and Features of Word Processing – 

Advantages and Applications of Word Processing – Toolbars – Creating, Saving and Closing a document 

– Moving and copying text – Text and Paragraph formatting, Applying Bullets and Numbering. 

 

Unit IV 

Ms Excel: Meaning – Features of MS Excel – Insertion and Deletion of Worksheet – Entering and editing 

data in worksheet – Cell range – Formatting – Auto Fill – Formulas and its disadvantages. 

MS Power Point: Meaning – Slides – Creation of Slides – Slide Sorter, Slide Show, Slide Number, Slide 

Design, Slide Layout, Slide Show – View Show Set up Show, Custom Animation, Slide Transition.  

 

Unit V 

Internet, E- Commerce and E-Mail: E-Commerce: Meaning, Advantages and limitations, Application 

of e-commerce – E-mail – Creation of e-mail Id – Group communication – Tele conferencing – Video 

Conferencing – File Exchange – Bandwidth – Modem – Network Topologies – Network Types LAN, 

MAN, WAN and their architecture – Dial Up access. 

 

Suggested Readings:  

Text Book:  

1. Peter Norton. (2017) Introduction to Computers, [7th Edition]. Mc Graw Hill Company New 

Delhi.  

Reference Books:  

1. Rajaraman V. (2013). Introduction to Information Technology. [2nd Edition]. New Delhi: 

Prentice Hall of India.  

2. Rajaraman V. (2014) Fundamentals of Computers [6th Edition]. New Delhi:Prentice Hall of 

India.  

3. Deepak Bharihoke.(2012).Fundamentals of Information Technology. [Kindle Edition]. New 

Delhi: Excel Books.  

Websites:  

 W1:http://www.tutorialspoint.com/computer-components/  

 W2:http://www.cram.com/computer/devices/  

 W3:http://www.computer-pdf.com/operating -system/  

 W4:http://www.scribd.com/MS Office  

 W5:http://www.excel_easy.com/basic.Msexcel  

 W6:http://www.networkingabasics.net 

http://www.tutorialspoint.com/computer-components/
http://www.cram.com/computer/devices/
http://www.computer-pdf.com/operating -system/
http://www.excel_easy.com/basic.Msexcel
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DEPARTMENT OF COMMERCE(CA) 

 
LECTURE PLAN 

 
SUBJECT   : INTRODUCTION TO INFORMATION TECHNOLOGY 
SEMESTER   : I                                   
SUBJECT CODE: 17CCU102                                          CLASS         :    I B.COM CA 

 
 

UNIT – I 

Sl No. Lecture 

Duration 

(Hour) 

 
Topics to be Covered 

 
Support 

Materials 

 
1 

1 

Introduction to Computers: 
 Definition 

Characteristics of Computers 
 Speed, Accuracy, Diligence, 

Versatility, Storage capacity 

T1:1-5 R3:9-15 

W1 

 
2 

1 

 
Limitations of Computers 

 Expense, Power, Intelligence, 
Decision, Commonsense 

T1:1-5 
R5:6-8 W1 

3 1 
Components of computer system 

 CPU, Motherboard, Memory 
T1:14-20,w1 

R2:17- 21, W2 

4 1 
 Input devices, Output devices, 

Storage devices 
W2, W4 

5 1 
Elements of Computer System 

 Control, Memory, Input, Output, 
Buses 

T1:20-26 W4 

 
6 

 
1 

Hardware: Definition 
 Power supply, Monitor, CPU  

 
W3 7 1 

 Mouse, Drives, Cards-Ethernet, 
Graphics, Sound 

 
 
8 

1 

Software: 
 Definition 
 Types of Software 

 System software 

 
 

R1: 183-200,W6 

9 1   Application software 



Lecture Plan 2017-2020 Batch 

 

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   2/8 
 

 
10 

1 
Input Devices 

 Keyboard, Mouse  
T1:39-47, W4 

11 1 
 Light pen, Touch Screen, OCR etc.,

12 1 
Output devices 

 Printer, Monitor, Speakers, Arm 
robots 

 
T1:47-55 ,W5 

13 1 
Storage devices 

 Floppy disks, CD-ROMs  

14 1  Hard disks, Zip disks, Tape drives T1:58-65,W4 

15 1 
Recapitulation & Important Questions 

Discussion 
 

Total No .Of Hours 15 

 

 

UNIT –II 

Sl 

No. 

Lecture 

Duration 

(Hour) 

 
Topics to be Covered 

Support 

Materials 

 

1 

 

1 

Operating system 

 Operating system –Meaning 
 Definition 

 
R2:129-134 

R3::54-67, W6 

 
2 

 
1 

Functions of Operating System: 

 Process management 
 Memory management  

 

R2::54-67, 

R1:263 -274 

 
 
3 

 
 

1 

Functions of Operating System: 

 Extended Machine 
 Mastermind 

Types of operating system: 
 Batch processing 

 
 

4 

 
 

1 

Types of Operating System 

 Serial processing 
 Multi-processing 
 Real time system 
 Distributed Operating system 
 Parallel Operating system 

 
R1:263 -274 W3  

R3:275,W6 
 
5 

 
1 

Booting Process 

 Booting process 
 Types of Booting 

 

6 

 

1 

Disk operating system 

 Origin 
 File system 

 
R3:115-116 W5 
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7 

 
1 

 Boot process 
 Drive names 
 Memory management 

 
 

8 

 
 

1 

Internal and external commands: 

Internal commands 

 CLS,DIR, COPY, 
Date, MD, RD 
External 
commands 

 Attrib,chkdisk,scandisk,tree,Edit 

 
 

R3: 116-120 

W2 

 
9 

 
1 

Wild cards 

 Asterisks(*) 
 Question mark (?) 

R3:120 W1 

 

10 

 

1 

Computer virus 

 Symptoms 
 Types 
 Measures 

 

W4 

 
11 

 
1 

Cryptology: 

 Definition 
 History 

 
R2:135-140 

12 1  Modern Cryptology 
 Issues 

 

 
13 

 
1 

Windows operating system 

 Desktop: Icons,Buttons,Taskbar 
 Start menu :Menu,Interface,Shortcut 

 
R1:65-67 

 
 

14 

 
 

1 

 Control panel: System security , 
Network, User accounts 

 Windows accessories: 
Calculator, Paint, Notepad, 
WordPad 

W6 

15 1 Recapitulation & Important Questions 
Discussion 

 

Total No .Of Hours 15 

 

 

UNIT-III 

Sl 

No. 

Lecture 

Duration 

(Hour) 

 
Topics to be Covered 

Support 

Materials 

 
1 

 
1 

Ms word 

 Meaning 
 Word for windows 

T1:78-79 W3 
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2 

 
1 

Word Processing 

 Meaning 
 Characters of word processing 

T1:79,W4 

 
3 

 
1 

Features of word processing 

 Word-wrap 
 Justification 

 
T1:80-86 W2 

4 1  Search & Replace 
 Adjustments 

 

5 

 

1 

Advantages of word processing 

 Import data 
 Handy features 
 Easy 

T1:86-87 W2 

6 1 
Applications of word processing 

 Manipulate Text 
 

W5 T1:87-91 

7 1  Editing 
 Formatting etc., 

 
8 

 
1 

Toolbars 

 Standard 
 Formatting 

 
W4 T1:82-83 

9 1  Drawing 
 Customizing 

 
10 

 
1 

Create and save document 

 Create-Open, Writing, Reading, etc., 

 

W1 T1:83-84 

11 1  Save-save, save as, file name 

 
12 

 
1 

Close, move and copy 

 Shortcut keys 

W5 T1:85-87 

 
13 

 
1 

 Selection 
 File menu 

W6 R2:85-87 

 
 

14 

 
 

1 

Text and paragraph Formatting 

 Alignment 
 Line Spacing 
 Shading and Borders 

 

W6 R1:92-98 

15 1 Recapitulation & Important Questions 
Discussion 

 

Total No .Of Hours 15 
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UNIT- IV 

Sl 

No. 

Lecture 

Duration 

(Hour) 

 
Topics to be Covered Support 

Materials 

 
 
1 

 

1 

MS-Excel 

 Meaning 
 Electronic spread sheet 
 Database management 

 

T1:113-114 W2 

2 1 Database management 

 
 
3 

 
 
1 

Features of MS-Excel 

 Pivot tables 
 Basic math 
 Conditional formatting 
 Sorting & Filtering 

 
T1:114-115 W3 

 
 

4 1 

Insertion and deletion of work sheet 

 Insert New worksheet 
 Insert Multiple Worksheet 
 Numbering 
 Rename 
 Deletion of worksheet 

 
 

T1:116-118 W4 

 

5 1 

Entering and editing data 

 Cell Data 
 Entering Data 
 Format Data 

 
T1:118-120 W2 

 
6 

1 

Cell range and formatting 

 Select Cell, Range, Rows , Columns 
 Formatting: Font, Alignment, 

Number 

T1:121-126 W1 

 
7 

 
1 

AutoFill 

 Option Button 
 Option List 

T1:126 W5 

 
8 

 
1 

Formula and disadvantages 

 Formulas: Enter, Edit, Insert 
Functions 

 Disadvantages: Execution, Storage, 
Malware. 

R1:118 

W2 

 

9 
 

1 

MS Power Point 

 Meaning 
 File Extension 
 Pre-defined Formats 

 
R2:88-89 W6 

 
10  

1 

 Slide-Purpose 
 Creation of slide-Auto content 

wizard,Design Template,Blank 
Presentation. 

R3:190-193 W2 
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11 

 
1 

 Slide Sorter-View, Dragging, 
Dropping and uses 

 Slide Show- Running , Printing 
T1:197 W2 

 
 

12 1 

 
 Slide number: Slide tab, Number, 

Date & Time 
 Slide Design: Background, 

Template, Themes 

 
T1:193-194 W2 

 
 

13 
 
 
1 

 
 Slide Layout: Formatting, color, 

Text, Font 
 View Show setup: Slide show 

setup, Show dialog box. 

 
 

W2 

 
 

14 1 

 
 Custom Animation: Animation 

Combo, Motion Path. 
 Slide Transition:Add, 

Remove,Change 

 
R2:195-197 W2 

 
15  

1 

 
Recapitulation & Important Questions 
Discussion 

 

Total No .Of Hours 15 

 
UNIT-V 

 

Sl 

No. 

Lecture 

Duration 

(Hour) 

 
Topics to be Covered 

Support Materials 

 
 
1 

 
 
1 

Internet ,E-

Commerce, E-Mail: E-

Commerce 

 Meaning 
 Advantages: Customers, Business 

 

R1:309 -338 

T1:164-167 

2 1 Limitations: Quality, Service, Security.  

3 1 

 Application of E-
commerce: Finance, 
Marketing, Manufacturing. 

R2:338-339,W5 

 
 
4 

 
 
1 

E-mail: 

 Purpose 
 Domain Names 
 Creation of E-mail-ID: Sign-

in, Sign-up, Account setup 

 
 

R3:267-280, 
T2:185-186 
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5 

 
1 

Group Communication: 
 Purpose, Uses, Characteristics 

Tele-Conferencing: 
 Telecommunication system, 

Audio, Video, Data 

 
 

W3,W1 

 
6 

 
1 

Video Conferencing: 
 Dedicated system, Desktop 

system, webRTC platforms 
File exchange: 

 Moving, Transfer, Network. 

W6 

7 1 

BandWidth: 
 Network, Multimedia, Internet. 

Modem: 
 Dialup, Broadband, Voice 

W3 

 
8 

 
1 

Network Topologies: 

 Meaning 
 Types: Bus, Ring, Tree, Mesh , 

Hybrid 

 
W2 

9 1 
Types of Network: 

 PAN,LAN  
R1:145-165 

10 1 
Types of Network: 

 WAN,MAN 

11 1 

Network Architecture: 
 OSI, Distributed 
 Dialup Access 

W4 

12 1 
Recapitulation & Important Questions 
Discussion 

 

13 1 
Previous year ESE Question Paper 
Discussion 

 

14 1 
Previous year ESE Question Paper 
Discussion 

 

15 1 
Previous year ESE Question Paper 
Discussion 

 

Total No .Of Hours 10 
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Suggested Readings:  

Text Book:  

1. Peter Norton. (2017) Introduction to Computers, [7th Edition]. Mc Graw Hill 

Company New Delhi.  

Reference Books:  

1. Rajaraman V. (2013). Introduction to Information Technology. [2nd Edition]. 

New Delhi: Prentice Hall of India.  

2. Rajaraman V. (2014) Fundamentals of Computers [6th Edition]. New 

Delhi:Prentice Hall of India.  

3. Deepak Bharihoke.(2012).Fundamentals of Information Technology. [Kindle 

Edition]. New Delhi: Excel Books.  

Websites:  

 W1:http://www.tutorialspoint.com/computer-components/  

 W2:http://www.cram.com/computer/devices/  

 W3:http://www.computer-pdf.com/operating -system/  

 W4:http://www.scribd.com/MS Office  

 W5:http://www.excel_easy.com/basic.Msexcel  

 W6:http://www.networkingabasics.net 

 

http://www.tutorialspoint.com/computer-components/
http://www.cram.com/computer/devices/
http://www.computer-pdf.com/operating -system/
http://www.excel_easy.com/basic.Msexcel
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UNIT I 

Introduction to computers: definition, characteristics and limitations of 

computers – Components of Computer System – Elements of Computers – Hardware 

– Software – Input and Output devices – storage devices. 
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UNIT-I 

INTRODUCTION TO COMPUTERS 

INTRODUCTION: 

 

The term computer is derived from the Latin word compute, which means to 

calculate. A computer is an electronic machine, devised for performing calculations 

and controlling operations that can be expressed either in logical or numerical 

terms. In simple terms,  a computer is an electronic device that performs diverse 

operations with the help  of instructions to process the information in order to 

achieve the desired results. Computer application extends to cover huge area 

including education, industries, government,  medicine,  scientific  research etc. A 

computer is one of the most influential forces available in modern times. Due to its 

memory, high speed and perfection, i ts application can be extended to almost 

infinite levels. 

Millions of complex calculations can be done in mere fraction of time. Difficult 

decisions can be made with accuracy for comparatively little cost. Computers are 

widely seen as instruments for future progress and as tools to achieve substantiality 

by way of improved access to information by means of video conferencing and e-

mail. Indeed computers have left such on impression on modern civilization that we 

call this era as the information age. 

 

Definition: 

 

A computer is an electronic data processing device, which accepts and stores data input, 

processes the data input, and generates the output in a required format. 

 

If we look at it in a very broad sense, any digital computer carries out the following five 

Functions: 

 

Step 1 - Takes data as input. 

Step 2 - Stores the data/instructions in its memory and uses them as required. 
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Step 3 - Processes the data and converts it into useful information. 

Step 4 - Generates the output. 

Step 5 - Controls all the above four steps. 

 

 

CHARACTERISTICS OF COMPUTERS: 

The main characteristics of computers are: 

a) Speed 

b) Storage 

c) Accuracy 

d) Versatility 

e) Automation 

f) Diligence 

g) Reliability 

 

a) Speed : Computers are capable of carrying out the task with enor mous speed. Today’s 

computers, according to their class, can perform from 4 MIPS (Millions of instructions per 

second) to 100 MIPS. What may take days for manual calculations  may take only a few 

hours for computers to perform. Inside the computer the information signal travels at 

incredible electronic speed. 

b) Storage: Computers can store enormous quantity of information. Which is expressed in 

terms of Kilobytes (or) Mega Bytes (MB) or Gega Bytes (GB). It is achieved through its ‘Main 

memory’ or ‘Primary storage’ and through ‘auxiliary storage’ or ‘Secondary storage’. The Hard 

disks Floppy disk, Compact Disc(CD) and Magnetic Tape storage are examples of secondary 

storages. These large volumes of storage occupy much lesser space compared to paper 

documents and this aspect of computers makes them more powerful. 

c) Accuracy: The accuracy of  a Computer is consistently high.  In fact, this quality of the 

computers make them indispensable in various fields such as Scientific Research, Space 
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Research, Weather Predictions and many other  areas  where precision of a high order is 

required. The accuracy of  the computer is best achieved  by programming them in the most 

efficient manner. When it comes to very complex mathematical or scientific problem the 

computer’s accuracy has no substitute. 

d) Versatility: Computers are versatile in that they can perform almost any task, provided 

they are given the appropriate logical steps. For example, they are capable of performing wide 

ranging tasks such as construction of a payroll, inventory management in a factory, hotel 

billing, hospital management, banking applications and any imaginable task in every walk of 

life. 

e) Automation: The biggest advantage of computers is that it is automatic in its operation. 

Once a programming logic is initiated the computer performs repeated operations without 

human interventions until program completion. 

f) Diligence: Computers are machines and that do not get tired or ‘lose concentration’ like 

human beings. If a large number of calculations say million calculations are to be performed 

the resultant output will remain exactly the same even if operations are repeated any number 

of times. But when a human being is asked to do the same job this consistency cannot be 

achieved. Thus for those who want consistent and continuous standard output, computer’s 

‘diligence’ is of great  help. 

g) Reliability: The computers give very accurate results with predetermined values. They 

correct and modify the parameters automatically, giving suitable signals. They give formatted 

results with high degree of precisions. 

 

LIMITATIONS OF COMPUTERS: 

1) No I.Q. 

 A computer is a machine that has no intelligence to perform any task. 

 Each instruction has to be given to the computer. 

 A computer cannot take any decision on its own. 

2) Dependency 

 It functions as per the user’s instruction, thus it is fully dependent on humans. 

3) Environment 

 The operating environment of the computer should be dust free and suitable. 

4) No Feeling 

 Computers have no feelings or emotions. 

 It cannot make judgment based on feeling, taste, experience,  and  knowledge unlike 
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humans. 

 

HISTORY OF COMPUTERS: 

Generation in computer terminology is a change in technology a computer is/was being 

used. Initially, the generation term was used to distinguish  between  varying hardware 

technologies. Nowadays, generation includes both hardware and software, which 

together make up an entire computer system. 

There are five computer generations known till date. Each generation has been discussed 

in detail along with their time period and characteristics. 

In the following table, approximate dates against each generation has been mentioned, 

which are normally accepted. 

Following are the main five generations of computers. 

 

 

First Generation  

The period of first generation: 1946-1959.Vacuum tube based. 

Second Generation  

The period of second generation: 1959- 1965. Transistor based. 

Third Generation  

The period of third generation: 1965- 1971. Integrated Circuit based. 

Fourth Generation  

The period of fourth generation: 1971- 1980. VLSI microprocessor based. 

Fifth Generation  

The period of fifth generation: 1980- onwards. ULSI microprocessor based. 

 

 

First Generation Computers 

The period of first generation was from 1946-1959. The computers of first generation used 

vacuum tubes as the  basic components for memory  and circuitry  for CPU (Central 

Processing Unit). These tubes, like electric bulbs, produced a lot of heat and the installations 
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used to fuse frequently. Therefore, they were very expensive and only large 

organizations were able to afford it. In this generation, mainly batch processing operating 

system was used. Punch cards,paper tape, and magnetic tape was used as input and output 

devices. The computers inthis gene ration used machine code as the programming language. 

 

The main features of the first generation are: 

 Vacuum tube technology 

 Unreliable 

 Supported machine language only 

 Very costly 

 Generated a lot of heat 

 Slow input and output devices 

 Huge size 

 Need of AC 

 Non-portable 

 Consumed a lot of electricity 

 

Second Generation Computers 

The period of second generation was from 1959-1965. In this generation, transistors were 

used that were cheaper, consumed less power, more compact in size, more reliable and 

faster than the first generation machines made of vacuum tubes. In this generation, 

magnetic cores were used as the primary memory and magnetic tape and magnetic disks as 

secondary storage devices. In this generation, assembly language and high- level 

programming languages like FORTRAN, COBOL were used. The computers used batch 

processing and multiprogramming operating system. 

The main features of second generation are: 

 Use of transistors 

 Reliable in comparison to first generation computers 

 Smaller size as compared to first generation computers 

 Generated less heat as compared to first generation computers 

 Consumed less electricity as compared to first generation computers. 
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Third Generation Computers 

The period of third generation was from 1965-1971. The computers of third generation 

used Integrated Circuits (ICs) in place of transistors. A single IC has many transistors, 

resistors, and capacitors along with the associated circuitry. The IC was invented by Jack 

Kilby. This development made computers smaller  in  size,  reliable,  and efficient. In this 

generation remote processing, time-sharing, multiprogramming operating system were used. 

High-level languages (FORTRAN-II TO IV,COBOL, PASCAL PL/1, BASIC, ALGOL-68 etc.) 

were used during this generation. 

The main features of third generation are: 

 IC used 

 More reliable in comparison to previous two generations 

 Smaller size 

 Generated less heat 

 

Fourth Generation Computers 

The period  of fourth   generation  was  from 1971-1980. Computers  of fourth 

generation used Very Large Scale Integrated (VLSI) circuits. VLSI circuits having about 5000 

transistors and other circuit elements with their associated circuits on a single chip made it 

possible to have microcomputers of fourth generation. Fourth generation computers became 

more powerful, compact,  reliable,  and affordable.  As a result, it gave rise to Personal 

Computer (PC) revolution. In this generation, time sharing, real time networks, distributed 

operating system were used. All  the high- level languages like C, C++, DBASE etc., were 

used in this generation. 

The main features of fourth generation are: 

 VLSI technology used 

 Very cheap 

 Portable and reliable 

 Use of PCs 

 Very small size 

 Pipeline processing 

 No AC required 

 Concept of internet was introduced 

 Great developments in the fields of networks 
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 Computers became easily available 

Fifth Generation Computers 
The period of fifth generation is 1980-till date. In the fifth generation, VLSI technology 

became ULSI (Ultra Large Scale Integration) technology, resulting in the  production  of 

microprocessor chips having ten million electronic components. This generation is based on 

parallel processing hardware and AI (Artificial Intelligence) software.  AI is an emerging branch 

in computer science, which interprets the means and method of making computers think like 

human beings. All the high-level languages like C 

and C++, Java, .Net etc., are used in this generation The main features of fifth generation 

are: 

 ULSI technology 

 Development of true artificial intelligence 

 Development of Natural language processing 

 Advancement in Parallel Processing 

 Advancement in Superconductor technology 

 More user-friendly interfaces with multimedia features 

 Availability of very powerful and compact computers at cheaper rates. 

 

BASIC FUNCTIONAL UNITSOF A COMPUTER : 

 

Input Unit 

This unit contains devices with the help of which we enter data into the computer. 
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This unit creates a link between the user and the computer. The input  devices translate the 

information into a form understandable by the computer. 

 

CPU (Central Processing Unit) 

CPU is considered as the brain of the computer. CPU performs all types of data processing 

operations. It stores data, intermediate results, and instructions  (program). It controls the 

operation of all parts of the computer. 

CPU itself has the following three components: 

 ALU (Arithmetic Logic Unit) 

 Memory Unit 

 Control Unit 

a) Control Unit 

This unit controls the operations of all parts of the computer but does not carry out  any 

actual data processing operations. Functions of this unit are: 

 It is responsible for controlling the transfer of data and instructions among other units of a 

computer. 

 It manages and coordinates all the units of the computer. 

 It obtains the instructions from the memory, interprets them, and directs the operation of 

the computer. 

 It communicates with Input/Output devices for transfer of data or results from storage. 

 It does not process or store data. 

 

Output Unit 

The output unit consists of devices with the help of  which we  get  the  information from the 

computer. This unit is a link between the computer and the users. Output devices translate 

the computer's output into a form understandable by the users. 

 

COMPONENTS OF COMPUTER SYSTEM 

 

A computer system is a combination of various components. It performs the system 

functions such as input, processing, output, storage and control. A computer 

system consists of the following components: 
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1. Hardware 

2. Software 

3. Human ware 

4. Firmware 

5. Bridge ware 

 

1. Hardware : The physical components of the computer, such as electrical, 

electronics and mechanical unit are known as the hardware of the computer. That 

is, the input units, output units and CPU are called hardware. Thus hardware is the 

equipment involved in the function of a computer. It consists of the components 

that can be physically handled. The function of these components is typically 

divided into three main categories: input, output, and storage. Components in these 

categories connect to microprocessors, output and storage. Components  in these 

categories connect to microprocessors, specifically, the computer's central 

processing unit (CPU), the electronic circuitry that provides the computational 

ability and control of the computer, via wires or circuitry called a bus. 

2. Software: The computer performs operations like addition, subtraction, 

multiplication and division only when the user instructs it to do so. The user issues 

instructions and the CPU acts in accordance with the instructions. The sets of 

instructions, which control the sequence of operations, are known as programs, 

and collectively programs are called software. The software can be broadly classified 

into two types. They are: 

a. System Software 

b. Application software 

3. Human ware: The man-machine interface is called a human ware. The people 

who work with the computer are collectively called the human ware or livewire. 

4. Firmware: The computer programs permanently stored in ROM or PROM are 

called firmware. These programs are provided by hardware manufacturer along with 

the computers. Generally these are booting programs whichhelp in the starting of a 

computer. Such programs cannot be erased or overwritten. 

5. Bridge ware: The computer components and programs used to translate 
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instructions and information written for one type of computer into a format that 

another type of computer can understand is called bridge ware. This is necessary 

because different computers are made by different manufacturers. 

 

ELEMENTS OF COMPUTER: 

 

A computer system consists of hardware, the physical unit (parts) of the computer 

that are capable of computing and manipulating information and software (set of 

instructions or programs) that carries out predefined tasks to complete a given job. 

The computer performs operations like addition, subtraction, multiplication and 

division only when the user instructs it to do so. The user issues instructions and 

the CPU acts in accordance with the instructions. The sets of instructions, which 

control the sequence of operations, are known as programs, and collectively 

programs are called software. 

 

We can equate hardware and software with human body and human intelligence, 

respectively. All human physical actions such as walking and eating are based on 

the thoughts and feelings, which is raised by the brain. If the brain does not raise 

thoughts and feelings, we do no t perform any physical activity. Similarly, the 

actions and functioning of every hardware equipment is driven by software. The 

combination of physical equipment (hardware) and logical instructions (software) 

gives modern computing system their power and versatility. 

 

  

COMPONENTS OF HARDWARE: 

 

I. Input unit: This unit accepts instructions and data. 

II. Output unit: This unit communicates the results to the user. 

III. Storage unit: This unit stores temporary and final results. 

IV. Central Processing Unit (CPU): This unit performs processing of instructions and 

data inside thecomputer. 
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The CPU has three components: 
a) The Control Unit 

b) The Arithmetic Logic Unit (ALU) and c) The Memory Unit. 

 

a) Control Unit: It controls the overall operation o f the computer system. It is 

considered as the heart of the computer system. It controls all the other units, 

directs them to operate in a proper way and co-ordinates various operations 

performed. It instructs the input device to transfer the data and instructions to the 

main memory and then to the arithmetic and logic unit (ALU). Then, it sends the 

processed result from ALU to the memory unit for storage and transfers it to the 

visual display unit or to the ' printer. The control unit coordinates the various parts 

of the computer system - the arithmetic logic unit, the memory unit and the 

peripheral units. 

Besides, it controls the flow of data into, from and within the main storage as per 

the program instructions. To perform its control operations effectiv ely and quickly, 

the control unit has four basic components. They are 

(a) Instruction Register 

(b) Decoder 

(c) Address Register 

and (d) Instruction Counter. 

 

The instruction register receives one by one the instructions to be executed in the 

required sequence. Then, the operation code of the instructions is transferred to 

decoder, which decodes the operation code. And it activates the appropriate circuits 

of the arithmetic and logic unit to perform the operation. The address register 

enables the data in the location specified in the instruction to be transferred to a 

specified accumulator for the arithmetic and logic unit. 

 

b) Arithmetic Logic Unit (ALU) This unit performs two kinds of operations, the 

arithmetic processing and logical processing. In arithmetic processing it performs 
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all mathematical operations such as addition, subtraction, multiplication and 

division. In logical processing, it performs the relational and logical operations such 

as comparing larger or smaller values, true or false statements, etc. 

 

c) Memory Unit : This unit holds the intermediate results during the course of 

calculations and provides the data as and when required. This internal storage is 

also called primary memory or main memory. This memory takes the data from an 

input device and stores it until the computer is ready to process it. It also stores 

processed data and intermediate results. When the processing is finished, it 

transfers the results to an output device. 

 

SOFTWARE 

 

Software is a generic term for organized collection of computer data and 

instructions. It is responsible for controlling, integrating, and managing the 

hardware components of a computer and to accomplish specific tasks. In other 

words, software tells the computer what  to do  and how to do it. For ex ample, 

software instructs the hardware what to display on the user ’s screen, what kinds of 

input to take from the user, and what kinds of output to generate. Thus, software 

communicates with the hardware by organizing the control sequences, and the 

hardware carries out the instructions defined by the software. 

A computer needs to be instructed to perform any task. These instructions are 

given in the form of computer programs, which are written in computer 

programming languages. A program controls the activity of the processor. The 

moment the hardware (processor, memory, etc.), acts as per the instructions of a 

program, the program is said to be in running or executing state. A set of programs, 

which are specifically written to provide the user a precise functionality like solving 

a specific problem is termed as a software package. For example, word processing 

software package provides functionality to the computer so that it can be used to 

create text documents like letters and mailing lists. Similarly, an image processing 

software package assists a user in drawing and manipulating graphics. 
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FEATURES OF SOFTWARE 
1. Ease of use : The software systems and applications are becoming more and more 

easy to use. In fact, software developers and system analysts go to great lengths to 

ensure that the products they develop are user-friendlier than their competitor’s 

products. 

2. Graphical user interface (GUI ) GUI or graphical user interface has now become 

the default standard for most of the software applications. Gone are the days of the 

crude character based interfaces of UNIX and DOS application. Today ’s software 

applications and products provide the users with perceptive, graphical and easy-to-

use interfaces. Now the users do not have to remember the cryptic system 

commands or shortcut keys that were a must in the character based era. Now 

almost any task can be accomplished by a mouse click. 

3. Multi-platform capability : Today’s software applications are not developed for 

just one platform. Most of the software applications supports multiple platforms-

both hardware and software platforms. There are software applications that support 

hardware platforms ranging from mainframes to PCs and different software 

platforms like MVS, Solaris, AIX, UNIX, Windows and so on. For example IBM’s DB2 

Universal database is available for a variety or hardware and software platforms. 

Another important feature of today’s software application is that they support 

multiple languages and multiple currencies. Many vendors are providing their 

applications in many languages like English, Arabic, Japanese, and Chinese and so 

on. 

4. Compatibility with other software : Now the competition for each market 

segment in the software marketplace is rather fierce. We have many software 

vendors battling for the market share in the same segment. For example, Microsoft 

Word 2000 supports all previous versions of Work like Word 97, Word 6, Word and 

so on. The two features –compatibility with earlier versions and compatibility with 

other products make it easier for the users, as they can choose the application they 

want and still use the old files they have created using other applications or using 

older versions of the same application. 
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5. Mail enabling Mail enabled applications are designed to take advantage of on e-

mail. These are the familiar word processors, spreadsheets, and other individual 

desktop applications that have email features built to them. There is another class 

of message-centered programs that are built specifically around e-mail functions. 

6. Web enabling With the ever-increasing popularity of internet and the amount of 

information that is available on the net, most software applications are now web-

enabled. Web enabling  helps the user in many different ways. Its use starts while 

the user is installing the application. During installation, most of the applications 

will automatically connect to the Internet and  to the vendor’s web site and will 

register their products (earlier one had to fill in a paper form and mail or fax it to 

the vendor). 

 

INPUT DEVICES: 

Following are some of the important input devices which are used in a computer: 

 Keyboard 

 Mouse 

 Joy Stick 

 Light pen 

 Track Ball 

 Scanner 

 Graphic Tablet 

 Microphone 

 Magnetic Ink Card Reader (MICR) 

 Optical Character Reader (OCR) 

 Bar Code Reader 

 Optical Mark Reader (OMR) 

Keyboard 

Keyboard is the most common and very popular input device which helps to input data to the 

computer. The layout of the keyboard is like that of traditional typewriter, although there are 

some additional keys provided for performing additional functions. 

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 108 
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keys are also available for Windows and Internet. 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-control device havinga 

small palm size box with a round ball at its base,  which  senses  the movement of the mouse 

and sends corresponding signals to  the  CPU  when  the mouse buttons are pressed. 

Generally, it has two  buttons  called the  left  and  the right button and a wheel is present 

between the buttons. A mouse can be used to control the position of the cursor on the screen, 

but  it cannot  be used to enter text  into the computer. 

Advantages 

 Easy to use 

 Not very expensive 

 Moves the cursor faster than the arrow keys of the keyboard 

Joystick 

Joystick is also a pointing device, which is used to move the cursor position on a monitor 

screen. It is a stick having a spherical ball at  its both lower and  upper  ends.  The lower 

spherical ball moves in a socket. The joystick can be moved in all four directions. 

The function of the joystick is similar to that of a mouse. It is mainly used in Computer 

Aided Designing (CAD) and playing computer games. 

Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a displayed menu item 

or draw pictures on the monitor screen. It consists of a photocell and an optical system 

placed in a small tube. When the tip of a light pen is moved over the monitor screen and the 

pen button is pressed, its photocell sensing element detects the  screen location and sends the 

corresponding signal to the CPU. 

 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop computer, instead 

of a mouse. This is a ball which is half inserted  and by  moving fingers on the  ball, the 

pointer can be moved.Since the whole device is not moved, a track ball requires less space 

than a mouse. A track ball comes in various shapes like a ball, a button, or a square. 
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Scanner 

Scanner is an input device, which works more like a photocopy machine. It is used when 

some information is available on paper and it is to be transferred to the hard disk of 

the computer for further manipulation. Scanner captures images from the source  which are 

then converted into a digital form that can be stored on the disk. These images  can be edited 

before they are printed. 

 

Magnetic Ink Card Reader (MICR) 

MICR input device is generally used in banks as there are  large number of  cheques  to be 

processed every day. The bank's code number and cheque number are printed on the cheques 

with a special type of ink that contains particles of magnetic material that  are 

machine readable. 

This reading process is called Magnetic Ink Character Recognition (MICR). The main 

advantages of MICR is that it is fast and less error prone. 

 

Optical Character Reader (OCR) 

OCR is an input device used to read a printed text. OCR scans the text optically, 

character by character, converts them into a machine readable code, and stores the text on 

the system memory. 

Optical Mark Reader (OMR) 

OMR is a special type of optical scanner used to recognize the type of mark made by pen 

or pencil. It is used where one out of a few alternatives is to be selected and 

marked. It is specially used for checking the answer sheets of examinations having multiple 

choice 

questions. 

 
OUTPUT DEVICES: 

Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 
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Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the m ain output device of 

a computer. It forms images from tiny dots, called pixels that are arranged in a rectangular 

form. The sharpness of the image depends upon the number of pixels. There are two kinds 

of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

 

Cathode-Ray Tube (CRT) Monitor: 

The CRT display is made up of small picture elements called pixels. The smaller the 

pixels,the better the image clarity or resolution. It takes more than one illuminated pixel to 

form a whole character, such as the letter ‘e’ in the word help. 

A finite number of characters can be  displayed on a screen at once.  The  screen can be 

divided into a series of character boxes - fixed location on the screen  where a standard 

character can be placed. Most screens are capable of displaying 80 characters of data 

horizontally and 25 lines vertically. 

There are some disadvantages of CRT: 

 Large in Size 

 High power consumption 

Flat-Panel Display Monitor: 

The flat-panel display refers to a class of video devices that have reduced volume, weight and 

power requirement in comparison to the CRT. You can hang them on  walls or wear them on 

your wrists. Current uses of flat-panel displays include calculators, video games, monitors, 

laptop computer, and graphics display. 

 

The flat-panel display is divided into two categories: 

 Emissive Displays - Emissive displays are devices that convert electrical energy into light. 

For example, plasma panel and LED (Light-Emitting Diodes). 

 Non-Emissive Displays - Non-emissive displays use optical effects to convert sunlight or 

light from some other source into graphics patterns. For example, LCD (Liquid-Crystal 

Device). 
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Printers 

Printer is an output device, which is used to print information on paper. There are two types 

of printers: 

 Impact Printers 

 Non-Impact Printers 

 

Impact Printers 

Impact  printers  print  the  characters  by  striking  them  on  the  ribbon,  which  is  then 

pressed on the paper. 

Characteristics of Impact Printers are the following: 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 

 There is physical contact with the paper to produce an image These printers are of two types 

- 

 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at a time. These are further 

divided into two types: 

 Dot Matrix Printer (DMP) 

 Daisy Wheel 
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Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. These printers are 

popular because of their ease of printing and economical price. Each  character printed is 

in the form of pattern of dots and head consists of a Matrix of Pins of  size (5*7, 7*9, 9*7 

or 9*9) which come out to form a character which is why it is called Dot  Matrix Printer. 

Advantages 

 Inexpensive 

 Widely Used 

 Other language characters can be printed 

Disadvantages 

 Slow Speed 

 Poor Quality 

Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are  like petals of  Daisy 

(flower) which is why it is called Daisy Wheel Printer. These printers are generally used 

for word-processing in offices that require a few letters to be sent here and there with 

very nice quality. 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 

Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

Non-impact Printers: 

Non-impact printers print the characters without using the  ribbon.  These  printers  print a 

complete page at a time, thus they are also called as Page Printers. These printers are of two 

types - 

 Laser Printers 

 Inkjet Printers 

Characteristics of Non-impact Printers 

 Faster than impact printers 
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 They are not noisy 

 High quality 

 Supports many fonts and different character size 

 

Laser Printers 

These are non-impact page printers. They use laser lights to produce  the  dots needed to 

form the characters to be printed on a page. 

Advantages 

 Very high speed 

 Very high quality output 

 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a single printing 

 

Inkjet Printers 

Inkjet printers are non-impact character printers based on a relatively new technology. 

They  print  characters  by  spraying  small  drops  of  ink  onto  paper.  Inkej t  printers 

produce 

high quality output with presentable features. They make less noise because no hammering is 

done and these have many styles of printing modes available. Color printing is also possible. 

Some models of Inkjet printers can produce multipl e copies of printing also. 

Advantages 

 High quality printing 

 More reliable 

Disadvantages 

 Expensive as the cost per page is high 

 Slow as compared to laser printer. 
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STORAGE DEVICES: 

 

There are two types of storage devices. 

a. Primary storage device 

b. Secondary Storage device. 

 

a. PRIMARY STORAGE DEVICE OR RANDOM ACCESS MEMORY [RAM]: Primary 

storage is usually referred to as Random Access Memory [RAM] because it is possible 

to randomly select and use any location of this memory to directly store and retrieve 

data and instructions. It is also referred to as read/write memory because 

information can be ‘read’ from a RAM chip also be ‘written’ into it. The Random 

Access Memory requires some times for accessing data and is considered to be the 

fastest memory. Each bit in a RAM stores infomr  ation by means of electric charge, 

where the presence of an electric charge indicates‘1’ and the absence of an ‘0’. RAM 

is called Temporary storage, because data persists until the machine is on. 

ROM : A Read Only Memory [ROM] is one in which information is permanently 

stored. The information from the memory can only be read and it is not possible to 

write fresh information into it. This is the reason why it is called ROM. When the 

power supply is switched off, the information stored inside ROM is not lost as it is in 

the case of a RAM chip. ROMs are mainly used by computer manufacturers for 

storing the micro programs so that they cannot be modified by the users. 

 

b. SECONDARY STORAGE DEVICES : 

 

This section of the memory is also referred to as backup storage because it is used 

to store large volume of data on a permanent basis which can be partially 

transferred to the primary storage as and when required for processing. The storage 

capacity of the primary storage of today’s computers is not sufficient to store the 

large volume of time handled by most data processing centres. As a result, 

additional memory, called auxiliary memory or secondary storage, is used with most 

computer systems. Hard Disk, Floppy Disk, Tape and Compact Disc are the main 
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secondary storage devices. 

I) Hard Disk: The hard disk used in the PC is permanently fixed, hard disks with 

storage capacities of 8 GB, 10GB, 20GB, 40GB, are quite common, the CPU can use 

the hard disk to load programs and data as well as to store data We should oper ate 

the PC within a dust-free and cool room (Preferably air-conditioned) to prevent hard 

disk crash. 

ii). Floppy Disk: Floppy disk is flexible circular disk of diameter 3.inches made of 

plastic coated with a magnetic material. This is housed in a square plastic jacket. 

The floppy disk can store 1.4 Mbytes of data [also called 1.44Mnytes, since it holds 

1440Kytes]. Data recorded on a floppy disk is read and stored in a computer’s 

memory by a device called a floppy disk drive[FDD]. A floppy disk is inserted in a 

slot of the FDD. Some of the floppies have limited life time. The floppies have to be 

recycled periodically to keep them alive. A frequently recycled floppy. [i.e used] will 

have a life time of 3to 4 years to do recycling take out old floppies occasionally and 

try to read them once, at least the directory. 

iii). Compact Disk: CD-ROM [Compact Read Only Memory] uses a laser beam to 

record and read data along spiral tracks on a 51/4’’ disk. A disk can store around 

650/00MB of information. CD- ROMs are normally used to store data as back up. 

Using a CD Writer, lot of information can be written on CD-ROM and stored for 

future reference. 

iv). Tape Drives: Even though tape drives are one of the oldest of storage 

technologies, they can still hold the most data on a single cartridge. A computer 

tape drive works similar to a tape recorder or a VCR. A plastic tape ribbon is coated 

with magnetic particles which are polarized by 

a magnetic field generated by the read/write head. Since tape is a sequential, and 

not a r andom- access media, a tape drive has to wind through a tape to locate a 

specific bit of data. This makes accessing data slow so tape is mainly used for 

system backups and regular archiving of files and records. Tape dives allow users to 

backup large amounts of data. Tape drives are capable of backing up a couple 

hundred megabytes to several gigabytes of information without having to spend 

large sums of money on disks. 



Introduction to Information Technology 2017-2020 Batch 

  

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   24/24  

iv). DLT [Digital Linear Tape] :DLT drives are a robust and durable medium. The 

DLT segments the tape into parallel horizontal tracks and records data by 

streaming the tape across a single stationary head. Released in 1991 DLT drives are 

very reliable, high-speed, and high-capacity making the DLT drives an excellent use 

for Network backups. 

v). Micro Vault USB Storage Media: 

Micro Vault media plugs directly into the computer’s SB port – and acts just like 

another drive. It is small, light, Shock-proof and moisture – proof. This nifty flash 

memory storage device is compact and durable enough to carry in any pocket. The 

device is recognized automatically when we connect it to the computer. By 

connecting it via USB, the files can be transferred by dragging and dropping. There 

are no cables or adaptors needed, no power cord and no driver software to install. 

It’s compatible with both Macintosh and Windows operating systems, and even 

comes with software that password protects the contents of the device. Micro Vault 

They are perfect for sharing PowerPoint presentations, digital photos, MPEG video 

and MP3s, transporting files between work and home, or sharing files with friends 

and colleagues. 
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UNIT I
S.NO QUESTIONS OPTION 1 OPTION 2 OPTION 3 OPTION 4 ANSWER

1 __________ allow us to send information to the computer input output data CPU input
2  CD-ROM stands for Compactable Read

Only Memory
Compact Data Read Only Memory Compactable Disk Read Only Memory  Compact Disk Read Only

Memory
 Compact Disk Read Only
Memory3 ALU is a. Arithmetic Logic Unit  Array Logic Unitc. Application Logic Unitd.  None of above Arithmetic Logic Unit

4 WAN stands for   Wap Area Network  Wide Area Network Wide Array Netd. Wireless Area Network  Wide Area Network
5 MICR stands for Magnetic Ink Code

Reader
Magnetic Ink Cases Reader  Mechanism Ink Character Reader  Magnetic Ink Character Reader  Magnetic Ink Character Reader

6 _______ allow us to get information from the computer input output data CPU output
7 A light sensitive device that converts drawing, printed text or other images into digital form is Keyboard Plotter Scanner OMR Scanner
8 Dot-matrix is a type of Tape Printer Disk  Bus Printer
9 Cursor is a ____ Pixel  Thin blinking line Pointing device  input device  Thin blinking line
10 ASCII stands for American Stable

Code for International
Interchange

 American Standard Case for
Institutional Interchange

 American Standard Code for
Information Interchange

 American Standard Code for
Interchange Information

 American Standard Code for
Information Interchange11 Personal computers use a number of chips mounted on a main circuit board. What is the common name for such boards? Father board  Daughter board Breadboard Motherboard Motherboard

12 Can you tell what passes into and out from the computer via its ports? Data  Bytes Graphics Pictures Data
13 Computer system comprises of major units input unit, output unit,

control unit
input unit, output unit, control unit
and storage

input unit, output unit, central
processing unit and storage unit

input, output and storage units input unit, output unit, central
processing unit and storage unit14 What type of device is computer keyboard?  Memory Output Storage Input Input

15 Through which device the main components of the computer communicate with each other?  Keyboard  System Bus  Monitor  Memory  System Bus
16 The difference between memory and storage is that memory is _____ and storage is _______ Temporary,

Permanent
Permanent, Temporary Slow, fast Data,backup Temporary, Permanent

17 The size of commonly used floppy disk is 4.5" 3.5" 3.25" 5.5" 3.5"
18 The processor which performs arithmetical and logical operations is called Control ALU Register Cache Memory ALU
19 Which of the following memory is volatile RAM ROM EPROM PROM RAM
20 Which of the following is the fastest CPU Magnetic Tapes and Disks Video Terminal Sensors, Mechanical Controllers CPU
21 Which is the device that converts computer output into a form that can be transmitted over a telephone line? Teleport Multiplexer Concentrator Modem Modem
22 Computer Virus is a _______. Hardware Software Bacteria Freeware Software
23 Another term for Main Memory is Hard Disk ROM Floppy Disk RAM RAM
24 Dot-matrix, Deskjet, Inkjet and Laser are all types of which computer peripherals? Printers Software Monitors Keyboards Printers
25 ______ is the high speed memory used in the computer. RAM Hard Disk Cache BIOS Cache
26 The term 'memory' applies to which one of the following Logic Storage Input Device Output Device Storage
27 The device primarily used to provide hardcopy is the CRT Computer Console Printer Card Reader Printer
28 A list of instructions used by a computer is called Text CPU Program Output Program
29 Which one is not an input device? Keyboard Mouse Speaker Scanner Speaker
30 Memories which can be read only are called __________. RAM ROM DRAM Secondary Memory ROM

31 CPU controls _________. All Input, Output and
processing.

Controls Memory Controlled by the input data ALU All Input, Output and processing.

32 USB stands for ________? Universal Serial Bus Universal Sequential Bus Unique Serial Bus Unique Sequential Bus Universal Serial Bus

33 CPU stands for ______ ? Central  Performance
Unit.

Control Processing Unit Common Processing Unit Central Processing Unit Central Processing Unit

34 Which of the following holds the ROM, RAM, CPU? Hard Disk ALU Mother Board Computer Mother Board
35 An optical input device that interprets pencil marks on paper media is Magnetic tape Optical scanners Punch card reader O.M.R O.M.R

36
What does a system bus do? allows the user to

communicate with the
computer

carries out instructions connects various components within
the computer

stores data and instructions connects various components
within the computer

37 What are the two types of monitors? CRT and DVD CRT and LCD DVD and VCD LCD and DVD CRT and LCD
38 ________ keys are present on the top row of the keyboard. Function Type writer Numeric Navigation Function
39 Transformation of input into output is performed by? Memory Storage The Input-Output unit The CPU The CPU

40 You can use the tab key to Move a cursor across
the screen

Indent a paragraph Move the cursor down the screen Move the cursor to the right of
the screen

Indent a paragraph

41 Computers use the _____ number system to store data and perform calculations. Decimal Hexadecimal Octal Binary Binary
42 The _____ key will launch the start buttons. Esc Shift Windows Shortcut Windows
43 To move to the beginning of a line of text, press the _____ key. Home A PageUp Enter Home

44
What is backup? Adding more

components to your
network

Protecting data by copying it from
the original source to a different
destination

Filtering old data from the new data Accessing data on tape Protecting data by copying it from
the original source to a different
destination

45 Computers that are portable and convenient for users who travel are known as _____ Super computers Laptops Mini computers File servers Laptops
46 Which input device cannot be used to work in MS Office? Scanner Lightpen Keyboard Joy Stick Joy Stick
47 A normal CD-ROM usually can store up to ........ 680 KB 680 Bytes 680 MB 680 GB 680 MB
48 Which of the following devices have a limitation that we can only store information to it but cannot erase or modify it? Floppy Disk Hard Disk Tape Drive CD-ROM CD-ROM
49 Which computer memory is used for storing programs and data currently being processed by the CPU? Mass memory Internal memory Non-volatile memory PROM Internal memory

50 What is output ? What the processor
takes from the user

What the user gives to the processor What the processor gets from the user What the processor gives to the
user

What the processor gives to the
user

51
In processing cheques which of the following I/O techniques have banks traditionally followed? OCR (Optical

Character
Recognition)

MICR (Magnetic Ink Character
Recognition)

Barcode VRT (Volume Rendering
Technique)

MICR (Magnetic Ink Character
Recognition)

52 QWERTY is used with reference to Monitor Printer Keyboard Mouse Keyboard

53 "Zipping" a file means Encrypting the
message

Compressing the message Transfer the message Shortcut of message Compressing the message

54 Integrated Circuits (IC) chips used in computers are made with Gold Silver Silicon Copper Silicon
55 The term that we use to describe physical components of the system Hardware Input Software Operating System Hardware

56 What Does BIOS Stand For? Better Integrated
Operating System

Basic Input Output System Battery Integrated Operating Setup Backup Input Output System Basic Input Output System

57 Which of the following is not a storage device? DVD Hard Disk Floppy Disk Mouse Mouse
58 The term 'memory' applies to which one of the following: Logic Storage Input Device Output Device Storage
59 A disk's content that is recorded at the time of manufacture and cannot be changed or erased by user is Read-only Memory-only Run-only Write-only Read-only
60 What is usually used for displaying information at public places? Monitors Overhead Monitor and overhead projection Touch screen kiosks Touch screen kiosks
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1. What is a utility program? Give example. 

2. Name any three of the Application Software’s and its uses 

3. Explain OMR 

4. Explain USB Port? 

5. Expand EFTPOS? Give example 

6. What is system software? Give example 

7. Write any two uses of OCR? 

8. What is RAM? 

9. Define software? 

10. What is Bus ? 

 

PART – C (6 MARKS) 

1. Explain the Elements of computer system 

2. Describe the storage devices in detail 

3. Explain the components of Motherboard 
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4. Describe the types of software with example 

5. Explain the characteristics of computer system in detail 

6. Explain Output devices in detail 

7. Explain the components of CPU 

8. Explain Input devices in detail. 

9. Explain the components of Motherboard 

10. Define software? Explain the type of software in detail 
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UNIT-II 

OPERATING YSTEM 

 

An operating system (OS) is system software that manages computer hardware 

and software resources and provides common services for computer programs. 

 

FUNCTIONS OF OPERATING SYSTEM: 

Following are some of important functions of an operating System. 

 

� Memory Management 

� Process Management 

� Device Management 

� File Management 

� Security 

Memory Management: 

Memory management refers to management of Primary Memory or Main Memory. 

Main memory is a large array of words or bytes where each word or byte has its 

own address. 

 

Main memory provides a fast storage that can be accessed directly by the CPU. For 

a program to be executed, it must in the main memory. An Operating System does 

OPERATING 

SYSTEM 

 
COMPUTER 

HARDWARE 
 

 

USER 
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the following activities for memory management − 

 

� Keeps tracks of primary memory, i.e., what part of it are in use by whom, what 

part are not in use. 

 

� Allocates the memory when a process requests it to do so. 

 

� De-allocates the memory when a process no longer needs it or has been 

terminated. 

 

Process Management: 

 

In multiprogramming environment, the OS decides which process gets the 

processor when and for how much time. This function is called process 

scheduling. An Operating System does the following activities for processor 

management − 

 

� Keeps tracks of processor and status of process. The program responsible for this 

task is known        as traffic controller. 

 

� Allocates the processor (CPU) to a process. 

 

� De-allocates processor when a process is no longer required. 

 

Device Management: 

An Operating System manages device communication via their respective drivers. 

It does the following activities for device management − 
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� Keeps tracks of all devices. Program responsible for this task is known as the I/O 

controller. 

 

� Decides which process gets the device when and for how much time. 

 

� Allocates the device in the efficient way. 

 

� De-allocates devices. 

 

File Management: 

A file system is normally organized into directories for easy navigation and usage. 

These directories may contain files and other directions. 

 

An Operating System does the following activities for file management − 

 

� Keeps track of information, location, uses, status etc. The collective facilities are 

often known as file system. 

 

� Decides who gets the resources. 

 

� Allocates the resources. 

 

� De-allocates the resources. 

 

Security Management: 

By means of password and similar other techniques, it prevents unauthorized 
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access to programs and data. 

TYPES OF OPERATING SYSTEM: 

There are Many Operating Systems those have be Developed for Performing the 

Operations those are requested by the user. There are Many Operating Systems 

which have the Capability to Perform the requests those are received from the 

System. The Operating system can perform a Single Operation and also Multiple 

Operations at a Time. So there are many types of Operating systems those are 

organized by using their Working Techniques. 

A) DESKTOP OPERATING SYSTEM 

The control program in a user's machine (desktop or laptop). Also called a "client 

operating system," Windows is the overwhelming majority while the Macintosh 

comes second. There are also several versions of Linux for the desktop. 

B) SERVER OPERATING SYSTEM: 

A server operating system, also called a server OS, is an operating system 

specifically designed to run on servers, which are specialized computers that 

operate within a client/server architecture to serve the requests of client 

computers on the network. The server operating system, or server OS, is the 

software layer on top of which other software programs, or applications, can run 

on the server hardware. Server operating systems help enable and facilitate typical 

server roles such as Web server, mail server, file server, database server, 

application server and print server. 

C) MAINFRAME OPERATING SYSTEM: 

Mainframe operating systems are sophisticated products with substantially 

different characteristics and purposes. The architecture is distinct from the 

physical design, and, in fact, different machine designs might conform to the same 

http://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system
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computer architecture. In a sense, the architecture is the computer as seen by the 

user, such as a system programmer. For example, part of the architecture is the 

set of machine instructions that the computer can recognize and execute. In the 

mainframe environment, the system software and hardware comprise a highly 

advanced computer architecture, the result of decades of technological innovation. 

MULTIUSER OPERATING SYSTEM: A multi-user operating system extends the 

basic concept of multi-tasking with facilities that identify processes and resources, 

such as disk space, belonging to multiple users, and the system permits multiple 

users to interact with the system at the same time. 

D) MULTIPROCESSING OPERATING SYSTEM: The Multi-processing Operating 

Systems never use any cards because the Process is entered on the Spot by the 

user. But the Operating System also uses the Process of Allocation and De-

allocation of the Memory Means he will provide the Memory Space to all the 

Running and all the Waiting Processes. There must be the Proper Management of 

all the Running Jobs. 

E) MULTITASKING OPERATING SYSTEM:A multi-tasking operating system allows 

more than one program to be running in concurrency. This is achieved by time-

sharing, dividing the available processor time between multiple processes that are 

each interrupted repeatedly in time slices by a task-scheduling subsystem of the 

operating system. Multi-tasking may be characterized in preemptive and co-

operative types. 

F) MULTITHREADING OPERATING SYSTEM:It allows different parts of a single 

program to run concurrently.Multithreaing is an ability of an operating system to 

execute different parts of a program called threads. 
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BOOTING PROCESS: 

Booting is a process or set of operations that loads and hence starts the operating 

system, starting from the point when user switches on the power button. 

The Booting is a process involving 2 stages: 

 

� getting hardware up and running, and 

� getting the OS and other software up and running. The tasks that are 

carried during booting process are: Turn on the Power button. 

· CPU pins are reset and registers are set to specific value. 

· CPU jump to address of BIOS (0xFFFF0). 

· BIOS run POST (Power-On Self Test) and other necessary checks. 

· BIOS jumps to MBR(Master Boot Record). 

· Primary Bootloader runs from MBR and jumps to Secondary Bootloader. 

· Secondary Bootloaders loads Operating System. 

 

BIOS-Basic Input Output System 

 

As we have seen that at power up CPU is reset and its registers are set to the 

default value, which is an address pointing or directing to the hardware containing 

BIOS. Generally the hardware is EEPROM containing the BIOS. The tasks 

performed by BIOS are categorized as follows: 

· POST- Power on Self Test is the foremost routine which checks and tests 

the basic hardware. If it fails then it displays error. 



 

Operating System 2017-2020Batch 

  

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   8/25 
  

· Initialization of the hardware devices by letting them run their individual 

BIOS( eg. video card have their own inbuilt BIOS code). 

· Searching for the Master Boot Record and reading it. 

 

· Copying the boot sector code to RAM and then switching the control to it. 

 

Boot Sectors 

 

A sector is a part of the hard disk having length of 512 bytes. A sector is termed as 

boot sector because of its location and because this sector is responsible for the 

further boot process of the system. This boot sector is generally called Master Boot 

Record. The MBR is a 512-byte sector, which is located in the first sector on the 

disk (sector 1 of cylinder 0, head 0). As soon as BIOS gets the boot sector, it tends 

to copy MBR to RAM and switches the execution authority to it. 

 
In the MBR the first 446 bytes are the primary boot loader, which is also referred 

as PBL. 

 

· The next sixty-four bytes are the partition table, which has the record for 

each of the partitions. 
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· The MBR ends with two bytes that should be 0xAA55. These numbers act 

as validation that this sector is the boot sector or Master Boot Record. 

DISK OPERATING SYSTEM: 

 

A disk operating system (abbreviated DOS) is a computer operating system that 

can use a disk storage device, such as a floppy disk, hard disk drive, or optical 

disc. A disk operating system must provide a file system for organizing, reading, 

and writing files on the storage disk 
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DOS (Disk Operating System) is an operating system that runs from a hard disk 

drive. The term can also refer to a particular family of disk operating systems, 

most commonly MS-DOS (Microsoft Disk Operating System). 

MS-DOS (Microsoft Disk Operating System): 

 

Originally developed by Microsoft for IBM, MS-DOS was the standard operating 

system. It is a single-user, single-tasking computer operating system that uses a 

command line interface. 

The main functions of DOS are to manage disk files, allocate system resources 

according to the requirement. DOS provides features essential to control hardware 

devices such as Keyboard, Screen, Disk Devices, Printers, Modems and 

programs.Basically, DOS is the medium through which the user and external 

devices attached to the system communicate with the system. DOS translate the 

command issued by the user in the format that is understandable by the computer 

and instruct computer to work accordingly. It also translates the result and any 

error message in the format for the user to understand. 

TYPES OF DOS COMMANDS: 

 

DOS Commands are instructions to perform tasks on files and directories. They 

are case insensitive. And as you already know, file is the area where we store 

group of information or data, and collection of group of files is called a directory. 

DOS Commands are divided into 2 types: 

 

� Internal Commands: These are for performing basic operations on files 

and directories and they do not need any external file support. 
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� External Commands: These external commands are for performing 

advanced tasks and they do  need some external file support. 

 

Basic Internal Commands: The internal commands are those commands that are 

automatically loaded in the memory. Some commonly used DOS internal 

commands are: 

1. Cls 

2. Dir 

3. Date 

4. Time 

5. Ver 

6. Copycon 

7. Type 

8. Ren 

9. Del 

10. MD 

11. CD 

12. RD 

13. Copy 
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1) Cls :- The purpose of this command is to clear the display screen and 

redisplay the Dos prompt at the top left corner of the screen. 

Syntax:- C : / > Cls 

2) Dir:- It displays the list of directories and files on the screen. 

Syntax:- C : / > dir. 

3) Date: - It displays the current system date. User can also change the current 

date with new date by using this command. 

Syntax: - C : /> date 

Current date is: sat 3-25-2015 Enter of new date (mm-dd-yy):- 

4. Time : - It displays the current systems time user can also change existing 

time with new time by using this command. 

Syntax : - C : / > time 

Current time is 12 : 39 - 48 : 36 p Enter new time : - 

5. VER : It displays the version of DOS being used currently. 

Syntax : - C : / > Ver MS – Dos version 6 : 20 Copy card . 

6. copycon : - The purpose of this command is to create a file. 

Syntax : - C : / > copy con filename . extension 

Saves the contents of file by pressing ctrl +z key combination at the last time of the 

file. File name should not  be greater than 11 characters out of which 8 characters are 

for the name and 3 characters are for the extension. 

Extension is optional : Eg : C : / > copy con ram I am a good boy 

 

1. File is copied. C : / > 
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7. TYPE:- Allows the user to see the contents of a file. 

Syntax :- C :/ >Type path Eg: C:/ > Type D:/> ramu 

8. REN : - The purpose of this command is to rename the old file name with new 

file name. 

Syntax : - C : / > ren oldfilename newfilename C : / > ren ramu somu 

9. DEL:- The purpose of this command is to delete file. The user can also delete 

multiple files by busing this command and long with while cards. 

Syntax : - C : / > Del file name . extension C : / > Del ramu 

C : Del x . prg. 

 

 

10. MD:- The purpose of this command is to create a new directly or sub 

directly i.e sub ordinate to the currently logged directly. 

Syntax : - C : /> MD directory C : /> MD sub directory 

Ex : C : / > MD college 

Now user wants to create a sub directory first year in college directory then C : / > 

cd college 

C : / > college > Md first year 

11. CD : - The purpose of this command is to change from one director to 

another directory or sub – directory. 

Syntax : - C : / > CD directory name 

Ex : C: / > cd college 

C : / > college > CD first year C : / > college > first year > 

If the user wants to move to the parents directory then use CD command as 

C : / > college > first year > cd …. C : / > college > 
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12 . RD: - The purpose of this command is to remove a directory or sub directory. 

If the user wants to remove a directory or sub – directory then first delete all the 

files in the sub – directory and then remove sub directory and remove empty main 

directory. 

13. COPY: The purpose of this command is to copy one or more specified files 

to another disk with same file name or with different file name. 

Syntax : - C : / > copy source path target path C : / > copy A :/> ˜ *. * ˜ C : /> 

chinni 

a. C : / > dir/p – It displays the list of directories or files page wise 

b. C: / > dir/w- It displays the list of directories or files width wise 

c. C : / > dir/d: –It display list of directories or files in drive D 

d. C : / > dir filename . extension – It displays the information of specified file. 

e. C : / > dir file name with wild cards. 

 

Basic External Commands: This commands are not permanent part of the 

memory. To execute or run this commands an external file is required..Some 

commonly used DOS external commands are : 

 

1. CHKDSK:- The command CHSDK returns the configuration status of the 

selected disk. It returns the information about the volume, serial number, total disk 

space, space in directories, space in each allocation unit, total memory and free 

memory. 

Syntax : - C : / > CHKDSK drive name 

Eg:- C : / > CHKDSK e : 

If drive name is not mentioned by default current drive is considered. 

2. Diskcopy : - Disk copy command is used to make duplicate copy of the disk 
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like Xerox copy. It first formats the target disk and then copies the files by collection. 

From the source disk and copied to the target disk. 

Syntax : - C : / > disk copy < source path > < destination path > 

Ex: - c : / > diskcopy A : B : 

NOTE: - This command is used after diskcopy command to ensure that disk is 

copied successfully. 

3. Format : - Format is used to erase information off of a computer diskette or fixed 

drive. 

Syntax : - C : / > format drive name 

Ex : C : / > format A: 

4. Label : This command is used to see volume label and to change volume label. 

 

Syntax : C : / > label drive name 

Ex : C : / > label A: 

5. Scandisk : - This utility is used to repair and check various disk errors. It also 

defects various physical disk errors and surface errors. 

Syntax : - C : / > scandisk < drive names > C : / > Scandisk A : 

6. Move : The purpose of move is move to files from one place to another place. 

Syntax: C : / > Move < source path > < target path > 

7. Print :This command allowed users to print a text file to a line printer. 

Syntax : C : / > Print < files name > C : / > print ramu 

8. Tree : This command displays the list of directories and files on specified path 

using graphical display. It  displays directories of files like a tree. 

Syntax:- C : / > tree > path C : / > tree A: 
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9. Deltree: This command is used to delete files a directories same as by the del 

and RD commands. This command is more useful than del and RD commands 

because it completely removes specified directories ie., disk will all it files and sub – 

directories at a time. 

Syntax:- C : / > deltree (path) C : / > deltree A:/>ramu 

 

Wild Card Characters: It is the set of special characters wild are used with some 

commonly used DOS commands. There are two types of wild cards. 

1. Asterisk (*˜) :The wild 

word will match all characters. 

 

For example: 

 

C : / > dir *.* - will display list of all files and directories. 

 

C : / > dir R*.* - will display all files stored with first character R. 

 

2. Question mark (?): - This wild card represents a single character that a 

group or files have in common. 

C : / > dir  ac .* ˜ - will display all files having any first character and 

remaining name has given in command. 

C : / > dir ??? R . doc - will display all files having extension doc and having 

any first three letters and 

fourth letter is R. 

 

Computer virus: It is a program, script, or macro designed to cause damage, steal 

personal information, modify data, send e-mail, display messages, or some 
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combination of these actions. When the virus is executed, it spreads by copying 

itself into or over data files, programs, or boot sector of a computer's hard drive, or 

potentially anything else writable. To help spread an infection the virus writers use 

detailed knowledge of security vulnerabilities, zero days, or social engineering to 

gain access to a host's computer. 

 

A computer virus is a type of malicious software program ("malware") that, when 

executed, replicates itself by modifying other computer programs and inserting its 

own code. Computer viruses can do considerable damage to computer systems. 

Viruses are infections. Computer infections can come in several forms and your 

computer can "catch" one in several ways: 

 

An email virus is one type of computer virus. An email virus can travel through 

attachments in email messages and can automatically replicate itself by mailing 

itself to dozens or even hundreds of people on your list of contacts found in your 

online address book. There are email viruses that can launch themselves into your 

computer while you are simply viewing the messasge. You don’t even need to 

double-click the message in order for the message to install itself. 

A Trojan horse is not a virus. It is a computer program that claims to be a game 

but, in actuality, will just do damage once you run it. It may even erase your hard 

disk. It cannot automatically replicate itself. 

A worm is a type of software called mallware that uses security holes and 

computer networks in order to replicate itself. The worm will scan the network for 

machines which carry a particular security hole. It will then copy itself to the 

machine through the security hole and will start replicating itself. 

Viruses in general, start working and spreading once you start using the 

application or program to which the virus is attached. For instance, a program 

that has a virus in it will place the virus in the system’s memory each time that 
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program is run. 

 

Once the virus is in the memory, one of several things can happen. First, it can be 

programmed to attach itself to other programs and applications, folders, or disks. 

Second, if given the chance, it can infect a network. 

 

 

Cryptology: Cryptography or cryptology is the practice and study of techniques 

for secure communication in the presence of third parties 

 

The field of cryptology includes both the study of and practice of securing 

information in the presence of untrusted third parties or adversaries. Specifically, 

it is focused on creating and analyzing the protocols used to subvert attempts by 

adversaries to gain access to or interrupt the flow of information between trusted 

parties. Specific focus areas of cryptology include data confidentiality, 

authentication, non-repudiation, and data integrity. The modern-day field of study 

has grown to include advanced applications from the computer science, math, and 

electrical engineering disciplines. Applications include secure communications, 

eCommerce, network and computer passwords, and debit and credit cards. 

 

Windows Operating System: 

 

The Windows operating systems (Windows OS) are more formally called Microsoft 

Windows and is a family of operating systems for personal computers. Windows 

dominates the personal computer world, running, by some estimates, more than 

90 percent of all personal computers – the remainder running Linux and Mac 

operating systems.Windows provides a graphical user interface (GUI), virtual 
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memory management, multitasking, and support for many peripheral devices. In 

addition to Windows OS for personal computers, Microsoft also offers operating 

systems for servers and personal mobile devices. 

 

These are the different Versions of Windows Family: 
 

 

Operating System 

 

Version Number 

Windows 1.0 1.04 

Windows 2.0 2.11 

Windows 3.0 3 

Windows NT 3.1 3.10.528 

Windows for Workgroups 

3.11 

3.11 

Windows NT Workstation 3.5 3.5.807 

Windows NT Workstation 

3.51 

3.51.1057 

Windows 95 4.0.950 

Windows NT Workstation 4.0 4.0.1381 

Windows 98 4.1.1998 

Windows 98 Second Edition 4.1.2222 

Windows Me 4.90.3000 

Windows 2000 Professional 5.0.2195 

Windows XP 5.1.2600 

Windows Vista 6.0.6000 

Windows 7 6.1.7600 

Windows 8.1 6.3.9600 
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Windows XP: 

Windows XP (codenamed Whistler) is a personal computer operating system that 

was produced by Microsoft as part of the Windows NT family of operating systems. 

It was released to manufacturing on August 24, 2001, and broadly released for 

retail sale on October 25, 2001.Windows XP received generally positive reviews, 

with critics noting increased performance (especially in comparison to Windows 

ME), a more intuitive user interface, improved hardware support, and its expanded 

multimedia capabilities.[6] Despite some initial concerns over the new licensing 

model and product activation system, Windows XP eventually proved to be popular 

and widely used. 

 

Features of Windows XP: 

 Reliable 

 Windows file protection 

 Windows installer 

 Encrypting File System 

 Windows firewall 

 Windows Security Center 

 Fresh Visual Design 

 Work with rich media 

 Remote connectin 

 Use of multiple monitors 

 Integrated CD burning 

 Offline folder feature 
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Basic Components /Elements Of Windows: 

The Desktop is the basic opening screen in Windows. It consists of 3 primary 

elements that are broken down into sub-elements. Here is a picture of a simple 

desktop with the default colors. 

 

 

 

 

The entire gray bar at the bottom is the TaskBar. The Start Menu, Quick Launch 

Toolbar and the Systray are all sub parts or elements of the Taskbar. Each of these 

elements are separated by a vertical line.All of the icons are called Objects. The 

element of the Desktop that is overlooked by many is the blank area. 

Placing the mouse cursor over any element and clicking the right mouse button 

displays a menu that varies by the location of the cursor. 
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ICONS: An icon is a pictogram or ideogram displayed on a computer screen in 

order to help the user navigate a computer system. In a computer's graphical user 

interface ( GUI ), an icon is an image that represents an application, a capability, 

or some other concept or specific entity with meaning for the user. An icon is 

usually selectable but can also be a nonselectable image such as a company's logo. 

 

Task Bar: The system tray is part of the task bar and displays the current time as 

well as the status icons. 

 

Structure of Windows: 

The various parts of windows are as follows: 

 

 

 

On the topmost part of a window there is always a bright colored (by default this 

color is blue, but you can change it) bar called the titlebar. This bar has several 
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parts. 

1. Control Icon: This is situated on the extreme left side of the titlebar and 

different applications put different icons there. By clicking on it, you will get a 

menu (as pictured below) which lets you move, re- size, minimize, maximize, and 

close the window. Of course, you can do all of these in other ways without using 

the control icon. 

2. Document name and Application name: These names appear on this bar and 

hence the name titlebar. Unless you have named your document (i.e., saved the 

file with a file name) most applications will put there names like Untitled, 

Document.The above picture of a typical application window was created by using 

Windows free word processor WordPad, So on the titlebar, it says "Document - 

WordPad". 

3. Minimize, Maximize, Close: These three buttons are always located 

on the extreme right side of the titlebar and their functions are obvious. Clicking 

on the minus (-) sign will minimize the window and it will become just a button on 

the taskbar. Clicking on the square box sign will maximize the window and it will 

expand to fill the entire desktop. 

3. Just under the titlebar is the menubar. As the name suggests, it holds the menu 

of commands. As in a restaurant menu, the commands are grouped into 

categories. Instead of Appetizers, Soups, Entrees, Desserts, Hot Drinks, Cold 

Drinks, etc. we have things like File, Edit, View, Insert, Format, Help, etc. here. 

4. Under the menubar comes the toolbar. This bar holds tools for the commonly 

executed commands. Just clicking on the command's icon executes the command 

and hence saves time needed to find the command from the menubar and then 

clicking on it. Most modern day programs use the same icons for the commonly 

executed commands. 



 

Operating System 2017-2020Batch 

  

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   24/25 
  

 

 

5. The large blank area in the middle of the application window that covers the most 

area of the window is for holding the document you are creating, or editing, or 

viewing is called work area. 

6. Below the document area runs the statusbar. In this area Windows notifies you 

about what is currently happening, such as when you are saving a file, it might tell 

you Saving ... or Done. 

7. When the document is too big (too long, too wide, or both) for the window to 

display in its document holding area, Windows automatically inserts scrollbars 

and scroll boxes as shown in the windows picture above. The vertical scrollbar is 

for scrolling up and down the window. 

The horizontal scrollbar is for scrolling side to side. Scrolling is done either by 

clicking on the scroll arrows - one click at a time, or by pressing a scroll arrow 

with the mouse pointer and keep it pressed, or by clicking directly on the scrollbar, 

or by dragging the scroll box with the mouse pointer. 

 

Control Panel: 

The Control Panel is a part the Microsoft Windows, in older versions, which allows 

users to view and manipulate basic system settings and controls via applets, such 

as adding hardware, adding and removing software, controlling user accounts, and 

changing accessibility options. Additional applets can be provided by third party 

software.The Control Panel has been an inherent part of the Microsoft Windows 

operating system since Windows 2.0,[1] with many of the current applets being 

added in later versions. Beginning with Windows 95, the Control Panel is 

implemented as 

a special folder, i.e. the folder does not physically exist, but only contains 

https://en.wikipedia.org/wiki/Control_Panel_(Windows)
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shortcuts to various applets such as Add or Remove Programs and Internet Options. 
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S.NO QUESTIONS OPTION 1 OPTION 2 OPTION 3 OPTION 4 ANSWER

1 The part of machine level instruction, which tells the central processor what has to be done, is Operation code Address Locator Flip-Flop Operation code
2  Most operating systems are comprised of three main components: the _____, the file system, and the shell.  desktop  kernel  user interface  code  kernel
3  The ________ keeps track of directories and files.  kernel  file system  shell  user interface  file system

4 A system program that combines the separately compiled modules of a program into a form suitable for execution assembler linking loader cross compiler load and go linking loader
5 Process is program in High level language

kept on disk
contents of main memory a program in execution a job in secondary memory a program in execution

6 Interprocess communication is required for all processes is usually done via disk drives is never necessary allows processes to synchronize
activity

allows processes to
synchronize activity

7 User-Friendly Systems are required for object-oriented
programming

easy to develop common among traditional
mainframe operating systems

becoming more common becoming more common

8 A system program that sets up an executable program in main memory ready for execution is assembler linker loader compiler loader
9 The operating system is an example of a computer ___________.  object  file system  program  desktop  program
10  Most often, you click with the ________ button when you want to select something.  middle  left  right  all of the above  left

11  Before the days of Windows, users interfaced with the operating system through a _________ interface.  graphical  object oriented  command utility  command line  command line

12 What is the name given to the organized collection of software that controls the overall operation of a computer? Working system Peripheral system Operating system Controlling system Operating system
13  The _______ is often used as part of a path.  comma  forward slash  backslash  semicolon  backslash

14  The _______ is often used in a switch.  comma  forward slash  backslash  semicolon  forward slash

15 Resolution of externally defined symbols is performed by Linker Loader Compiler Assembler Linker
16 System generation is always quite simple is always very difficult varies in difficulty between systems requires extensive tools to be

understandable
varies in difficulty between
systems

17 The _______ is the entire window that fills your computer screen and its contents.  System Tray  Taskbar  Desktop  Quick Launch Toolbar  Desktop

18  A quicker way to launch a program is to click on it in the ___________________.  System Tray  Taskbar  Desktop  Quick Launch Toolbar  Quick Launch Toolbar
19  If you right click on a file or folder, one of the context menu options is ________.  remote  send to  copy to  rename to  send to
20 While working with MS-DOS, which command will you use to transfer a specific file from one disk to another? DISKCOPY COPY RENAME FORMAT COPY
21  You can drop a file onto the start button to add it to the ________.  Quick Launch Toolbar  Taskbar  Start menu  Recycle Bin  Start menu
22  Many operating system directory structures are _______________.  discrete  disparate  virtual  hierarchical  hierarchical
23 Bug means A logical error in a program A difficult syntax error in a program Documenting programs using an

efficient documentation tool
keeps track of each and every
memory location

A logical error in a program

24 Memory management is not used in modern operating
system

replaced with virtual memory on
current systems

not used on multiprogramming
systems

critical for even the simplest
operating systems

critical for even the simplest
operating systems

25  The ___________ of a directory structure is the topmost directory on the disk.  root  tree  subdirectory  base  root

26 An algorithm is best described as A computer language A step by step procedure for solving
a problem

A branch of mathematics the address of the data is supplied by
the users

A step by step procedure for
solving a problem

27  ____________ Explorer is a Web browser that allows to more easily navigate the Internet.  Windows  Netscape  Internet  Microsoft  Internet

28  ______________ Explorer is a tool that lets you more easily navigate the files and folders on your computer.  Windows  Netscape  Internet  Microsoft  Windows

29 What is a shell ? is a hardware component It is a command interpreter It is a part in compiler It is a tool in CPU scheduling  It is a command interpreter
30  A floppy disk can hold ___________ when it is formatte  2.0 MB  1.44 KB  1.44 MB  2.0KB  1.44 MB
31 Virtual memory is ..... ? An extremely large main memory An extremely large secondary

memory
An illusion of extremely large main
memory

A type of memory used in super
computers

An illusion of extremely large
main memory

32  Examples of file ____________ are read only, hidden, and archive.  types  sizes  attributes  formats  attributes

33  If you ________ a file you now have more than one instance of it; if you ____________ a file, you only have one instance of it.  borrow/delete  move/copy  copy/move  none of the above  copy/move

34  Each copy of the file is referred to as a different _________of the file.  attribute  element  version  facet  version
35 Software that measures, monitors, analyzes, and controls real-world events is called system software real-time software scientific software business software real-time software
36 ____________ is referred to as a path using the proper syntax.  c;windows/desktop  c:>  c:\windows\desktop\My Documents  c:winnt/system32  c:\windows\desktop\My

Documents
37  Symbolic names can be associated with  Information  data or instruction  operand   mnemonic operation  data or instruction
38 Correcting errors in a program is referred to as Debugging bugging Rectifying modifying Debugging
39  The Recycle Bin is configured automatically to be able to store files equal to __________ of the size of your hard disk.  1 percent  5 percent  10 percent  15 percent  10 percent

40 PCB = Program Control Block Process Control Block Process Communication Block Program Communication Block Process Control Block
41 _____________ keeps track of the computers around you in a networked environment.  My Computers  FTP  Add Network Place  My Network Places  My Network Places

42  If you right click on a file or folder, one of the context menu options is ____________.  remote  send to  copy to  rename to  send to
43  Load address for the first word of the program is called  Linker address origin   load address origin  Phase library  absolute library   load address origin
44 Virtual memory is  simple to implement  used in all major commercial

operating systems
 less efficient in utilization of
memory

 useful when fast I/O devices are not
available

 used in all major commercial
operating systems

45 A computer system that permits multiple users to run programs at same time Real time system Multi tasking system Time Sharing Multi processing Multi tasking system
46 Resolution of externally defined symbols is performed by Linker Loader Compiler Assembler Linker
47 A translator is best described as an application software a system software a hardware component a software component a system software
48  Which amongst the following is not an advantage of Distributed systems?  Reliability  Incremental growth  Resource sharing   None of the above  Reliability
49  Which of the following loader is executed when a system is first turned on or  restarted  Boot loader   Compile and Go loader  Bootstrap loader   Relating loader  Bootstrap loader
50 Which command is used to clear the screen Cls Clear Clscreen Clr Cls
51  internal command in Dos are  Cls, rd label Dir, ren, sys Time, type, dir Del, disk copy, label Time, type, dir
52 Which keys can be pressed quit without saving in DOS Ctrl + A  Ctrl + B Ctrl + C Ctrl + D Ctrl + C
53  Translator for low level programming language were termed as  Assembler   Compiler  Linker  Loader  Assembler
54 Which of the following commands is given to reboot the Computer? Ctrl + Alt + Del Ctrl + Alt + TAB Ctrl + Shift + Del Ctrl + Alt + Shift Ctrl + Alt + Del
55 A program in execution is called process function CPU  Memory process
56 Which of the following is a block device mouse printer terminals disk disk
57 Bootstrap or vector is called Main program Grappling hook program Secondary program Primary storage Main program
58 What is the name given to all the programs inside the computer with makes it usable? Application software System software Firm ware Shareware System software
59 If you want to execute more than one program at a time, the systems software you are using must be capable of word processing virtual memory compiling multitasking multitasking
60 Resolution of externally defined symbols is performed by  Linker  Loader  Compiler   Editor  Linker
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POSSIBLE QUESTIONS 

PART A (1 MARK) 

(Online Examiantions) 

 

 

PART B(2 MARKS) 

 

1. What is Bootingup? 

2. Define OS 

3. Name any four Operating Systems. 

4. What is Wild card ?Give Example 

5. Name any four Internal Commands. 

6. Name some of the windows Accessories? 

7. Define Cryptology 

8. What is Virus? Give example 

9. What are all the uses for Control Panel? 

10. What is the use of DIR, COPY commands? 

11. What is updating Anti-virus Program means? 
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PART C (6 MARKS) 

 

1. Define cryptology and the characteristics of Cryptology 

2. Explain Distributed Operating system and Parallel Operating system 

3. Explain Booting Process in detail 

4. Explain Control panel settings 

5. Explain the functions of Operating system 

6. Explain any six internal commands in detail 

7. Explain Disk operating System 

8. Explain Wild cards in detail 

9. Explain the types of Operating system 

10. Write a note on Computer Virus and steps for preventing it. 
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Unit III 

MS Office: Ms Word – Meaning – Word Processing – Meaning and Features of Word Processing – 

Advantages and Applications of Word Processing – Toolbars – Creating, Saving and Closing a document – 

Moving and copying text – Text and Paragraph formatting, Applying Bullets and Numbering. 
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UNIT-III 

MS OFFICE 

 

WORD PROCESSING: 

 

 Word processing software is used to manipulate a text document, such as a 

resume or a report.  

 

 To enter text by typing and the software provides tools for copying, deleting 

and various types of formatting. 

 Word processing includes a number of tools to format your pages.  

 For example, you can organize your text into columns, add page numbers, 

insert illustrations, etc.  

 However, word processing does not give you complete control over the look 

and feel of your document.  

 When design becomes important, you may need to use desktop publishing 

software to give you more control over the layout of your pages. 

 Word processing software typically also contains features to make it easier for 

you to perform repetitive tasks.  

 For example, let's say you need to send a letter to all your customers 

regarding a new policy.  

 The letter is the same for all customers except for the name and address at 

the top of the letter. 

 Text editors shouldn't be confused with word processing software. While they 

do also allow you to create, edit and save text documents, they only work on plain 

text.  
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 Text editors don't use any formatting, such as underlined text or different 

fonts.  

 Text editors serve a very different purpose from word processing software. 

 They are used to work with files in plain text format, such as source code of 

computer programs or configuration files of an operating system.  

 An example of a text editor would be Notepad on the Windows platform. 

Features of Word Processing:  

Some of the functions of word processing software include: 

 

 Creating, editing, saving and printing documents. 

 Copying, pasting, moving and deleting text within a document. 

 Formatting text, such as font type, bolding, underlining or italicizing. 

 Creating and editing tables. 

 Inserting elements from other software, such as illustrations or photographs 

 Correcting spelling and grammar. 

 Collaborative editing, allowing multiple users to work on the same document. 

 Indexing assistance. 

 Automatically managed (updated) cross-references to pages or notes. 

 Version control of a document, permitting reconstruction of its evolution. 

 Non-printing comments and annotations. 

 

 There are a number of different word processing applications.  

 One of the most widely used ones is Word, which is part of Microsoft Office.  

 Another widely used one is WordPerfect by the Corel Corporation.  

 A third one is Writer, which is part of OpenOffice by Apache.  

 While the first two are commercial software, OpenOffice is open source and 

can be downloaded and used free of charge.  

 Finally, there is Pages, which is part of iWork by Apple. 

https://en.wikipedia.org/wiki/Index_(publishing)
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Ms Word: 

Microsoft Word is a word processor developed by Microsoft. It was first released on 

October 25, 1983 under the name Multi-Tool Word for Xenix systems. The first 

version of Word for Windows was released in 1989. Word for Windows is available 

stand-alone or as part of the Microsoft Office suite. Word contains rudimentary 

desktop publishing capabilities and is the most widely used word processing 

program on the market. Word files are commonly used as the format for sending 

text documents via e- mail because almost every user with a computer can read a 

Word document by using the Word application, a Word viewer or a word processor 

that imports the Word format. 

Working in the Word Environment: 

 

As with all programs in the 2007 Microsoft Office release, the most common way to 

start Word is from the Start menu displayed when you click the Start button at the 

left end of the Microsoft Windows taskbar. 

If Word is the first program in the 2007 Office system that you have used, you are 

in for a surprise! The look of the program window has changed radically from 

previous versions. 
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The new Word environment is designed to more closely reflect the way people 

generally work with the program. When you first start Word, this environment 

consists of the following elements: 

 

 Commands related to managing Word and Word documents as a whole 

(rather than document content) are gathered together on a menu that is displayed 

when you click the Microsoft Office Button. 

 Commands can be represented as buttons on the Quick Access Toolbar to the 

right of the Microsoft Office Button. By default, this toolbar displays the Save, 

Undo, and Repeat buttons, but you can customize the toolbar to include any 

command that you use frequently. 

 The title bar displays the name of the active document. At the right end of the 

title bar are the three familiar buttons that have the same function in all Windows 

programs. You can temporarily hide the Word window by clicking the Minimize 

button, adjust the size of the window with the Restore Down/Maximize button, and 

close the active document or quit Word with the Close button. 

 Below the title bar is the Ribbon, which makes all the capabilities of Word 

available in a single area so that you can work efficiently with the program. 

 Commands related to working with document content are represented as 

buttons on the tabs that make up the Ribbon. The Home tab is active by default. 

Clicking one of the other       tabs,       such       as        Insert,        displays        

that        tab's        buttons.     If Microsoft Outlook with Business Contact Manager 

is installed on your computer, you will have a Business Tools tab in addition to 

those shown in our graphics. 

 On each tab, buttons are organized into groups. Depending on the size of the 

program window, in some groups the button you are likely to use most often is 

bigger than the rest. 

 Depending on your screen resolution and the size of the program window, a 

tab might not have enough room to display all of its groups. In that case, the name 
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of the group resembles a button, and clicking the button displays the group's 

commands. 

 Related but less common commands are not represented as buttons in the 

group. Instead they are available in a dialog box, which you can display by clicking 

the Dialog Box Launcher at the right end of the group's title bar. 

 Some button names are displayed and some aren't. Pausing the mouse 

pointer over any button for a few seconds (called hovering) displays a ScreenTip 

with not only the button's name but also its function. 

 Some buttons have arrows, but not all arrows are alike. If you point to a 

button and both the button and its arrow are in the same box and are the same 

color, clicking the button will display options for refining the action of the button. If 

you point to a button and the button is in one box and its arrow is in a different box 

with a different shade, clicking the 

 button will carry out that action with the button's current settings. If you 

want to change those settings, you need to click the arrow to see the available 

options. 

 The Microsoft Office Word Help button appears at the right end of the Ribbon. 

 You create a document in the document window. When more than one 

document is open, each document has its own window. 

 

Across the bottom of the program window, the status bar gives you information 

about the current document. You can turn off the display of an item of information 

by right-clicking the status bar and then clicking that item. 
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 At the right end of the status bar is the View toolbar, which provides tools for 

adjusting the view of document content. 

 

Now you will start Word and explore the Microsoft Office Button and the tabs and 

groups on the Ribbon. Along the way, you will see how to take advantage of 

galleries and live preview. There are no practice files for this tutorial. Be sure to 

start your computer, but don't start Word yet. 

 

1. On the taskbar, click the Start button, click All Programs, click Microsoft 

Office, and then click Microsoft Office Word 2007. 

The Word program window opens, displaying a blank document. 

2. Click the Microsoft Office Button. 

Commands related to managing documents (such as creating, saving, and printing) 

are available from the menu that opens. This Office menu, takes the place of the 
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File menu that appeared in previous versions of Word. 

The commands on the left are for tasks related to the document as a whole. After 

you have worked with a document, its name appears in the Recent Documents list 

so that you can quickly open it again. At the bottom of the menu are buttons for 

changing program options and for quitting Word. 

3. Press the Escape key to close the menu. 

On the Ribbon, the Home tab is active. Buttons related to working with document 

content are organized on this tab in five groups: Clipboard, Font, Paragraph, Styles, 

and Editing. Only the buttons representing commands that can be performed on 

the currently selected document element are active. 

4. However the mouse pointer over the active buttons on this tab to display the 

ScreenTips that name them and describe their functions. 

Depending on your screen resolution and the size of the program window, you 

might see more or fewer buttons in each of the groups, or the buttons you see 

might be represented by larger or smaller icons. Experiment with the size of the 

program window to understand the effect on the appearance of the tabs. 

5. Click the Insert tab, and then explore its buttons. 

Buttons related to all the items you can insert are organized on this tab in seven 

groups: Pages, Tables, Illustrations, Links, Header and Footer, Text, and Symbols. 

6. Click the Page Layout tab, and then explore its buttons. 

Buttons related to the appearance of your document are organized on this tab in 

five groups: Themes, Page Setup, Page Background, Paragraph, and Arrange. 

 

Creating, Opening, Saving and Closing a Document: 

 

To create a Word document, you simply open a new blank document and type your 

content. The blinking insertion point shows where the next character you type will 

appear. When the insertion point reaches the right margin, the word you are typing 
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moves to the next line. Because of this word wrap feature, which is common in 

word-processing and desktop-publishing programs, you press Enter only to start a 

new paragraph, not a new line. 

 

Each document you create is temporary unless you save it as a file with a unique 

name or location. To save a document for the first time, you click the Save button 

on the Quick Access Toolbar or click the Microsoft Office Button and then click 

Save. Either action displays the Save As dialog box, where you can assign the name 

and storage location. 

 

If you want to save the document in a folder other than the one shown in the 

Address bar, you can click the chevrons to the left of the current folder name and 

then navigate to the folder you want. You can also click Browse Folders to display 

the Navigation Pane and a toolbar. If you want to create a new folder in which to 

store the file, you can click the New Folder button on this toolbar. 

 

After you save a document the first time, you can save changes simply by clicking 

the Save button. The new version of the document then overwrites the previous 

version. If you want to keep both the new version and the previous version, click 

Save As on the Office menu, and then save the new version with a different name in 

the same location or with the same name in a different location. 

 

To open an existing document, you click the Microsoft Office Button and then click 

Open to display the Open dialog box. The first time you use this command, the 

dialog box displays the contents of your Documents folder. If you display the dialog 

box again in the same Word session, it displays the contents of whatever folder you 

last used. To see the contents of a different folder, you use standard Windows 

techniques. After you locate the file you want to work with, you can double-click it 

to open it. 
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Clicking a file name and then clicking the Open arrow in the lower-right corner of 

the Open dialog box displays a list of alternative ways in which you can open the 

file. To look through the document without making any inadvertent changes, you 

can open the file as read-only, or you can open an independent copy of the file. You 

can open an file in a Web browser, or open an XML file with a transform. In the 

event of a computer crash or other similar incident, you can tell Word to open the 

file and attempt to repair any damage. And you can display earlier versions of the 

file. 

 

To move around in an open document without changing the location of the 

insertion point, you can use the vertical and horizontal scroll bars in the following 

ways: 

 

1. Click the scroll arrows to move the document window up or down by a line, or 

left or right by a few characters. 

 

2. Click above or below the vertical scroll box to move up or down one window, 

or to the left or right of the horizontal scroll box to move left or right one window. 

3. Drag the scroll box on the scroll bar to display the part of the document 

corresponding to the location of the scroll box. For example, dragging the scroll box 

to the middle of the scroll bar displays the middle of the document. 

 

You can also move around in a document in ways that do move the insertion point. 

To place the insertion point at a particular location, you simply click there. To move 

the insertion point back or forward a page, you can click the Previous Page and 

Next Page buttons below the vertical scroll bar. 

 

If more than one document is open, you can close it by clicking the Close button at 
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the right end of the title bar. If only one document is open, clicking the Close button 

closes the document and also quits Word. If you want to close the document but 

leave Word open, you must click the Microsoft Office Button and then click Close. 

Moving and Copying Text: Typing and inserting Text 

To enter text, just start typing! The text will appear where the blinking cursor is 

located. 

Move the cursor by using the arrow buttons on the keyboard or positioning the 

mouse and clicking the left button. The keyboard shortcuts listed below are also 

helpful when moving through the text of a document: 

Move Action Keystroke 

 Beginning of the line HOME 

 End of the line END 

 Top of the document CTRL+HOME 

 End of the document CTRL+END 

 Move in a blank document Tab, Enter and space bar 

Selecting Text 

To change any attributes of text it must be highlighted first. Select the text by 

positioning before or after a text and dragging the mouse over the desired text while 

keeping the left mouse button depressed, or hold down the SHIFT key on the 

keyboard while using the arrow buttons to highlight the text. The following table 

contains shortcuts for selecting a portion of the text: Selection Technique 

Whole word double‐click within the word. 

Whole paragraph triple‐click within the paragraph Several words or lines drag the 

mouse over the words, or hold down SHIFT while using the arrow keys. 

Entire document choose Editing Select All from the Ribbon, or press CTRL+A 

button deselect the text by clicking anywhere outside of the selection on the page or 

press an arrow key on the keyboard. 
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Inserting Additional Text 

Text can be inserted in a document at any point using any of the following methods: 

 Type Text: Put your cursor where you want to add the text and begin typing 

 Copy and Paste Text: Highlight the text you wish to copy and right click and 

click 

 Copy, put your cursor where you want the text in the document and right 

click and click 

Paste. Or hold down the CTRL and the “C” key at the same time 

 Cut and Paste Text: Highlight the text you wish to copy and right click and 

click Cut, put your cursor where you want the text in the document and right click 

and click Paste. 

 Drag Text: Highlight the text you wish to move, click on it and drag it to the 

place where you want the text in the document. 

 

You will notice that you can also use the Clipboard group on the Home Tab of the 

Ribbon. 
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Rearranging Blocks of Text 

To rearrange text within a document, you can utilize the Clipboard Group on the 

Home Tab of the Ribbon. 

Insert picture of clipboard group labeled 

 Move text: Cut and Paste or Drag as shown above 

 Copy Text: Copy and Paste as above or use the Clipboard group on the 

Ribbon 

 Paste Text: Ctrl + V (hold down the CTRL and the “V” key at the same 

time) or use the Clipboard group to Paste, Paste Special, or Paste as Hyperlink 

 

 

Deleting Blocks of Text 

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace 

will delete text to the left of the cursor and Delete will erase text to the right. To 

delete a large selection of text, highlight it using any of the methods outlined above 

and press the DELETE key. 

Search and Replace Text 

To find a particular word or phrase in a document: 

 Click Find on the Editing Group on the Ribbon; Or hold down the 

CTRL and the “F” key at the same time 

 To find and replace a word or phrase in the document, click Replace on 
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the Editing Group of Ribbon. 

� 

 

 

 

 

 

 

Undo Changes 

To undo changes: 

 Click the Undo Button on the Quick Access Toolbar. 

There are many features to help you proofread your document. These include: 

Spelling and Grammar, Thesaurus, AutoCorrect, Default Dictionary, and Word 

Count. 

 

FIND AND REPLACE TEXT: 

 

Word's Find and Replace function will search your documents for specific text, 

which can then be highlighted, replaced with different text or formatting, or left as-

is. This function provides many advanced options to help make your search as 

specific as necessary to find what you are looking for. 

 

 Finding Text 

 Replacing Text 

 

https://www.uwec.edu/help/Word07/find-replace.htm
https://www.uwec.edu/help/Word07/find-replace.htm
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Finding Text 

 

Word allows you to find specific text in a variety of ways. You may choose to view 

each occurrence of the text individually, see all occurrences selected at once, or 

highlight all occurrences even after the Find and Replace dialog box is closed. 

 

Accessing the Find and Replace Dialog Box 

 

To find text, you must first access the Find and Replace dialog box. 

 

1. Windows: From the Home command tab, in the Editing group, click FIND 

or Press [Ctrl] + [F] 

The Find and Replace dialog box appears, with the Find tab displayed. 

 

Finding Individual Occurrences 

1. Access the Find and Replace dialog box 

2. In the Find what text box, type the text you want to search for 

3. To set advanced options 

Windows: Click MORE >> 

Select the desired options 

https://www.uwec.edu/help/Word07/find-replace.htm


Ms‐Office 2017-2020 Batch 

 

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   17/33  

4. Click FIND NEXT 

the first occurrence of the text is highlighted. NOTES: 

The appearance of your document may change as it moves to display the 

highlighted item. 

The text that is highlighted will be the first occurrence in the document after the 

location of your insertion point. (i.e., if your insertion point was placed in the 

middle of the document, this may not be the first occurrence in the document as a 

whole.) 

5. To find more occurrences of the text, repeat step 4 

NOTE: When Word has shown you every occurrence of the text, a dialog box will 

appear with the message "Word has finished searching the document." 

6. Click OK 

7. When finished, to close the Find and Replace dialog box, click CLOSE or 

Click 

CANCEL 

 

Finding All Occurrences 

 

This option will highlight all occurrences of your text until the Find and Replace 

dialog box is closed. 

 

1. Access the Find and Replace dialog box 

2. In the Find what text box, type the text you want to search for 

3. To set advanced options 

Windows: Click MORE >> 

Select the desired options 

4. Windows: Click FIND IN » select Main Document 

5. Click FIND ALL All occurrences of the text are highlighted. 

https://www.uwec.edu/help/Word07/find-replace.htm
https://www.uwec.edu/help/Word07/find-replace.htm
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6. To close the Find and Replace dialog box, click CLOSE or Click CANCEL 

 

Highlighting All Occurrences 

 

This option will highlight all occurrences of your text until you choose to clear the 

highlighting. NOTE: This option is for Windows only. 

To highlight all occurrences: 

 

1. Access the Find and Replace dialog box 

2. In the Find what text box, type the text you want to search for 

3. To set advanced options 

a. Click MORE >> 

b. Select the desired options 

4. Click READING HIGHLIGHT » select Highlight All 

All occurrences of the text are highlighted in yellow. 

5. To close the Find and Replace dialog box, click CLOSE or Click CANCEL 

 

To clear all highlighting: 

 

1. Access the Find and Replace dialog box 

2. Click READING HIGHLIGHT » select Clear Highlighting 

All highlighted text returns to normal. 

3. To close the Find and Replace dialog box, click CLOSE or Click CANCEL 

 

Replacing Text 

 

Word allows you to choose how to replace text in your document. You may choose 

to replace all occurrences of a particular word or phrase or look at each occurrence 

https://www.uwec.edu/help/Word07/find-replace.htm
https://www.uwec.edu/help/Word07/find-replace.htm
https://www.uwec.edu/help/Word07/find-replace.htm
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before deciding which to replace. 

 

Accessing the Find and Replace Dialog Box 

1. Windows: From the Home command tab, in the Editing group, click REPLACE or 

Windows: Press [Ctrl] + [H] 

The Find and Replace dialog box appears, with the Replace tab displayed. 

Replacing Individual Occurrences 

 

1. Access the Find and Replace dialog box 

2. In the Find what text box, type the text you want to be replaced 

3. In the Replace with text box, type the text that you want to insert 

4. To set advanced options 

Windows: Click MORE >> 

Select the desired options 

5. To find the first occurrence of your text, click FIND NEXT 

The first occurrence of the text is highlighted. NOTES: 

The appearance of your document may change as it moves to display the 

highlighted item. 

The highlighted text will be the first occurrence in the document after the location 

of your insertion point (i.e., if your insertion point was placed in the middle of the 

document, this may not be the first occurrence in the document as a whole). 

https://www.uwec.edu/help/Word07/find-replace.htm
https://www.uwec.edu/help/Word07/find-replace.htm
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6. To replace the selected text, click REPLACE 

To leave this instance as-is and proceed to the next item, click FIND NEXT 

The next occurrence is highlighted. 

7. Click OK 

8. Repeat step 6 until you have replaced all desired occurrences 

NOTE: When Word has shown you every occurrence of the text, a dialog box will 

appear with the message "Word has finished searching the document." 

9. To close the Find and Replace dialog box, click CLOSE or Click CANCEL 

 

Replacing All Occurrences 

 

This option will replace every occurrence of your text without showing you where 

the text was replaced. 

 

WARNING: Use this option with care, as it may change the meaning of your 

document if text is replaced where it should not be. 

 

1. Access the Find and Replace dialog box 

2. In the Find what text box, type the text you want replaced 

3. In the Replace with text box, type the text that you want to insert 

4. To set advanced options 

Windows: Click MORE >> 

Select the desired options 

5. Click REPLACE ALL 

A dialog box appears, informing you of how many instances of the text were 

replaced. 

6. Click OK 

https://www.uwec.edu/help/Word07/find-replace.htm
https://www.uwec.edu/help/Word07/find-replace.htm
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7. To close the Find and Replace dialog box, click CLOSE or Click CANCEL 

 

Text and Paragraph Formatting: 

Text formatting: 

Styles 

A style is a format enhancing tool that includes font typefaces, font size, effects 

(bold,  italics, 

underline, etc.), colors and more. You will notice that on the Home Tab of the 

Ribbon, that you have several areas that will control the style of your document: 

Font, Paragraph, and Styles. 

 

 

Change Font Typeface and Size 

To change the font typeface: 

 Click the arrow next to the font name and choose a font. 

 

 Remember that you can preview how the new font will look by 

highlighting the text, and hovering over the new font typeface. 
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To change the font size: 

 Click the arrow next to the font size and choose the appropriate size, or 

 Click the increase or decrease font size buttons. 

 

 

Font Styles and Effects 

Font styles are predefined formatting options that are used to emphasize text. They 

include: Bold, Italic, and Underline. To add these to text: 

 Select the text and click the Font Styles included on the Font Group on 

the Home Tab of the Ribbon, or 

 Select the text and right click to display the font tools 

 

 

Change Text Color 

To change the text color: 
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 Select the text and click the Colors button included on the Font Group 

on the Home Tab of the Ribbon, or highlight the text and right click and choose the 

colors tool. 

 Select the color by clicking the down arrow next to the font color button. 

 

 

Highlight Text 

Highlighting text allows you to use emphasize text as you would if you had a 

marker. To highlight text: 

 Select the text 

 Click the Highlight Button on the Font Group on the Home Tab of the 

Ribbon, or 

 Select the text and right click and select the highlight tool 

 To change the color of the highlighter click on down arrow next to the 

highlight button, Then choose the suitable one. 

 

Copy Formatting 

If you have already formatted text the way you want it and would like another 

portion of the 

document to have the same formatting, you can copy the formatting. To copy the 

formatting, 

do the following: 

 Select the text with the formatting you want to copy. 

 Copy the format of the text selected by clicking the Format Painter 

button on the clipboard Group of the Home Tab 

 Apply the copied format by selecting the text and clicking on it. 
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Clear Formatting 

To clear text formatting: 

 Select the text you wish to clear the formatting 

 Click the Styles dialogue box on the Styles Group on the Home Tab 

 Click Clear All 

 Formatting paragraphs allows you to change the look of the overall 

document. You can access many of the tools of paragraph formatting by clicking the 

Page Layout Tab of  the ribbon or the Paragraph Group on the Home Tab of the 

Ribbon. 
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Formatting Paragraphs: 

Change Paragraph Alignment 

The paragraph alignment allows you to set how you want text to appear. To change 

the alignment: 

 Click the Home Tab 

 Choose the appropriate button for alignment on the Paragraph Group. 

o Align Left: the text is aligned with your left margin 

o Center: The text is centered within your margins 

o Align Right: Aligns text with the right margin 

o Justify: Aligns text to both the left and right margins. 

 

Indent Paragraphs 

Indenting paragraphs allows you set text within a paragraph at different margins. 

There are several options for indenting: 

 First Line: Controls the left boundary for the first line of a paragraph 

 Hanging: Controls the left boundary of every line in a paragraph except 

the first one 

 Left: Controls the left boundary for every line in a paragraph 
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 Right: Controls the right boundary for every line in a paragraph To 

indent paragraphs, you can do the following: 

 Click the Indent buttons to control the indent. 

 Click the Indent button repeated times to increase the size of the 

indent. 
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 Click the dialog box of the Paragraph Group 

 Click the Indents and Spacing Tab and Select your indents 

 

Page Formatting: 

 

Modify Page Margins and Orientations 

The page margins can be modified through the following steps: 

o Click the Page Layout Tab on the Ribbon 

o On the Page Setup Group, Click Margins 

o Click a Default Margin, or 

o Click Custom Margins and complete the dialog box. 
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To change the Orientation, Size of the Page, or Columns: 

o Click the Page Layout Tab on the Ribbon 

o On the Page Setup Group, Click the Orientation, Size, or 

Columns drop down menus 

o Click the appropriate choice 

 

Apply a Page Border and Color 

To apply a page border or color: 

 Click the Page Layout Tab on the Ribbon 

 On the Page Background Group, click the Page Colors or Page Borders 

drop down menus 

 Select the appropriate one. 

 

 

Add Borders and Shading 

You can add borders and shading to paragraphs and entire pages. To create a 

border around a paragraph or paragraphs: 

 Select the area of text where you want the border or shading. 
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 Click the Borders Button on the Paragraph Group on the Home Tab 

 Choose the Border and Shading 

 Choose the appropriate options 

 

 

Applying Bullets and Numbering: Bulleted lists have bullet points, numbered lists 

have numbers, and outline lists combine numbers and letters depending on the 

organization of the list. To add a list to existing text: 

 

 Select the text you wish to make a list 

 From the Paragraph Group on the Home Tab, Click the Bulleted or 

Numbered Lists 

button 

 

 

To create a new list: 

 Place your cursor where you want the list in the document 

 Click the Bulleted or Numbered Lists button 

 Begin typing. BULLETED LIST: a).Adding Text to the List 

Add information to a list item but do not want to create a separate list item. Using 

this simple keystroke will place your insertion point on the next line without a 
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bullet appearing. 

 

1. Place the insertion point after the last character in the list item where 

you want to add text 

2. Press [Shift] + [Enter] 

The insertion point appears under the previous list item. 

 

3. Type the additional text 

 

b).Customizing Bulleted Lists 

 

Customizing your bulleted list allows you to use creative and eye-catching bullets. 

Word provides many different images from which to choose. The following 

instructions assume that a bulleted list has already been created. If you do not 

have a bulleted list, refer to Using Bulleted Lists. 

 

1. Select the bulleted list you want to customize. 

2. On the Home command tab, in the Paragraph group, click  on the BULLETS 

button   The Bullets pull-down menu appears 

http://www.uwec.edu/help/word07/lst-bull.htm
http://www.uwec.edu/help/word07/lst-bull.htm
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3. Select the desired bullet option 

4. If the desired option does not appear, select Define New Bullet... 

The Define New Bullet dialog box appears 

 

5. To select a symbol for your bullet, 

a. Under Bullet character, click SYMBOL... 

The Symbol dialog box appears. 
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b. From the Font pull-down box, select the desired font 

c. In the scroll box, select the desired bullet character 

d. click OK 

6. To select a picture for your bullet, 

a. Under Bullet character, click PICTURE... 

The Picture Bullet dialog box appears. 

b. In the scroll box, select the desired bullet character 

c. Click OK NUMBERED LIST: a)Adding Text to the List 

Perhaps you want to add information to a step but do not want to create a separate 

list item. Using this simple keystroke will place your insertion point on the next line 

without a number appearing. 

 

1. Place the insertion point after the last character in the step where you want 

to add text 

2. Press [Shift] + [Enter] 

Your insertion point appears under the previous list item. 

 

3. Type the additional text 

 

b) Customizing Numbered Lists 

 

Customizing your numbered list allows you to have a wider variety of styles for 

numbers. Word provides several different ways of customizing your numbers in 

order to create an effective numbered list. The following instructions assume that a 

numbered list has already been created. If you do not have a numbered list, refer to 

Using Numbered Lists. 

 

http://www.uwec.edu/help/word07/lst-num.htm
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1. Select the numbered list you want to customize 

 

2. On the Home command tab, in the Paragraph group, click on the 

NUMBERING button The Numbered List pull-down menu appears. 

 

3. Select the desired numbering option  

4. If the desired option does not appear, select Define New Number Format.

..

The Define New Number Format dialog box appears.
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5. To change the number style, from the Number style pull-down list, select the 

desired option 

6. To change the number format, in the Number format text box, make the 

desired changes EXAMPLE: Instead of following numerals with a period (1.), you 

may want to follow them with a dash (1-). 

7. To change the numbering alignment, from the Alignment pull-down list, select  

Left, Right or Centered  
 

Left-aligned Centered Right-aligned 
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8. To change font, style, color, or size of the numbers, 

a. Click FONT... 

The Font dialog box appears. 

b. Under  Font,  Font  style,   Font   color,   or   Size,   select   the   appropriate   

options   An example of your number formatting appears in the Preview section. 

c. Click OK 

Your customized number appears in the Number format text box. 

9. Click OK 

 

c) Changing the Starting Number 

 

1. Select the numbered list 

2. On the Home command tab, in the Paragraph group, click on the 

NUMBERING button The Numbered List pull-down menu appears. 

3. Select Set Numbering Value... 

The Set Numbering Value dialog box appears. 

 

 

4. In the Set value to scroll box, type or use the nudge buttons to select the 

number to start the numbered list 

5. Click OK. 
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UNIT III
S.NO QUESTIONS OPTION 1 OPTION 2 OPTION 3 OPTION 4 ANSWER

1  From which menu you can insert Header and Footer?   Insert Menu   View Menu   Format menu   Tools Menu   Insert Menu 
2  To get to the ‘Symbol’ dialog box, click on the ______ menu and choose ‘Symbol’.   Insert   Format   Tools   Table   Insert 
3  _______ option from clipboard is used to move data from one place to another in a document.   Copy & Paste   Cut & Paste   Bold   Justify   Cut & Paste 
4  ______ is an option in Font Group.  Strikethrough  Find  Replace   Change Styles  Strikethrough 
5  Name the button in the picture?   Font Color   Fill Color    Page Color   Highlighter tool   Highlighter tool 
6 Shortcut for document views toolbar is situated in ______ bar.   Task bar   Status bar    Tool bar  Title bar   Status bar 
7  Bullets and Numbering is in _____ ta   Home tab    Insert tab   Pagelayout tab   View tab   Home tab 
8  To open a existing document, click on the ________ and then select Open.   MS Office button    Quick Access Toolbar   Document Views   Ribbon   MS Office button 
9  Cut, Copy and Paste is in ________ Group in the Home ta   Font   Page Setup   Clipboard    Editing    Clipboard 

10  _______ is used to covert from upper case to lower case and vice vers   Toggle case  Sentence case   Lower case    Upper case   Toggle case 
11  Pressing F8 key for three times selects   A word   A sentence   A paragraph   Entire document   A sentence 
12  What is the shortcut key you can press to create a copyright symbol?   Alt+Ctrl+C   Alt + C   Ctrl + C   Ctrl + Shift + C   Alt+Ctrl+C 
13  What is the smallest and largest font size available in Font Size tool on formatting toolbar?   8 and 72   8 and 64   12 and 72   None of above   8 and 72 
14 Which of the following is graphics solution for Word Processors?   Clipart   WordArt   Drop Cap   All of above   Clipart 
15  The keystrokes Ctrl + I is used to   Increase font size   Inserts a line break   Indicate the text should be bold  Applies italic format to selected text  Applies italic format to selected text 
16  A character that is raised and smaller above the baseline is known as   Outlined   Raised   Superscript   Subscript   Superscript 
17  Thesaurus tool in MS Word is used for   Spelling suggestions   Grammar options   Synonyms and Antonyms words  All of above   Synonyms and Antonyms words 
18  Why Drop Caps are used in document?   To drop all the capital letters  To automatically begin each paragraph with capital letter  To begin a paragraph with a large dropped initial capital letter  None of above   To begin a paragraph with a large dropped initial capital letter 
19 A bookmark is an item or location in document that you identify as a name for future reference. Which of the following task is accomplished by using bookmarks?  To add anchors in web page  To mark the ending of a paragraph of document  To quickly jump to specific location in document  To add hyperlinks in webpage  To quickly jump to specific location in document 
20 Which of the following is not valid version of MS Office?   Office XP   Office Vista   Office 2007   None of above   Office Vista 
21 You cannot close MS Word application by   Choosing File menu then Exit submenu  Press Alt+F4   Click X button on title bar   From File menu choose Close submenu  From File menu choose Close submenu 
22 The key F12 opens a   Save As dialog box   Open dialog box   Save dialog box   Close dialog box   Save As dialog box 
23  What is the short cut key to open the Open dialog box?   F12   Shift F12   Alt + F12   Ctrl + F12   Ctrl + F12 
24 A feature of MS Word that saves the document automatically after certain interval is available on   Save tab on Options dialog box  Save As dialog box   Both of above   None of above   Save tab on Options dialog box 
25 Which of the following is not available on the Ruler of MS Word screen?   Tab stop box   Left Indent   Right Indent   Center Indent   Center Indent 
26 Which file starts MS Word?   Winworexe   Worexe   Msworexe   Word2003.exe   Winworexe 
27  If you want to keep track of different editions of a document which features will you use?   Editions   Versions   Track Change   All of above   Versions 
28 Background color or effects applied on a document is not visible in   Web layout view   Print Layout view   Reading View   Print Preview   Print Preview 
29  What is a portion of a document in which you set certain page formatting options?   Page   Document   Section   Page Setup   Section 
30  Which of the following is not a type of page margin?   Left   Right   Center   Top   Center 
31  What is the default left margin in Word 2003 document?   1"   1.25"   1.5"   2"   1.5" 
32 Portrait and Landscape are   Page Orientation   Paper Size   Page Layout   All of above   Page Orientation 
33 If you need to change the typeface of a document, which menu will you choose?   Edit   View   Format   Tools   Format 
34  Which of the following is not a font style?   Bold   Italics   Regular   Superscript   Superscript 
35  What happens when you click on Insert >> Picture >> Clip Art   It inserts a clipart picture into document  It lets you choose clipart to insert into document  It opens Clip Art taskbar   None of above   It opens Clip Art taskbar 
36 Which option is not available in Insert Table Autofit behavior?   Fixed Column Width   AutoFit to Contents   Autofit to Window   Autofit to Column   Autofit to Column 
37  To autofit the width of column   Double click the right border of column  Double click the left border of column  Double click the column header  All of above   Double click the right border of column 
38 Which of the following statement is false?   You can set different header footer for even and odd pages  You can set different page number formats for different sections  You can set different header footer for first page of a section  You can set different header and footer for last page of a section  You can set different header and footer for last page of a section 
39  Where can you change the vertical alignment?   Formatting toolbar   Paragraph dialog box   Page Setup dialog box   Standard toolbar   Page Setup dialog box 
40  AutoCorrect was originally designed to replace _________ words as you type.   Short, repetitive   Grammatically incorrect   Misspelled   None of the above   Misspelled 
41 In Word, the mailing list is known as the ____________.  Data sheet  Source  Data source  Sheet  Data source
42 Which of the following is not available on the Ruler of MS Word screen?  Tab stop box  Left Indent  Right Indent  Center Indent  Center Indent
43  What is place to the left of horizontal scroll bar?  Tab stop buttons  View buttons  Split buttons  Indicators  View buttons
44 Which file starts MS Word?  Winworexe  Worexe  Msworexe  Word2003.exe  Winworexe
45  How many ways you can save a document? 3 4 5 6 3
46  If you want to keep track of different editions of a document which features will you use?  Editions  Versions  Track Change  All of above  Versions
47 Background color or effects applied on a document is not visible in  Web layout view  Print Layout view  Reading View  Print Preview  Print Preview
48 What is a portion of a document in which you set certain page formatting options?  Page  Document  Section  Page Setup  Section
49 In which view the header and footer  are visible Normal view Page Layout View Print layout draft view Print layout
50 Which of the following is not a type of page margin?  Left  Right  Center  Top  Center
51  What is gutter margin?  Margin that is added to the left margin when printing Margin that is added to right margin when printing Margin that is added to the binding side of page when printing Margin that is added to the outside of the page when printing Margin that is added to the binding side of page when printing
52 Portrait and Landscape are  Page Orientation  Paper Size  Page Layout  All of above  Page Orientation
53  If you need to change the typeface of a document, which menu will you choose?  Edit  View  Format  Tools  Format
54 Which of the following is not a font style?  Bold  Italics  Regular  Superscript  Superscript
55 The process of removing unwanted part of an image is called Hiding Bordering Cropping Cutting Cropping
56 Text-Styling feature of MS word is  WordColor WordFont WordArt WordFill WordArt
57 To apply center allignment to a paragraph we can press Cntrl+S Cntrl+C+A Cntrl+E Cntrl+c Cntrl+E
58 Which items are placed at the end of a Document Footer Foot Note Header End note End note
59 Which feature starts a new line whenever a word or sentence reached a border Text Line New Line Text Wrapping Text Align Text Wrapping
60 Color and Pattern used to fill a closed shape is called  Fill style WordArt Fill Back Shape Fill style
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SUBJECT   : INTRODUCTION TO INFORMATION TECHNOLOGY 
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POSSIBLE QUESTIONS 

PART A(1 MARK) 

(Online Examinations) 

PART B (2 MARKS) 

1. List out the packages in MS Office. 

2. Write down the shortcut keys for CUT, COPY, and PASTE? 

3. Name some of the Font styles used in Word 

4. What is a Clip Art 

5. What is Mail-Merge? 

6. What is Thesaurus? 

7. What is word Art? 

8. How can you insert footer into your presentation? 

9. How can you apply automatic slide number into your presentation? 

10. What does Drag and Drop means 

 

PART C (6 MARKS) 

1. What is word processing? Explain the advantages of the word processing 

2. Explain the home menu in detail 

3. Explain the application of word processing 

4. Write a note on paragraph formatting 

5. Describe Toolbars in MS word in detail 
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6. Write down the steps for the following 

• creating a document 

• writing 

• Underline ,Bold, Italics 

• copying and moving a text 

7. Explain the features of word processing 

8. Explain office button in detail 

9. Explain Mailing using Word in Detail 

10. Explain insert option in detail 

 



 

Ms-Excel 2017-2020 Batch 

  

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   1/46 
  

KARPAGAM ACADEMY OF HIGHER EDUCATION 
(Deemed University Established Under Section 3 of UGC Act 1956) 

Coimbatore - 641021. 
(For the candidates admitted from 2016 onwards) 

DEPARTMENT OF COMMERCE (CA) 

 
SUBJECT   : INTRODUCTION TO INFORMATION TECHNOLOGY 
SEMESTER   : I                                   
SUBJECT CODE: 17CCU102                                          CLASS         :    I B.COM CA 

 

 

Unit IV 

Ms Excel: Meaning – Features of MS Excel – Insertion and Deletion of Worksheet – Entering and editing data in 

worksheet – Cell range – Formatting – Auto Fill – Formulas and its disadvantages. 

MS Power Point: Meaning – Slides – Creation of Slides – Slide Sorter, Slide Show, Slide Number, Slide Design, 

Slide Layout, Slide Show – View Show Set up Show, Custom Animation, Slide Transition.  

 

 W6:http://www.networkingabasics.net 
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UNIT-IV 

MS EXCEL: 

Microsoft Excel is a spreadsheet program included in the Microsoft Office suite 

of applications. Spreadsheets present tables of values arranged in rows and 

columns that can be manipulated mathematically using both basic and 

complex arithmetic operations and functions. 

 

In addition to its standard spreadsheet features, Excel also offers 

programming support via Microsoft's Visual Basic for Applications (VBA), the 

ability to access data from external sources via Microsoft’s Dynamic Data 

Exchange (DDE), and extensive graphing and charting capabilities. 

 

Microsoft Excel Release History: Microsoft Excel was first released for 

Macintosh systems in 1985, followed by the first Windows version in 1987. The 

following is a list of Excel releases for Windows: 

 

Excel 

2.0 

(1987

) 

 

Excel 

3.0 

(1990

) 

Excel 

4.0 

(1992

) 

- Included in Microsoft 

Office 3.0 

Excel 

5.0 

(1993

) 

- Included in Microsoft 

Office 4.0 

Excel 

95 

(1995

) 

- Included in Microsoft 

Office 95 
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Excel 

97 

(1997

) 

- Included in Microsoft 

Office 97 

Excel 2000 (2000) - Included in Microsoft 

Office 2000 Excel 2002 (2002) - Included in 

Microsoft Office XP Excel 2003 (2003) - 

Included in Microsoft Office 2003 

Excel 2007 (2007) - Included in Microsoft Office 2007 

Excel 2010 (2010) - Included in Microsoft Office 2010 

Excel 2013 (2013) - Included in Microsoft Office 2013 

 

FEATURES OF Ms EXCEL: 

1. Excel Formulas. 

2. VBA, Macros & automation 

3. Pivot tables 

4. Look up formulas 

5. Excel Charts. 

6. Sorting, and filtering data. 

7. Conditional Formatting 

8. Drop down validation & form controls 

9. PowerPivot, Data Explorer & Data Analysis features 
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Insertion and deletion of worksheet: 

workbook, but you can add more worksheets (and other types of sheets, such 

as a chart sheet, macro sheet, or dialog sheet), rename them, or delete them 

as needed. 

 

The name (or title) of a worksheet appears on its shee

of the screen. By default, the name is Sheet1, Sheet2, and so on, but you 

can give any worksheet a more appropriate name.

 

To insert a new worksheet, do one of the following:

 

� Click the New sheet 

 

 

� To insert a new worksheet in front of an existing worksheet, select the 

existing worksheet and then, click 

Ms-Excel 

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE 

Insertion and deletion of worksheet: Excel gives you three worksheets in a 

workbook, but you can add more worksheets (and other types of sheets, such 

as a chart sheet, macro sheet, or dialog sheet), rename them, or delete them 

The name (or title) of a worksheet appears on its sheet tab at the bottom 

of the screen. By default, the name is Sheet1, Sheet2, and so on, but you 

can give any worksheet a more appropriate name. 

To insert a new worksheet, do one of the following: 

New sheet button at the bottom of the screen. 

To insert a new worksheet in front of an existing worksheet, select the 

existing worksheet and then, click Home > Insert > Insert

 2017-2020 Batch 
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Excel gives you three worksheets in a 

workbook, but you can add more worksheets (and other types of sheets, such 

as a chart sheet, macro sheet, or dialog sheet), rename them, or delete them 

t tab at the bottom 

of the screen. By default, the name is Sheet1, Sheet2, and so on, but you 

 

To insert a new worksheet in front of an existing worksheet, select the 

Insert Sheet. 
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To change the order of the worksheets in a workbook, click the tab of the 

worksheet that you want to move, and then drag it to the location that we 

want. 

 

Rename of a worksheet: 

 

1. On the Sheet tab bar, right-click the sheet tab that you want to rename, 

and then click 

Rename. 

 

 

2. Select the current name, and then type the new name. 

 

Delete one or more worksheets: 

 

1. Select the worksheet or worksheets that you want to delete. 

2. Click Home, click the arrow below Delete, and then click Delete Sheet. 
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We can also right-click the sheet tab of a worksheet or a sheet tab of any 

selected worksheets that we want to delete, and then click Delete Sheet. 

 

Entering and Editing data in a worksheet: 

 

To enter a data in worksheet: 

 

1. Click a cell, and then type data in that cell. 

2. Press ENTER or TAB to move to the next cell 

Cell data - Things that can be entered into a cell: 

 

 numbers 

 words 

 equations, formulas or functions 

 fill color 

 images (although they are actually on top of a cell, not in it) 

 

Adjust settings: 
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1. To wrap text in a cell, select the cells that you want to format, and then 

on the Home tab, in the Alignment group, click Wrap Text. 

 

 

2. To adjust column width and row height to automatically fit the 

contents of a cell, select the columns or rows that you want to change, 

and then on the Home tab, in the Cells group, click Format. 

 

 

Under Cell Size, click AutoFit Column Width or AutoFit Row Height. 

Format the data : 

 

1. To apply number formatting, click the cell that contains the numbers 

that you want to format, and then on the Home tab, in the Number 

group, click the arrow next to General, and then click the format that 

you want. 
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2. To change the font, select the cells that contain the data that you want to 

format, and then on the Home tab, in the Font group, click the format 

that you want. 

 

Review cursor styles - There are four common cursor styles used in Excel. 

Become familiar with each style. 

 

 

 

Click and drag to 

highlight multiple 

cells with this 

cursor, or click in a 

cell to select the 

single cell 

  

 

 

Click and drag with 

this cursor to fill 

cell contents into 

cells below or to 

the right. 

     

 

 

Click and drag the 

contents of the 

selected cell to any 

other cell. 

  

 

Click to place the 

cursor into the 

Formula bar so that 

you can edit an 

equation or 

function. 
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CELL RANGE IN MS EXCEL: 

A range is a group or block of cells in a worksheet that has been selected or 

highlighted. When cells have been selected they are surrounded by an outline 

or border as shown in the image to the left. 

 

A range can also be a group or block of cell references that can be, for example, 

 

 entered as an argument for a function; 

 used to create a graph; 

 used to create bookmarks to specific data in a workbook. 

 

By default, this outline or border surrounds only one cell in a worksheet 

at a time, which is known as the active cell. 

 

Changes to a worksheet - such as data editing or formatting, by default, 

affect the active cell. When a range of more than one cell is selected, 

changes to the worksheet - with certain exceptions such as data entry and 

editing - affect all cells in the selected range. 

 

Contiguous and Non-contiguous Ranges 

 

A contiguous range of cells is a group of highlighted cells that are adjacent to 

each other - such as the range C1 to C5 shown in the image above. 

 

A non-contiguous range consist of two or more separate blocks of cells. 

These blocks can be separated by rows or columns as shown by the ranges 

A1 to A5 and C1 to C5. 
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Both contiguous and non-contiguous ranges can include hundreds or even 

thousands of cells and span worksheets and workbooks. 

 

Naming a Range: Ranges are so important in Excel and Google Spreadsheets 

that names can be given to specific ranges to make them easier to work with 

and reuse when referencing them in such things as charts and formulas. 

Selecting a Range in a Worksheet: There a number of ways to select a 

range in a worksheet. These include using: 

 

 the mouse; 

 the keyboard; 

 the Name Box in Excel; 

 or a combination of the three. 

 

A range consisting of adjacent cells can be created by dragging with the 

mouse or by using a combination of the Shift and four Arrow keys on the 

keyboard.Ranges consisting of non- adjacent cells can be created by using 

the mouse and keyboard or just the keyboard. 

 

Selecting a Range for Use in a Formula or Chart: 

 

When entering a range of cell references as an argument for a function or 

when creating a chart, in addition to typing in the range manually, the range 

can also be selected using pointing. 

 

Ranges are identified by the cell references or addresses of the cells in the 
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upper left and lower right corners of the range. These two references are 

separated by a colon ( : ) which tells Excel to include all the cells between 

these start and end points. 

 

AUTO –FILL IN MS EXCEL: 

Instead of entering data manually on a worksheet, you can use the Auto Fill 

feature to fill cells with data that follows a pattern or that is based on data in 

other cells. 

Automatically repeat values that already exist in the column: 

 

If the first few characters that you type in a cell match an existing entry in 

that column, Excel automatically enters the remaining characters for you. 

Excel automatically completes only those entries that contain text or a 

combination of text and numbers. Entries that contain only numbers, dates, 

or times are not automatically completed. 

 

After Excel completes what you started typing, do one of the following: 

 

 To accept a proposed entry, press Enter. 

 

The completed entry exactly matches the pattern of uppercase and 

lowercase letters of the existing entry. 

 

 To replace the automatically entered characters, continue typing. 

 To delete the automatically entered characters, press Backspace. 

 Excel completes an entry only when the cursor is at the end of the current 

cell contents. 
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 Excel bases the list of potential AutoComplete entries on the column 

that contains the active cell. Entries that are repeated within a row 

are not automatically completed. 

 

Turn automatic completion of cell values on or off: 

 

If you don't want Excel to automatically complete cell values, you can turn off 

this feature. 

 

1. Click the File tab, and then click Options. 

2. Click Advanced, and then under Editing options, select or clear the 

Enable AutoComplete for cell values check box to turn automatic 

completion of cell values on or off. 

 

Fill data into adjacent cells by using the fill handle: 

 

To quickly fill in several types of data series, you can select cells and drag the 

fill handle . To use the fill handle, you select the cells that you want to use 

as a basis for filling additional cells, and then drag the fill handle across or 

down the cells that you want to fill. 

 

By default, the fill handle is displayed, but you can hide it, or show it if it's 

hidden. 

 

After you drag the fill handle, the Auto Fill Options button is displayed. If you 

don't want to display the Auto Fill Options button every time that you drag the 

fill handle, you can turn it off. Likewise, if the Auto Fill Options button does 
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not appear when you drag the fill handle, you might want to turn it on. 

Show or hide the fill handle: 

 

1. Click the File tab, and then click Options. 

2. Click Advanced, and then under Editing options, select or clear the 

Enable fill handle and cell drag-and-drop check box to show or hide 

the fill handle. 

3. To avoid replacing existing data when you drag the fill handle, make 

sure that the Alert before overwriting cells check box is selected. If 

you don't want to see a message about overwriting nonblank cells, you 

can clear this check box. 

 

Drag the fill handle to fill data into adjacent cells: 

 

1. Select the cells that contain the data that you want to fill into adjacent 

cells. 

2. Drag the fill handle across the cells that you want to fill. 

3. To change how you want to fill the selection, click Auto Fill 

Options , and then click the option that you want. 

 

For example, you can choose to fill just cell formats by clicking Fill 

Formatting Only, or you can choose to fill just the contents of a cell by 

clicking Fill Without Formatting. 

 

Turn Auto Fill Options on or off: 

 

1. Click the File tab, and then click Options. 
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2. Click Advanced, and then under Cut, copy, and paste, select or clear 

the Show Paste Options button when content is pasted check box 

to turn this option on or off. 

 

Fill data into adjacent cells by using the Fill command: 

 

You can use the Fill command to fill the active cell or a selected range with 

the contents of an adjacent cell or range. 

1. Do one of the following: 

o To fill the active cell with the contents of an adjacent cell, select 

an empty cell that is below, to the right, above, or to the left of 

the cell that contains the data that you want to use to fill the 

empty cell. 

o To fill multiple adjacent cells, select the cell with the contents 

you want to fill and the adjacent cells into which you want to 

fill the content. 

2. On the Home tab, in the Editing group, click Fill, and then click Down, 

Right, Up, or 

Left. 

 

 

Keyboard shortcut To quickly fill a cell with the contents of an 

adjacent cell, you can press Ctrl+D to fill from the cell above or Ctrl+R to fill 

from the cell to the left. 
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Fill formulas into adjacent cells: 
 

1. Select the cell that contains the formula that you want to fill into adjacent 

cells. 

2. Drag the fill handle across the cells that you want to fill. 

3. To choose how you want to fill the selection, click Auto Fill Options , 

and then click the option that you want 

4. Click the File tab. 

5. Under Excel, click Options, and then click the Formulas category. 

6. Under Calculation options, look under Workbook Calculation. 

 

 Automatic Formulas automatically recalculate. 

 Automatic except for data tables Formulas recalculate, 

unless the formula is in a data table. 

 Manual Formulas never recalculate automatically. 

 Recalculate workbook before saving This option is available only 

if Workbook Calculation is set to Manual. If this check box is 

selected, formulas do not automatically recalculate until you save 

the workbook. Note that several other actions can cause the 

workbook to be saved, such as using the Send To command. 

 

Fill in a series of numbers, dates, or other built-in series items: 

 

You can quickly fill cells in a range with a series of numbers or dates, or 

with a built-in series for days, weekdays, months, or years by using the fill 

handle or the Fill command. 
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Fill cells with a series by using the fill handle: 

 

1. Select the first cell in the range that you want to fill. 

2. Type the starting value for the series. 

3. Type a value in the next cell to establish a pattern. 

 

For example, if you want the series 1, 2, 3, 4, 5..., type 1 and 2 in the first 

two cells. If 

you want the series 2, 4, 6, 8..., type 2 and 4. If you want the series 2, 

2, 2, 2..., you can leave the second cell blank. 

 

4. Select the cell or cells that contain the starting values. 

5. Drag the fill handle across the range that you want to fill. 

6. You can also specify the type of series by using the right mouse button 

to drag the fill handle over the range and then clicking the appropriate 

command on the shortcut menu. For example, if the starting value is 

the date JAN-2007, click Fill Months for the series FEB-2007, MAR-

2007, and so on; or click Fill Years for the series JAN-2007, JAN- 

2008, and so on. 

7. If the selection contains numbers, you can control the type of series 

that you want to create. 

8. You can suppress series AutoFill by holding down Ctrl as you drag the 

fill handle of a selection of two or more cells. The selected values are 

then copied to the adjacent cells, and Excel does not extend a series. 

 

Fill cells with a series by using the Fill 

command: 
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1. Select the first cell in the range that you want to fill. 

2. Type the starting value for the series. 

3. On the Home tab, in the Editing group, click Fill, and then click Series. 

 

 

4. Under Type, click one of the following options: 

o Linear Creates a series that is calculated by adding the value in the 

Step value 

box to each cell value in turn. 

o Growth Creates a series that is calculated by multiplying the 

value in the Step value box by each cell value in turn. 

o Date Creates a series that fills date values incrementally by the 

value in the 

Step value box and is dependent on the unit specified under Date 

unit. 

o AutoFill Creates a series that produces the same results as 

dragging the fill handle. 

5. To establish a pattern for the series, in the Step value and Stop 

value boxes, type the values you want 

Fill data by using a custom fill series: 

 

To make entering a particular sequence of data (such as a list of names or 
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sales regions) easier, you can create a custom fill series. A custom fill series 

can be based on a list of existing items on a worksheet, or you can type the 

list from scratch. You cannot edit or delete a built-in fill series (such as a fill 

series for months and days), but you can edit or delete a custom fill series. 

 

Note: A custom list can only contain text or text mixed with numbers. 

 

Use a custom fill series based on an existing list of items: 

 

1. On the worksheet, select the list of items that you want to use in the fill 

series. 

2. Click the File tab, and then click Options. 

3. Click Advanced, and then under General, click the Edit Custom Lists 

button. 

4. Verify that the cell reference of the list of items that you selected is 

displayed in the 

Import list from cells box, and then click Import. 

 

The items in the list that you selected are added to the Custom lists box. 

 

5. Click OK twice. 

6. On the worksheet, click a cell, and then type the item in the custom 

fill series that you want to use to start the list. 

7. Drag the fill handle across the cells that you want to fill. 

Use a custom fill series based on a new list of items: 

 

1. Click the File tab, and then click Options. 
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2. Click Advanced, and then under General, click Edit Custom Lists. 

3. In the Custom lists box, click NEW LIST, and then type the entries in the 

List entries 

box, starting with the first entry. 

4. Press Enter after each entry. 

5. When the list is complete, click Add, and then click OK twice. 

6. On the worksheet, click a cell, and then type the item in the custom 

fill series that you want to use to start the list. 

7. Drag the fill handle across the cells that you want to fill. 

Edit or delete a custom fill series: 

 

1. Click the File tab, and then click Options. 

2. Click Advanced category, and then under General, click Edit Custom 

Lists. 

3. In the Custom lists box, select the list that you want to edit or delete, 

and then do one of the following: 

o To edit the fill series, make the changes that you want in the 

List entries box, and then click Add. 

o To delete the fill series, click Delete. 

 

Formulas in Ms Excel: 

A formula is an expression which calculates the value of a cell. 

Functions are predefined formulas and are already available in Excel. 

 

For example, cell A3 below contains a formula which adds the value of cell 

A2 to the value of cell A1. 
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For example, cell A3 below contains the SUM function which calculates the 

sum of the range A1:A2. 

 

 

Enter a Formula: 

To enter a formula, execute the following steps. 

1. Select a cell. 

2. To let Excel know that you want to enter a formula, type an equal sign (=). 

3. For example, type the formula A1+A2. 

 

 



 

Ms-Excel 2017-2020 Batch 

  

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   21/46 
  

 

 

Tip: instead of typing A1 and A2, simply select cell A1 and cell A2. 

 

4. Change the value of cell A1 to 3. 

 

 

Excel automatically recalculates the value of cell A3. This is one of Excel's 

most powerful features! 

 

Edit a Formula: 

 

When you select a cell, Excel shows the value or formula of the cell in the 

formula bar. 
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1. To edit a formula, click in the formula bar and change the formula. 

 

 

 

2. Press Enter. 

 

 

MS POWERPOINT: 

Microsoft PowerPoint is a powerful presentation software developed by 

Microsoft. It is a standard component of the company's Microsoft Office suite 
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software, and is bundled together with Word, Excel and other office 

productivity tools. The program uses slides to convey information rich in 

multimedia. The term slide refers to the old slide projector, which this 

software effectively replaces. 

 

PowerPoint was first developed by Dennis Austin and Thomas Rudkin at 

Forethought Inc. It was supposed to be named Presenter, but the name was 

not adapted due to trademark issues. It was renamed as PowerPoint in 1987 

as suggested by Robert Gaskins. In August of 1987, Microsoft bought 

Forethought for $14 million and turned it into its graphics business unit, 

where the company continued to develop the software. The first iteration was 

launched together with Windows 3.0 in 1990. It only allowed slide progression 

in one direction - forward - and the amount of customization was fairly 

limited. 

 

PowerPoint experienced a very significant change in PowerPoint 97, which 

added predefined transition effects and allowed the user to time them 

appropriately so that slides would transition automatically. This allowed a 

presenter to follow a predefined progression and go on with the presentation 

without pausing to change or read the slides. 

 

CREATION OF SLIDE 

 

Step 1: Launch the PowerPoint Program. When you launch the PowerPoint 

program, you may be prompted to pick what kind of document you want to 

create. Choose to create a blank presentation. If it does not ask you this, a 

blank presentation will automatically launch 
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Step 2: Choosing a Design, go to the 'Design' tab at the top of the page. Scroll 

through all the options and decide which one looks best for the presentation 

you want. To get a preview of what the design will look like before applying it 

to the presentation, hover over the design you want to preview. This design 

will be automatically continued throughout the rest of your presentation. 

Once you have more than one slide, you can add a different design for just 

one slide. To do this, select the slide you want to change the design on by 

clicking on it. It will pop- up as the big slide in the screen. Then you can 

right-click the design you want for this slide and select 'Apply to Selected 

Slide'. 
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Step 3: Create Title Page 
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Step 4: Add More Slides 

 

 

 

Slide Sorter View 

Slide Sorter view in PowerPoint lets you view and sort the presentation 

slides. To switch       to Slide Sorter view, click the “Slide Sorter” button in the 

“Presentation Views” button group  in the Status Bar. Alternatively, click the 
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“Slide Sorter” button in the “Presentation Views” button group on the “View” 

tab of the Ribbon. We use Slide Sorter view to reorganize, insert, delete and 

copy the presentation slides. Slide Sorter view in PowerPoint also shows the 

presentation’s visual flow. We can also add and preview slide transition 

animation here, as well. 

 

In Slide Sorter view in PowerPoint, you can see all of the slides in your 

presentation laid out as thumbnail pictures. We cannot modify the content of 

the individual slides shown. In  Slide Sorter view in PowerPoint, We can click a 

slide to select it. If you double-click that slide or press “Enter” on your 

keyboard, We open the selected slide in Normal View. We can then modify its 

content in Normal View. To delete slides in Slide Sorter view, click them once 

to highlight them. Then press the “Delete” key on your keyboard. 

 

1. To switch to Slide Sorter view, click the “Slide Sorter” button in the 

“Presentation Views” button group within the Status Bar. 

2. Alternatively, click the “Slide Sorter” button in the “Presentation Views” 

button group on the “View” tab of the Ribbon. 

3. To change the order of presentation slides in Slide Sorter view, click 

and drag the pictures of the slides. 

4. Then release the slide when it is in the desired position. 

5. To select a slide in Slide Sorter view, click a slide. 

6. To open a selected slide in Normal View to edit it, double-click the 

slide. 

7. Alternatively, press the “Enter” key on your keyboard. 

8. To delete a slide in Slide Sorter view, click it once to select it. 
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9. Then press the “Delete” key on

 

 

 

 

Add slide numbers, page numbers, or the date and time:

Add slide numbers or notes page numbers

 

1. On the View tab, in the 

2. On the left of your screen, in the pane that contains the slide 

thumbnails, click the first slide thumbnail in your

Ms-Excel 

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE 

Then press the “Delete” key on your keyboard. 

Add slide numbers, page numbers, or the date and time: 

Add slide numbers or notes page numbers 

tab, in the Presentation Views group, click

On the left of your screen, in the pane that contains the slide 

click the first slide thumbnail in your presentation.
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group, click Normal. 

On the left of your screen, in the pane that contains the slide 

presentation. 
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3. On the Insert tab, in the Text group, click Header & Footer. 

 

 

4. In the Header and Footer dialog box, do one of the following: 

o If you want to add slide numbers, click the Slide tab, and then 

select the Slide number check box. 

 

o If you want to add page numbers to notes or handouts, click 

the Notes and Handouts tab, and then select the Page 

number check box. 

 

 

5. If you want to add page numbers to all of the slides, notes pages, or 

handouts in your presentation, click Apply to All. 
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Change the starting slide number 

 

You can change the starting slide number, number only one slide, or omit the 

slide number from the first slide. Here's how. 

 

1. On the Design tab, in the Customize group, click Slide Size > Custom 

Slide Size. 

2. In the Slide Size box, in the Number Slides from drop-down list, select a 

starting number. 

 

Number only one slide or number all slides but the first slide 

 

1. On the Insert tab, in the Text group, click Header & Footer. 

 

 

2. In the Header and Footer dialog box, click the Slide tab. 

3.  
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4. Do one of the following: 

o To number the slide that you have selected, select the Slide 

number check box, and then click Apply. Repeat this step for 

each individual slide that you want to number. 

o To number all slides but the first slide, select the Slide number 

check box, select 

Don’t show on title slide, and then click Apply to All. 

 

Add the date and time 

 

1. On the View tab, in the Presentation Views group, click Normal. 

2. On the left of your screen, in the pane that contains the slide 

thumbnails, click the first slide thumbnail in your presentation. 

3. On the Insert tab, in the Text group, click Date & Time. 

4. In the Header and Footer box, do one of the following: 

o If you want to add the date and time to your slides, click the Slide 

tab. 

o If you want to add the date and time to your notes pages or 

handouts, click the 

Notes and Handouts tab. 

5. Select the Date and time check box, and then do one of the following: 

o If you want the date and time to reflect the current date and 

time each time you open or print the presentation, click Update 

automatically, and then select the date and time format that 

you want . 

o If you want to set the date and time to a specific date, click 

Fixed, and then in the Fixed box, type in the date that you 

want.By setting the date on your presentation so that it is 
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Fixed, you can easily keep track of the last time you made 

changes to it. 

6. If you want to add the date and time to all of the slides, notes pages, or 

handouts in your presentation, click Apply to All. 

 

Apply or change a slide layout 

Slide layouts contain formatting, positioning, and placeholders for all of 

the content that appears on a slide. Placeholders are the containers in 

layouts that hold such content as text (including body text, bulleted lists, 

and titles), tables, charts, SmartArt graphics, movies, sounds, pictures, 

and clip art. Slide layouts also contain the theme (colors, fonts, effects, 

and the background) of a slide. 

 

 

Apply or change a slide layout: 

 On the View tab, click Normal. 

 

 In Normal View, in the thumbnail pane on the left, click the slide that 

you want to apply a layout to. 
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 On the Home tab, click Layout, and then select the layout that you want. 

 

Change a slide layout in Slide Master View 

If you are unable to find a slide layout that works with the text and other 

objects that you plan to put on your slides, change a layout in Slide Master 

View. 

 

1. On the View tab, click Slide Master. 

 

2. In Slide Master View, in the thumbnail pane on the left, click a slide 

layout that you want to change. 
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On the Slide Master tab, to change the layout, do one or more of the following: 

 

 To add a placeholder, click Insert Placeholder, and then pick a 

type of placeholder from the list. 

 To rearrange a placeholder, click the edge of the placeholder until you 

see a four-headed arrow, and the drag the placeholder to the new 

location on the slide. 

 To delete a placeholder, select the placeholder, and then press Delete on 

your keyboard. 

 To add a new layout, click Insert Layout. 

 To rename a layout, in the thumbnail pane on the left, right-click the 

layout that you want to rename, click Rename Layout, type the new 

name of the layout and then click Rename. 

 

Change the orientation of your slides 

You can change the orientation of all your slides to standard, widescreen, or 
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a custom size, and you can specify either portrait or landscape orientation for 

both slides and notes. 

 

 On the Design tab, click Slide Size and select an option 

 

 

 To change the orientation, click Custom Slide Size, and then select 

the orientation you want under Orientation. 

 

 

 To create a custom slide size, click Custom Slide Size, and then 

select screen, width, and height options on the left side of the Slide 

Size dialog box. 

 

Set Up Slide Show: 
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Show type: Use the options in the Show type section to specify how you 

want to show your presentation to your audience. 

 

 To deliver your presentation before a live audience, click Presented by 

a speaker (full screen). 

 To enable your audience to view your presentation from a hard 

drive or CD on a computer, or on the Internet, click Browsed by 

an individual (window). 

 

To allow your audience to scroll through your self-running 

presentation from an unattended computer, select the Show 

scrollbar check box. 

 

Show slides : Use the options in the Show slides section to specify which 

slides are available in a presentation or to create a custom show. 

 To show all slides in your presentation, click All. 

 To show a specific group of slides from your presentation, enter the 

first slide number that you want to show in the From box, and enter 

the last slide number that you want to show in the To box. 

 To start a custom slide presentation that derives from another 

PowerPoint presentation, click Custom show, and then click the 

presentation that you want to view as a custom show. 

 

Show options : Use the options in the Show options section to specify 

how you want sound files, narrations, or animations to run in your 

presentation. 
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 To play a sound file or animation continuously, select the Loop 

continuously until 'Esc' check box. 

 To show a presentation without playing an embedded narration, 

select the Show without narration check box. 

 To show a presentation without playing an embedded animation, 

select the Show without animation check box. 

 By default, PowerPoint speeds up the drawing of graphics in your 

presentation. But sometimes this feature causes display problems 

on older computers. To turn off this feature, choose Disable 

hardware graphics acceleration. 

 When you deliver your presentation before a live audience, you can 

write on your slides. To specify an ink color, in the Pen color list, select 

an ink color. 

 

The Pen color list is available only if Presented by a speaker (full 

screen) (in the 

Show type section) is selected. 

 

 Choose a Laser pointer color from the drop-down list. While 

presenting, you Press and hold the Ctrl key, and then click and drag the 

left mouse button to point to the contents on the slide that you want to 

draw attention to with the pointer. 

 

Advance slides : Use the options in the Advance slides section to specify 

how to move from one slide to another. 

 

 To advance to each slide manually during your presentation, click 

Manually. 
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 To use slide timings to advance to each slide automatically during 

your presentation, click Using timings, if present. 

 

CUSTOM ANIMATION: 

We can animate the text, pictures, shapes, tables, SmartArt graphics, and 

other objects in our PowerPoint presentation to give them visual effects, 

including entrances, exits, changes in size or color, and even movement. 

Build a slide presentation that animates bullet points or even production 

credits. 

 

Animation is a great way to emphasize a point, control information flow, and 

increase viewer interest. You can apply animation effects on individual slides, 

the slide master, or custom slide layouts. 

 

Add animation to an object 

 

1. Select the object that you want to animate. 

 

An "object" in this context is any thing on a slide, such as a picture, a 

chart, or a text box. Sizing handles appear around an object when you 

select it on the slide 

 

On the Animations tab of the ribbon, in the Animation group, click the 

More button, and then select the animation effect that you want. 
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o If you do not see the entrance, exit, emphasis, or motion path 

animation affect that you want, click More Entrance Effects, 

More Emphasis Effects, More Exit Effects, or More Motion 

Paths. 

o Some entrance and exit effects (such as Flip, Drop, and Whip) 

and some emphasis effects (such as Brush Color and Wave) are 

available only for objects that contain text. If you want to apply 

an animation effect that isn’t available for this reason, try adding 

a space inside your object. 

o After you have applied an animation to an object or text, the 

animated items are labeled on the slide with a non-printing 

numbered tag, displayed near the text or object. The tag appears 

only in Normal view when the Animations tab is selected or the 

Animation task pane is visible. 

 

Change the speed of the animation effect: The speed of the effect is 

determined by the Duration setting. 

 

1. On the slide, select the animation effect that you want to change. 
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2. On the Animations tab, under Timing options, in the Duration box, 

enter the number seconds that you want the animation effect to last. 

 

 

(Maximum: 59 seconds. Minimum: .01 seconds. You can type a 

duration or use the up or down arrows to select a standard 

incremental value.) 

 

Set the effect options, timing, or order for an animation 

 

 To set the effect options for an animation, on the Animations tab, in the 

Animation 

group, click the arrow to the right of Effect Options and click the option 

that you want. 

 You can specify the start, duration, or delay timing for an animation on 

the Animations 

tab. 

o To set the start timing for an animation, in the Timing group, 

click the arrow to the right of the Start menu and select the 

timing that you want. 

o To set the duration of how long the animation will run, in the 
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Timing group, enter the number of seconds that you want in 

the Duration box. 

o To set a delay before the animation begins, in the Timing 

group, enter the number of seconds that you want in the 

Delay box. 

 To reorder an animation in the list, in theAnimation task pane, 

select the animation that you want to reorder, and on the 

Animations tab, in the Timing group, under Reorder Animation, 

either select Move Earlier to make the animation occur before 

another animation in the list or select Move Later to make the 

animation occur after another animation in the list. 

 

Test your animation effect: 

 

After you add one or more animation effects, to validate that they work, do the 

following: 

 

 On the Animations tab, in the Preview group, click Preview. 

 

 

More about animating text and object 

There are four different types of animation effects: 

 

 Entrance effects make an object fade gradually into focus, fly onto 
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the slide from an edge, or bounce into view. 

 Exit effects include making an object fly off of the slide, disappear from 

view, or spiral off of the slide. 

 Emphasis effects include making an object shrink or grow in size, 

change color, or spin on its center. 

 You can use Motion Paths to make an object move up or down, left or 

right, or in a star or circular pattern (among other effects). You also can 

draw your own motion path. 

 

You can use any animation by itself, or combine multiple effects. For instance, 

to make a line of text fly in while it grows, apply a Fly In entrance effect and a 

Grow/Shrink emphasis effect to it. Click Add Animation to add effects, and 

use the Animation Pane to set the emphasis effect to occur With Previous. 

 

The gallery of animation effects on the Animations tab shows only the 

most popular effects. Get even more possibilities by clicking Add 

Animation, scrolling down, and clicking More Entrance Effects, More 

Emphasis Effects, More Exit Effects, or More Motion Paths. 

 

 

Applying transitions: Transition effects—or transitions as they are often 

called—are the movements you see when one slide changes to another in 

Slide Show view. Transition effects are different from animation effects. The 
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term animation in PowerPoint refers to the movements of text and objects on 

the slide, while transitions refer to the movement of the slide as it changes to 

another slide. 

To apply a transition to one slide: 

 Select the slide you want to modify. 

 Select the Animations tab. 

 Locate the Transition to This Slide group. By default, No Transition is applied 

to each slide

 

 

 Click the More drop-down arrow to display all available transition effects. 

 

 

 Click a slide transition effect to apply it to the selected slide. 
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Hover over a slide transition effect to see a live preview of the effect on the slide. 

 

To apply a slide transition to all slides: 

 

 Select the slide you want to modify. 

 Select the Animations tab. 

 Locate the Transition to This Slide group. By default, No Transition is 

applied to each slide. 

 Click the More drop-down arrow to display all transition effects. 

 Click a slide transition effect to apply it to the selected slide. 

 Click Apply To All to apply the transition to all slides in the presentation. 

 

Modifying transitions 

 

To set slide transition speed: 

 

 Apply a slide transition effect to a slide. 

 Click the Transition Speed drop-down menu in the Transition to 

This Slide group on the Animations tab. 

 Select a menu option to apply the transition speed to the selected slide. 
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You can set the transition speed when you apply the transition effect, or you 

can return to the Animations tab and apply it later. If you want to apply the 

transition effect and transition speed to all slides, Click Apply to All. 

 

To set slide transition sound: 

 

 Apply a slide transition effect to a slide. 

 Click the Transition Sound drop-down menu in the Transition to 

This Slide group on the Animations tab. 

 Select a sound to apply it to the selected slide. 

 

Click Apply To All if you want to apply the transition effect and transition 

sound to all slides. 

 

To remove a slide transition effect: 

 

 Select the slide you want to modify. 

 Select the Animations tab. 

 Click No Transition in the Transition to This Slide group. 
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 Repeat this process for each slide you want to modify. OR 

 

 Click Apply To All to remove the slide transition effect 

from each slide in the presentation. 
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UNIT IV
S.NO QUESTIONS OPTION 1 OPTION 2 OPTION 3 OPTION 4 ANSWER

1 The Software which contains rows and columns is called ______ Database  Drawing  Spreadsheet  Word processing  Spreadsheet
2  What is the short cut key to replace a data with another in sheet?  Ctrl + R  Ctrl + Shift + R Ctrl + H  Ctrl + F Ctrl + H
3 The key F12 opens a Save As dialog box Open dialog box Save dialog box Close dialog box Save As dialog box
4 Which of the following is not a valid Zoom percentage in Excel? 10 100 300 500 500
5 The spelling tool is placed on ______ toolbar Standard  Formatting  Drawing  Reviewing Standard
6 You can automatically adjust the size of text in a cell if they do not fit in width by  Double clicking on the right border of column header  From Format choose Columns and then Autofit Selection  From Format Cells dialog box mark Shrink to fit check box  Decimal Places  From Format Cells dialog box mark Shrink to fit check box
7  Formatting a cell in Currency, you can specify Decimal Places  Currency  Adding  Symbol  Decimal Places
8 Formatting a cell in Number format you can’t set Decimal Places Use 1000 separator Negative numbers  Currency Symbol  Currency Symbol
9 What is entered by the function =today()  The date value for the day according to system clock  The time value according to system clock  Today’s date as Text format Todays day  The date value for the day according to system clock
10 Which function will you use to enter current time in a worksheet cell?  =today()  =now()  =time()  =currentTime()  =now()
11 Merge cells option can be applied from  Format Cells dialog box Alignment Tab  Formatting toolbar  Both of above  None of above  Format Cells dialog box Alignment Tab
12  Pre-made sheet formats like Simple, Classic, Accounting, Colorful et can be applied from  from Format >> Cells  from Format >> Autoformat  from Table >> Autoformat  All of above  from Format >> Autoformat
13 You can set Page Border in Excel from  From Border tab in Format Cells dialog box  From Border tool in Formatting toolbar  From Line Style tool in Drawing toolbar  You can not set page border in Excel  You can not set page border in Excel

14  When all the numbers between 0 and 100 in a range should be displayed in Red Color, apply  Use =if() function to format the required numbers red  Apply Conditional Formatting command on Format menu  Select the cells that contain number between 0 and 100 then click Red color on
Text Color tool use formulas  Apply Conditional Formatting command on Format menu

15  Which of the following is not true regarding Conditional Formatting?  You can add more than one condition to check  You can set condition to look for Bold and apply Italics on them.  You can apply Font, border and pattern formats that meets the specified
conditions

 You can delete any condition from Conditional Formatting dialog box if
it is not required  You can set condition to look for Bold and apply Italics on them.

16  Which of the following is invalid statement?  Sheet tabs can be colored  Some picture can be applied as a background of a sheet  You can set the column width automatically fit the amount of text  The width of a row and be specified manually or fit automatically  The width of a row and be specified manually or fit automatically
17  You can auto fit the width of column by  double clicking on the column name on column header  Double click on the cell pointer in worksheet  Double clicking on column right border on column header  Double clicking on the column left border of column header  Double click on the cell pointer in worksheet
18  Long text can be broken down into many lines within a cell. You can do this through  Wrap Text in Format >> Cells  Justify in Edit >> Cells  Text Wraping in Format >> Cells, Layout tab   Wraping in Format >> Cells,  Wrap Text in Format >> Cells
19  MS Excel provides the default value for step in Fill Series dialog box 0 1 5 10 1
20  Ctrl + D shortcut key in Excel will  Open the font dialog box  Apply double underline for the active cell  Fill down in the selection  None of above  Fill down in the selection
21  The short cut key Ctrl + R is used in Excel to  Right align the content of cell  Remove the cell contents of selected cells  Fill the selection with active cells to the right  None of above  Fill the selection with active cells to the right
22  The command Edit >> Fill Across Worksheet is active only when  One sheet is selected  When many sheets are selected  When no sheet is selected  two sheet are selected  When many sheets are selected
23  Which of the following series type is not valid for Fill Series dialog box?  Linear  Growth  Autofill  Time  Time
24 Formulas in Excel start with % .= .+ & .=
25 Paste Special allows some operation while you paste to new cell. Which of the following operation is valid?  Square  Percentage  Goal Seek  Divide  Divide
26  Edit >> Delete command  Deletes the content of a cell  Deletes Formats of cell  Deletes the comment of cell  Deletes selected cells  Deletes selected cells
27  To remove the content of selected cells you must issue ______ command  Edit >> Delete  Edit >> Clear >> Contents  Edit >> Clear >> All  Data >> Delete  Edit >> Clear >> Contents
28  The Delete key of keyboard is assigned to which command in Excel?  Edit >> Clear >> Contents  Edit >> Clear >> All  Edit >> Delete Edit>>clear  Edit >> Clear >> Contents

29 If you need to remove only the formatting done in a range (numbers and formula typed there should not be remove, you must  From Edit menu choose Clear and then Formats  From Edit menu choose Delete  Click on Remove Formatting tool on Standard Toolbar  Double click the Format Painter and then press Esc key in keyboard  From Edit menu choose Clear and then Formats

30  Which of the following action removes a sheet from workbook?  Select the sheet, then choose Edit >> Delete Sheet  Select the sheet then choose Format >> Sheet >> Hide shift Delete Delete button  Select the sheet, then choose Edit >> Delete Sheet
31 In Microsoft PowerPoint two kind of sound effects files that can be added to the presentation are  .wav files and .mid files  .wav files and .gif files  .wav files and .jpg files  .jpg files and .gif files  .wav files and .mid files
32  Material consisting of text and numbers is best presented as  A table slide  A bullet slide  A title slide A tilde slide  A table slide
33  What is a motion path?  A type of animation entrance effect  A method of advancing slides  A method of moving items on a slide A movement way  A method of moving items on a slide
34  What is a slide-title master pair?  The title area and text area of a specific slide  a slide master and title master merged into a single slide  A slide master and title master for a specific design template A pair of slides  A slide master and title master for a specific design template
35  Which of the following should you use if you want all the slide in the presentation to have the same “look”?  the slide layout option  add a slide option  outline view  a presentation design template  a presentation design template
36  in the context of animations, what is a trigger?  An action button that advances to the next slide  An item on the slide that performs an action when clicked  The name of a motion path Starts the slide show  An item on the slide that performs an action when clicked
37  If you have a PowerPoint show you created and want to send using email to another teacher you can add the show to your email message as a (an)  Inclusion  Attachment  Reply  Forward  Attachment
38  In order to edit a chart, you can  Triple click the chart object  Click and drag the chart object  Double click the chart object  Click the chart object  Double click the chart object
39  to exit the PowerPoint  click the application minimize button  click the document close button  double click the applications control menu icon  double click the document control menu icon  double click the applications control menu icon
40  to preview a motion path effect using the custom animation task pane, you should click the play button  click the show effect button  double click the motion path click the motion path click the play button
41  You can create a new presentation by completing all of the following except  Clicking the new button on the standard toolbar  Clicking file, new  Clicking file open  Pressing ctrl + N  Clicking file open
42  To select one hyperlink after another during a slide presentation, what do you press?  Tab  Ctrl + K  Ctrl + h ctrl+shift  Tab
43  special effects used to introduce slides in a presentation are called  effects  custom animations  transitions  present animations  transitions
44  What is the term used when you press and hold the left mouse key and more the mouse around the slide?  Highlighting  Dragging  Selecting  Moving  Dragging
45  Which of the following toolbars provide different options in various master views?  Common tasks toolbar  Drawing toolbar  Formatting toolbar  Standard toolbar  Common tasks toolbar
46  How can you create a uniform appearance by adding a background image to all slides?  Create a template  Edit the slide master  Use the autocorrect wizard copy  Edit the slide master
47  What is the term used when a clip art image changes the direction of faces?  Group  Flip  Rotate maximize  Rotate
48 the slide that is used to introduce a topic and set the tone for the presentation is called  table slide  graph slide  bullet slide  title slide  title slide
49 Which of the following features should you use when typing in the notes text box?  Slide show  Insert  Slide maser  Zoom  Zoom
50  Which of the following should be used when you want to add a slide to an existing  presentation?  File, add a new slide  Insert, New slide  File Open  File, New  Insert, New slide
51   Which of the following tool enables you to add text to a slide without using the standard placeholders?  Text tool box  Line tool  Drawing tool  Auto shapes tool  Text tool box
52  Objects on the slide that hold text are called  Placeholders  Object holders  Auto layouts  Text holders  Placeholders
53  Which command brings you to the first slide in your presentation?  Next slide button  Page up  Ctrl + Home  Ctrl + End  Ctrl + Home
54  With which of the following allow you to select more than one slide in a presentation?  Alt + Click each slide  Shift + drag each slide  Shift + Click each slide  Ctrl + Click each slide  Shift + Click each slide
55  The PowerPoint view that displays only text (title and bullets) is  Slide show  Slide sorter view  Notes page view  Outline view  Outline view
56  In Microsoft PowerPoint the entry effect as one slide replaces another in a show is called a (an)  animation  slide transition  custom animation  preset animation  slide transition
57  In Microsoft PowerPoint in order to see all the slides on one screen use  view, slide sorter  view, slide  view, master  view, slide show  view, slide sorter
58 Which of the following options changes the fill color of an object back to the default color?  Template  Automatic  Patterns  Fill colors  Automatic
59 Which of the following should be used with the mouse when you want to draw a perfect shape?  The spacebar  The alt key  The ctrl key  The shift key  The shift key
60 When an image is selected, it displays which of the following?  Two corner handles  Six middle handles  Eight sizing handles  Six boxes  Eight sizing handles
50

The ________ property of the control collection returns the number count behave set. number count behave set count
51 The __________ statement is used to assosiate a particular control with an object variable set reset class object set
52 There are ___ types of scroll bars are available. 1 2 3 4 2
53 The _ control is a visual element that contains several predefined shapes shape line rectangle square shape
54 The ___ control is a straight line segment that is drawn at design time. square rectangle shape line line
55 The Fill color and Fill style properties in shape sontrol can be  not changed changed enabled disabled changed
56 The _________ is a commonly used sontrol , which enables the user  to select a value by positioning it at the desired location.  vertical scroll bar Horizontal scroll bar scroll bar status bar scroll bar
57 ___________ control executes timer events at specifies intervals of time time timer watch none timer
58 The ___ control which is a part of an option group allows the user to select one option even if it displays multiple choices. check box command button option button timer option button
59 _____ allows the user to select an item from the dropdown list box to type a selection in the text box.  combo box command button check box none  combo box
60

To create a child form, set its MDI child property to ________ TRUE FALSE 0 1 TRUE
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POSSIBLE QUESTIONS 

PART A (1 MARK) 

(Online Examinations) 

PART B (2 MARKS) 

 

1. What is data? 

2. What is autofill ?Give example 

3. What is a Presentation? 

4. Define SpreadSheet 

5. Define Slide Sorter 

6. What is slide Transition 

7. What does pivot table means? 

8. What is the difference between data and information? 

9. What is slide master? 

10. What is animation? 

PART C (6 MARKS) 

1. How are Formulas useful in MS Excel? Explain with example 

2. Explain slide Design and transition with example. 

3. Explain the formulas and its application in MS Excel with example 

4. Explain custom animation and slide transition 
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5. How are charts useful in MS Excel? Explain any three available in MS 

Excel 

6. Explain slide show and Inserting Media into presentation 

7. Explain steps in insertion and deletion of a worksheet 

8. Explain insert option in MS Power point in detail 

9. Explain the features of MS Excel 

10. Explain the view option in MS Power point 
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Unit V 

Internet 

 

A means of connecting a computer to any other computer anywhere in 

the world via dedicated routers and servers. When two computers are 

connected over the Internet, they can send and receive all kinds of 

information such as text, graphics, voice, video, and computer programs. 

No one owns Internet, although several organizations the world over 

collaborate in its functioning and development. The high-speed, fiber-

optic cables (called backbones) through which the bulk of the Internet 

data travels are owned by telephone companies in their respective 

countries. 

 

The Internet grew out of the Advanced Research Projects Agency's Wide 

Area Network (then called ARPANET) established by the US Department 

Of Defense in 1960s for collaboration in military research among 

business and government laboratories. 

 

Later universities and other US institutions connected to it. This resulted 

in ARPANET growing beyond everyone's expectations and acquiring the 

name 'Internet.' 

The development of hypertext based technology (called World Wide web, 

WWW, or just the Web) provided means of displaying text, graphics, and 

animations, and easy search and navigation tools that triggered 

Internet's explosive worldwide growth. 

 

E-Commerce 



 

Internet 2017-2020 Batch 

  

 

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   3/37 
  

 ommerce or Electronics Commerce is a methodology of modern 

business, which addresses the need of business organizations, 

vendors and customers to reduce cost and improve the quality of 

goods and services while increasing the speed of delivery. E 

commerce refers to the paperless exchange of business Information 

using the following ways: 

� Electronic Data Exchange (EDI) 

� Electronic Mail (e-mail) 

� Electronic Bulletin Boards 

� Electronic Fund Transfer (EFT) 

 

Advantages of E-Commerce 

 

The advantages of e-commerce can be broadly classified into three major 

categories: 

 

� Advantages to Organizations 

 

� Advantages to Consumers 

 

� Advantages to Society 

 

Advantages to Organizations 

 

 Using e-commerce, organizations can expand their market to 

national and international markets with minimum capital 

investment. An organization can easily locate more customers, 

best suppliers, and suitable business partners across the globe. 



 

Internet 2017-2020 Batch 

  

 

Prepared by Mr. K. Veerasamy, Asst. Prof., Department of Computer Application, KAHE   4/37 
  

 

 E-commerce helps organizations to reduce the cost to create 

process, distribute, retrieve and manage the paper based 

information by digitizing the information. 

 

 E-commerce improves the brand image of the company. 

 

 E-commerce helps organizations to provide better customer service. 

 

 E-commerce helps to simplify the business processes and makes 

them faster and efficient. 

 

 E-commerce reduces the paper work. 

 

 E-commerce increases the productivity of organizations. It 

supports "pull" type supply management. In "pull" type supply 

management, a business process starts when a request comes 

from a customer and it uses just-in-time manufacturing way. 

 

Advantages to Consumers 

 It provides 24x7 support. Customers can enquire about a 

product or service and place orders anytime, anywhere from any 

location. 

 E-commerce application provides users with more options and 

quicker delivery of products. 

 

 E-commerce application provides users with more options to 

compare and select the cheaper and better options. 
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 A customer can put review comments about a product and can see 

what others are buying, or see the review comments of other 

customers before making a final purchase. 

 E-commerce provides options of virtual auctions. 

 It provides readily available information. A customer can see the 

relevant detailed information within seconds, rather than waiting 

for days or weeks. 

 E-Commerce increases the competition among organizations 

and as a result, an organization provides substantial discounts 

to customers. 

 

Advantages to Society 

 Customers need not travel to shop a product, thus less traffic on 

road and low air pollution. 

 

 E-commerce helps in reducing the cost of products, so less 

affluent people can also afford the products. 

 

 E-commerce has enabled rural areas to access services and 

products, which are otherwise not available to them. 

 

 E-commerce helps the government to deliver public services such 

as healthcare, education, social services at a reduced cost and in 

an improved manner. 
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The Limitations of EC 

The limitations of EC can be grouped into technical and nontechnical 

categories. 

Technical Limitations of EC 

The technical limitations of EC are as follows: 

 There is a lack of system security, reliability, standards, and 

some communication protocols. 

 There is insufficient telecommunication bandwidth. 

 The software development tools are still evolving and changing 

rapidly. 

 It is difficult to integrate the Internet and EC software with 

some existing applications and databases. 

 Vendors may need special Web servers and other 

infrastructures, in addition to the network servers. 

 Some EC software might not fit with some hardware, or may be 

incompatible with some operating systems or other 

components. 

As time passes, these limitations will lessen or be overcome; 

appropriate planning can minimize their impact. 

NonTechnical Limitations 

Of the many nontechnical limitations that slow the spread of EC, 

the following are the major ones. 

 Cost and justification The cost of developing EC in-house can be 

very high, and mistakes due to lack of experience may result in 

delays. There are many opportunities for outsourcing, but where 

and how to do it is not a simple issue. Furthermore, to justify the 

system one must deal with some intangible benefits (such as 

improved customer service and the value of advertisement), which 
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are difficult to quantify. · Security and privacy These issues are 

especially important in the B2C area, especially security issues 

which are perceived to be more serious than they really are when 

appropriate encryption is used. Privacy measures are constantly 

improved. Yet, the customers perceive these issues as very 

important, and, the EC industry has a very long and difficult task 

of convincing customers that online transactions and privacy are, 

in fact, very secure. 

 

 Lack of trust and user resistance Customers do not trust an 

unknown faceless seller (sometimes they do not trust even known 

ones), paperless transactions, and electronic money. So switching 

from physical to virtual stores may be difficult. · Other limiting 

factors. Lack of touch and feel online. Some customers like to 

touch items such as clothes and like to know exactly what they 

are buying. · Many legal issues are as yet unresolved, and 

government regulations and standards are not refined enough for 

many circumstances. · Electronic commerce, as a discipline, is still 

evolving and changing rapidly. Many people are looking for a 

stable area before they enter into it. 

 There are not enough support services. For example, copyright 

clearance centers for EC transactions do not exist, and high-

quality evaluators, or qualified EC tax experts, are rare. · In most 

applications there are not yet enough sellers and buyers for 

profitable EC operations. 

 Electronic commerce could result in a breakdown of human 

relationships. · Accessibility to the Internet is still expensive 

and/or inconvenient for many potential customers. (With Web TV, 
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cell telephone access, kiosks, and constant media attention, the 

critical mass will eventually develop.) 

Despite these limitations, rapid progress in EC is taking place. For 

example, the number of people in the United States who buy and sell 

stocks electronically increased from 300,000 at the beginning of 1996 

to about 10 million in fall 1999. As experience accumulates and 

technology improves, the ratio of EC benefits to costs will increase, 

resulting in a greater rate of EC adoption. The potential benefits may 

not be convincing enough reasons to start EC activities 

APPLICATIONS OF E-COMMERCE: 

The applications of E-commerce are used in various business areas 

such as retail and wholesale and manufacturing. The most common E-

commerce applications are as follows: 

Retail and wholesale: 

E-commerce has a number of applications in retail and wholesale. E-

retailing or on-line retailing is the selling of goods from Business-to-

Consumer through electronic stores that are designed using the 

electronic catalog and shopping cart model. Cybermall is a single Website 

that offers different products and services at one Internet location. It 

attracts the customer and the seller into one virtual space through a Web 

browser. 

 

Marketing: 

Data collection about customer behavior, preferences, needs and buying 

patterns is possible through Web and E-commerce. This helps marketing 

activities such as price fixation, negotiation, product feature 
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enhancement and relationship with the customer 

Finance: 

Financial companies are using E-commerce to a large extent. Customers 

can check the balances of their savings and loan accounts, transfer 

money to their other account and pay their bill through on-line banking 

or E-banking. Another application of E-commerce is on-line stock 

trading. Many Websites provide access to news, charts, information 

about company      profile      and      analyst      rating      on      the       

stocks.   Manufacturing: 

E-commerce is also used in the supply chain operations of a company. 

Some companies form an electronic exchange by providing together buy 

and sell goods, trade market information and run back office information 

such as inventory control. This speeds up the flow of raw material and 

finished goods among the members of the business community. Various 

issues related to the strategic and competitive issues limit the 

implementation of the business models. Companies may not trust their 

competitors and may fear that they will  lose  trade  secrets  if  they  

participate   in   mass   electronic   exchanges.  Auctions: 

Customer-to-Customer E-commerce is direct selling of goods and 

services among customers. It also includes electronic auctions that 

involve bidding. Bidding is a special type of auction that allows 

prospective buyers to bid for an item. For example, airline companies 

give the customer an opportunity to quote the price for a seat on a 

specific route on the specified date and time. 

Email 

Short for electronic mail, email (or e-mail) is defined as the transmission 

of messages over communications networks.  Typically  the  messages  

are   notes   entered   from   the keyboard or    electronic files stored on 

http://www.webopedia.com/TERM/C/communications.html
http://www.webopedia.com/TERM/N/network.html
http://www.webopedia.com/TERM/K/keyboard.html
http://www.webopedia.com/TERM/F/file.html
http://www.webopedia.com/TERM/S/store.html
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disk.    Most mainframes, minicomputers,  and computer networks have 

an email system. Some electronic mail systems are confined to a single 

computer system or network, but others have gateways to other 

computer systems, enabling users to send electronic mail anywhere in 

the world. Companies that are fully computerized make extensive use of 

e-mail because it is fast, flexible, and reliable. 

Steps to create email account 

Follow the steps below to create email account enjoy the great mail.com 

emailing experience: 

 Click on the Free Sign Up Button 

 Enter all mandatory fields (First Name, Last Name, Gender, etc.) 

 Type in your desired Email Address out of our huge selection of 

200 available domains (e.g. biker.com, accountant.com, chef.net, 

gmail, yahoo, etc.) 

 Choose a secure Password (at least 8 characters, mixing letters, 

numbers, lower and upper case, and using special characters) 

 Select your Security Question, type in your Answer 

 Verify your registration by typing the numbers in the captcha picture 

 Click the "Accept" - Button underneath 

That's it! You're done. Enjoy your new email account immediately on any 

device of your choice! 

Typical Components of an Email System 

Most e-mail systems include a rudimentary text editor for composing 

messages, but many allow you to edit your messages using any editor 

you want. Some systems will also provide basic formatting, including 

bold, italics, font color and HTML. You can use the program to send the 

message to a recipient by specifying the recipient's address. You can also 

send the same message to several users at once. This is called 

http://www.webopedia.com/TERM/M/mainframe.html
http://www.webopedia.com/TERM/M/minicomputer.html
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/S/system.html
http://www.webopedia.com/TERM/C/computer_system.html
http://www.webopedia.com/TERM/G/gateway.html
http://www.webopedia.com/TERM/U/user.html
https://www.mail.com/email/
https://www.mail.com/email/
http://www.webopedia.com/TERM/E/editor.html
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broadcasting. Sent messages are stored in electronic mailboxes until the 

recipient fetches them. To see if you have any mail, you may have to 

check your electronic mailbox periodically, although many systems alert 

you when mail is received. After reading your mail, you can store it in a 

text file, forward it to other users, or delete it. Copies of memos can be 

printed out on a printer if you want a paper copy. 

Group Communication 

Group communication refers to the interaction between members of a 

small group of individuals. Quality communication leads to effective 

group decision making and project completion. 

 

More than two members involved in communication process will become 

a group communication. If least number of persons is involved in the 

group communication is called as small group communication. In this 

communication process, everyone becomes a Source as well as receiver 

http://www.webopedia.com/TERM/B/broadcast.html
http://www.webopedia.com/TERM/M/mailbox.html
http://www.webopedia.com/TERM/T/text_file.html
http://www.webopedia.com/TERM/D/delete.html
http://www.webopedia.com/TERM/P/printer.html
http://www.webopedia.com/TERM/C/copy.html
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through sharing information and gives feedback to another. 

 

Group communication applies to groups containing between three and 

20 people. Communication between two people is a dialog, and larger 

groups are unable to use group communication effectively. Quality group 

communication involves a facilitator and group members with a sense of 

belonging, common goals and mutual respect. Both verbal and nonverbal 

communication are components of group communication. 

 

Successful group communication is essential in a business environment. 

Many variables come into play, starting with the seating arrangement. A 

circular seating arrangement allows all group members to make eye 

contact and interact with all other members. This forms the foundation 

for a web network style of communication, with all group members 

sharing ideas with each other. Sociologists find this type of group 

communication arrangement to be the most effective for generating ideas, 

making decisions and solving problems. 

 

When the primary purpose of a group is to share information, an 

alternate arrangement is preferable. This form of group communication 

starts with a seating arrangement that emphasizes the group leader: for 

example a long table with the leader at one end. The leader presents 

information and group members give feedback. 

 

Teleconferencing 

A teleconference is a telephone meeting among two or more participants 

involving technology more sophisticated than a simple two-way phone 

connection. At its simplest, a teleconference can be an audio conference 
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with one or both ends of the conference sharing a speaker phone. With 

considerably more equipment and special arrangements, a teleconference 

can be a conference, called a videoconference, in which the participants 

can see still or motion video images of each other. Because of the high 

bandwidth of video and the opportunity for larger and multiple display 

screens, a videoconference requires special telecommunication 

arrangements and a special room at each end. As equipment and high-

bandwidth cabling become more commonplace, it's possible that 

videoconferences can be held from your own computer or even in a 

mobile setting 

 

File transfer is a generic term  for  the  act  of transmitting files over  a 

computer network like the Internet. There are numerous ways and 

protocols to transfer files over a network. Computers which provide a file 

transfer service are often called file servers. Depending      on      the 

client's       perspective       the       data       transfer       is     called 

uploading or downloading. File transfer for the enterprise now 

increasingly is done with Managed file transfer. 

 

There are 2 types of file transfers: 

 

 Pull-based file transfers where the receiver initiates a file transmission 

request 

 Push-based file transfers where the sender initiates a file transmission 

request. 

 

  

https://en.wikipedia.org/wiki/Transmission_(telecommunications)
https://en.wikipedia.org/wiki/File_(computing)
https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Internet
https://en.wikipedia.org/wiki/Protocol_(computing)
https://en.wikipedia.org/wiki/File_server
https://en.wikipedia.org/wiki/Client_(computing)
https://en.wikipedia.org/wiki/Upload
https://en.wikipedia.org/wiki/Download
https://en.wikipedia.org/wiki/Managed_file_transfer
https://en.wikipedia.org/wiki/Pull_technology
https://en.wikipedia.org/wiki/Push_technology
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File transfer can take place over a variety of levels: 

 Transparent file transfers over network file systems 

 Explicit file transfers from dedicated file transfer services like FTP or 

HTTP 

 Distributed file transfers over peer-to-peer networks like Bittorent or 

Gnutella 

 In IBM Systems Network Architecture, LU 6.2 peer-to-peer file 

transfer programs such as IBM's Connect:Direct and CA 

Technologies' XCOM Data Transport 

 File transfers over instant messaging or LAN messenger 

 File transfers between computers and peripheral devices 

 File transfers over direct modem or serial (null modem)

 links, such as XMODEM, YMODEM and ZMODEM. 

 

Protocols: 

 

A file transfer protocol is a convention that describes how to 

transfer files between  two  computing  endpoints.  They  are  meant  

solely  to  send  the  stream        of bits stored as a single unit in a file 

system, plus any relevant metadata such as thefilename, file size and 

timestamp. File transfer protocols usually operate on top of a lower-level 

protocol in a protocol stack. For example, the HTTP protocol operates at 

the topmost  application  layer  of  the TCP/IP   stack,   whereas 

XMODEM,YMODEM,   and ZMODEM typically operate across RS-232 

serial connections. 

 

Bandwidth is defined as a range within a band of frequencies or 

wavelengths. Bandwidth is also defined as the amount of data that can 

https://en.wikipedia.org/wiki/Network_transparency
https://en.wikipedia.org/wiki/Distributed_file_system
https://en.wikipedia.org/wiki/File_Transfer_Protocol
https://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol
https://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol
https://en.wikipedia.org/wiki/Peer-to-peer
https://en.wikipedia.org/wiki/BitTorrent_(protocol)
https://en.wikipedia.org/wiki/Gnutella
https://en.wikipedia.org/wiki/Gnutella
https://en.wikipedia.org/wiki/IBM_Systems_Network_Architecture
https://en.wikipedia.org/wiki/IBM_Advanced_Program-to-Program_Communication
https://en.wikipedia.org/wiki/IBM
https://en.wikipedia.org/wiki/CA_Technologies
https://en.wikipedia.org/wiki/CA_Technologies
https://en.wikipedia.org/wiki/XCOM_Data_Transport
https://en.wikipedia.org/wiki/Instant_messaging
https://en.wikipedia.org/wiki/LAN_messenger
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Peripheral_device
https://en.wikipedia.org/wiki/Modem
https://en.wikipedia.org/wiki/Serial_port
https://en.wikipedia.org/wiki/Null_modem
https://en.wikipedia.org/wiki/XMODEM
https://en.wikipedia.org/wiki/YMODEM
https://en.wikipedia.org/wiki/ZMODEM
https://en.wikipedia.org/wiki/Bit
https://en.wikipedia.org/wiki/File_system
https://en.wikipedia.org/wiki/File_system
https://en.wikipedia.org/wiki/Metadata
https://en.wikipedia.org/wiki/Filename
https://en.wikipedia.org/wiki/Timestamp
https://en.wikipedia.org/wiki/Timestamp
https://en.wikipedia.org/wiki/Protocol_stack
https://en.wikipedia.org/wiki/TCP/IP_stack
https://en.wikipedia.org/wiki/XMODEM
https://en.wikipedia.org/wiki/XMODEM
https://en.wikipedia.org/wiki/YMODEM
https://en.wikipedia.org/wiki/ZMODEM
https://en.wikipedia.org/wiki/RS-232
http://www.webopedia.com/TERM/D/data.html
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be transmitted in a fixed amount of time. For 

bandwidth is usually expressed in bits per second(

second. For analog devices, the bandwidth is expressed in cycles per 

second, or Hertz (Hz). 

 

The bandwidth is particularly important  for 

a  fast disk  drive can be hampered by a 

is the main reason that new buses, such as 

for the PC. 

 

Modem: 

 

(mō´dem) (n.) Short for 

program that enables a 

telephone or cable lines. Computer information is

whereas information transmitted over telephone lines is transmitted in 

the form of analog waves. 

 

Standard Modem Interface

 

Fortunately, there is one 

modems to computers called RS

can be attached to any c

Internet 
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be transmitted in a fixed amount of time. For digital devices

bandwidth is usually expressed in bits per second(bps) or

devices, the bandwidth is expressed in cycles per 

The bandwidth is particularly important  for I/O devices.  For  example,  

can be hampered by a bus with a low bandwidth. This 

is the main reason that new buses, such as AGP, have been developed 

Short for modulator-demodulator. A modem is 

that enables a computer to transmit data over, for example, 

telephone or cable lines. Computer information isstored 

whereas information transmitted over telephone lines is transmitted in 

waves. A modemconverts between these two forms.

Standard Modem Interface 

Fortunately, there is one standard interface for connecting 

to computers called RS-232.Consequently, any external modem 

can be attached to any computer that has an RS-232 port, which almost 
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devices, the 

) orbytes per 

devices, the bandwidth is expressed in cycles per 

devices.  For  example,  

with a low bandwidth. This 

, have been developed 

A modem is adevice or 

over, for example, 

stored digitally, 

whereas information transmitted over telephone lines is transmitted in 

between these two forms. 

for connecting external 

232.Consequently, any external modem 

which almost 
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allpersonal computers have. There are also modems that come as an 

expansion board that you can insert into a vacant expansion slot. These 

are sometimes called onboard or internal modems. 

Types of Network Topology 

 

Network Topology is the schematic description of a network 

arrangement, connecting various nodes(sender and receiver) through 

lines of connection. 

 

BUS Topology 

 

Bus topology is a network type in which every computer and network 

device is connected to single cable. When it has exactly two endpoints, 

then it is called Linear Bus topology. 

 

 

Features of Bus Topology 

 

1. It transmits data only in one direction. 

2. Every device is connected to a single cable 

 

http://www.webopedia.com/TERM/P/personal_computer.html
http://www.webopedia.com/TERM/E/expansion_board.html
http://www.webopedia.com/TERM/E/expansion_slot.html
http://www.webopedia.com/TERM/I/internal_modem.html
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Advantages of Bus Topology 

 

1. It is cost effective. 

2. Cable required is least compared to other network topology. 

3. Used in small networks. 

4. It is easy to understand. 

5. Easy to expand joining two cables together. 

 

Disadvantages of Bus Topology 

 

1. Cables fails then whole network fails. 

2. If network traffic is heavy or nodes are more the performance of the 

network decreases. 

3. Cable has a limited length. 

4. It is slower than the ring topology. 

 

Ring Topology 
 

It is called ring topology because it forms a ring as each computer is 

connected to another computer, with the last one connected to the first. 

Exactly two neighbours for each device. 
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Features of Ring Topology 

 

1. A number of repeaters are used for Ring topology with large 

number of nodes, because if someone wants to send some data to 

the last node in the ring topology with 100 nodes, then the data 

will have to pass through 99 nodes to reach the 100th node. Hence 

to prevent data loss repeaters are used in the network. 

2. The transmission is unidirectional, but it can be made 

bidirectional by having 2 connections between each Network Node, 

it is called Dual Ring Topology. 

3. In Dual Ring Topology, two ring networks are formed, and data 

flow is in opposite direction in them. Also, if one ring fails, the 

second ring can act as a backup, to keep the network up. 

4. Data is transferred in a sequential manner that is bit by bit. Data 

transmitted, has to pass through each node of the network, till the 

destination node. 
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Advantages of Ring Topology 

 

1. Transmitting network is not affected by high traffic or by adding 

more nodes, as only the nodes having tokens can transmit data. 

2. Cheap to install and expand 

 

Disadvantages of Ring Topology 

 

1. Troubleshooting is difficult in ring topology. 

2. Adding or deleting the computers disturbs the network activity. 

3. Failure of one computer disturbs the whole network. 

 

STAR Topology 

 

In this type of topology all the computers are connected to a single hub 

through a cable. This hub is the central node and all others nodes are 

connected to the central node. 
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Features of Star Topology 

 

1. Every node has its own dedicated connection to the hub. 

2. Hub acts as a repeater for data flow. 

3. Can be used with twisted pair, Optical Fibre or coaxial cable. 

 

Advantages of Star Topology 

 

1. Fast performance with few nodes and low network traffic. 

2. Hub can be upgraded easily. 

3. Easy to troubleshoot. 

4. Easy to setup and modify. 

5. Only that node is affected which has failed, rest of the nodes can work 

smoothly. 

 

Disadvantages of Star Topology 

 

1. Cost of installation is high. 

2. Expensive to use. 

3. If the hub fails then the whole network is stopped because all the 

nodes depend on the hub. 

4. Performance is based on the hub that is it depends on its capacity 

 

MESH Topology 

 

It is a point-to-point connection to other nodes or devices. All the 

network nodes are connected to each other. Mesh has n(n-2)/2 

physical channels to link n devices. 
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There are two techniques to transmit data over the Mesh topology, they are : 

 

1. Routing 

2. Flooding 

 

Routing 

 

In routing, the nodes have a routing logic, as per the network 

requirements. Like routing logic to direct the data to reach the 

destination using the shortest distance. Or, routing logic which has 

information about the broken links, and it avoids those node etc. We can 

even have routing logic, to re-configure the failed nodes. 

 

Flooding 

 

In flooding, the same data is transmitted to all the network nodes, hence 

no routing logic is required. The network is robust, and the its very 

unlikely to lose the data. But it leads to unwanted load over the network. 
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Types of Mesh Topology 
 

1. Partial Mesh Topology : In this topology some of the systems are 

connected in the same fashion as mesh topology but some devices 

are only connected to two or three devices. 

2. Full Mesh Topology : Each and every nodes or devices are 

connected to each other. 

 

Features of Mesh Topology 

 

1. Fully connected. 

2. Robust. 

3. Not flexible. 

 

Advantages of Mesh Topology 

 

1. Each connection can carry its own data load. 
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2. It is robust. 

3. Fault is diagnosed easily. 

4. Provides security and privacy. 

 

Disadvantages of Mesh Topology 

 

1. Installation and configuration is difficult. 

2. Cabling cost is more. 

3. Bulk wiring is required. 

 

TREE Topology 

 

It has a root node and all other nodes are connected to it forming a 

hierarchy. It is also called hierarchical topology. It should at least have 

three levels to the hierarchy. 

 

Features of Tree Topology 

 

1. Ideal if workstations are located in groups. 

2. Used in Wide Area Network. 
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Advantages of Tree Topology 

 

1. Extension of bus and star topologies. 

2. Expansion of nodes is possible and easy. 

3. Easily managed and maintained. 

4. Error detection is easily done. 

 

Disadvantages of Tree Topology 

 

1. Heavily cabled. 

2. Costly. 

3. If more nodes are added maintenance is difficult. 

4. Central hub fails, network fails. 

 

HYBRID Topology 

 

It is two different types of topologies which is a mixture of two or more 

topologies. For example if in an office in one department ring topology is 

used and in another star topology is used, connecting these topologies 

will result in Hybrid Topology (ring topology and star topology). 
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Features of Hybrid Topology 

1. It is a combination of two or topologies 

2. Inherits the advantages and disadvantages of the topologies included 

 

Advantages of Hybrid Topology 

 

1. Reliable as Error detecting and trouble shooting is easy. 

2. Effective. 

3. Scalable as size can be increased easily. 

4. Flexible. 
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Disadvantages of Hybrid Topology 

 

1. Complex in design. 

2. Costly. 

 

TYPES OF NETWORK 

Local Area Network (LAN) 

This is one of the original categories of network, and one of the simplest. 

LANnetworks connect computers together over relatively small distances, 

such as within a single building or within a small group of buildings. 

 

 

Homes often have LAN networks too, especially if there is more than one 

device in the home. Often they do not contain more than one subnet, if 

any, and are usually controlled by a single administrator. They do not 

have to be connected to the internet to work, although they can be.

http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
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Wide Area Network (WAN) 

This is another of the original categories of network, and slightly more 

complex in nature. WAN networks connect computers together over 

large physical distances, remotely connecting them over one huge 

network and allowing them to communicate even when far apart. The 

Internet is a WAN, and connects computers all around the world 

together. 

 

 

LANs connect to WANs, such as the internet, using routers to transfer 

data and information quickly and securely. WANs are usually too large to 

be controlled by one administrator, and so usually have collective 

ownership, or in the case of the internet, is publicly owned. 

 

  

http://www.certiology.com/computing/computer-networking/types-of-networks.html
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Other Types of Network 

 

There are also other types of network you may encounter. Some of these 

are different, but most are simply developed from LAN and WAN 

networks to have slight difference and adapt to different user needs. 

These include: 

 

Metropolitan Area Network – This is a network which is larger than a 

LAN but smaller than a WAN, and incorporates elements of both. It 

typically spans a town or city and is owned by a single person or 

company, such as a local council or a large company. 

 

 

 

 

Campus Area Network – This is a network which is larger than a LAN, 

but smaller than an MAN. This is typical in areas such as a university, 

large school or small business. It is typically spread over a collection of 

buildings which are reasonably local to each other. It may have an 

internal Ethernet as well as capability of connecting to the internet. 

http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
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Wireless Local Area Network – This is a LAN which works using 

wireless network technology such as Wi-Fi. This type of network is 

becoming more popular as wireless technology is further developed and 

is used more in the home and by small businesses. It means devices do 

not need to rely on physical cables and wires as much and can organise 

their spaces more effectively. 

 

 

http://www.certiology.com/computing/computer-networking/types-of-networks.html
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System Area Network – This network connects computers together on 

an especially high- speed connection, in a configuration known as a 

cluster. This means computers which are connected together so as to 

work as a single system, and can be done as a result of very high speed 

computers and new low cost microprocessors. They are usually used to 

improve performance and for cost effectiveness. 

 

 

Storage Area Network – This network connects servers directly to 

devices which store amounts of data without relying on a LAN or WAN 

network to do so. This can involve another type of connection known as 

Fibre Channel, a system similar to Ethernet whichhandles high-

performance disk storage for applications on a number of professional 

networks. 

http://www.certiology.com/computing/computer-networking/types-of-networks.html
http://www.certiology.com/computing/computer-networking/types-of-networks.html
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Open Systems Interconnect Layer: 

 

The Open Systems Interconnect (OSI) model has seven layers. This 

article describes and explains them, beginning with the 'lowest' in the 

hierarchy (the physical) and proceeding to the 'highest' (the application). 

The layers are stacked this way: 

 

 Application 

 Presentation 

 Session 

 Transport 

 Network 

 Data Link 

 Physical  

PHYSICAL LAYER 

The physical layer, the lowest layer of the OSI model, is concerned with 

the transmission and reception of the unstructured raw bit stream over a 

physical medium. It describes the electrical/optical, mechanical, and 
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functional interfaces to the physical medium, and carries the signals for 

all of the higher layers. It provides: 

 

 Data encoding: modifies the simple digital signal pattern (1s and 

0s) used by the PC to better accommodate the characteristics of 

the physical medium, and to aid in bit and frame synchronization. 

It determines: 

 What signal state represents a binary 1 

 How the receiving station knows when a "bit-time" starts 

 How the receiving station delimits a frame 

 Physical medium attachment, accommodating various possibilities in 

the medium: 

 Will an external transceiver (MAU) be used to connect to the 

medium? 

 How many pins do the connectors have and what is each pin used 

for? 

 Transmission technique: determines whether the encoded bits will 

be transmitted by baseband (digital) or broadband (analog) 

signaling. 

 Physical medium transmission: transmits bits as electrical or 

optical signals appropriate for the physical medium, and 

determines: 

 What physical medium options can be used 

 How many volts/db should be used to represent a given 

signal state, using a given physical medium 

 

DATA LINK LAYER 
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The data link layer provides error-free transfer of data frames from one 

node to another over the physical layer, allowing layers above it to 

assume virtually error-free transmission over the link. 

 

To do this, the data link layer provides: 

 

 Link establishment and termination: establishes and terminates 

the logical link between two nodes. 

 Frame traffic control: tells the transmitting node to "back-off" when 

no frame buffers are available. 

 Frame sequencing: transmits/receives frames sequentially. 

 Frame acknowledgment: provides/expects frame 

acknowledgments. Detects and recovers from errors that occur in 

the physical layer by retransmitting non- acknowledged frames 

and handling duplicate frame receipt. 

 Frame delimiting: creates and recognizes frame boundaries. 

 Frame error checking: checks received frames for integrity. 

 Media access management: determines when the node "has the 

right" to use the physical medium. 

 

NETWORK LAYER 

 

The network layer controls the operation of the subnet, deciding which 

physical path the data should take based on network conditions, priority 

of service, and other factors. It provides: 

Routing: routes frames among networks. 

 

 Subnet traffic control: routers (network layer intermediate systems) 
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can instruct a sending station to "throttle back" its frame 

transmission when the router's buffer fills up. 

 Frame fragmentation: if it determines that a downstream router's 

maximum transmission unit (MTU) size is less than the frame size, 

a router can fragment a frame for transmission and re-assembly at 

the destination station. 

 

 Logical-physical address mapping: translates logical addresses, or 

names, into physical addresses. 

 Subnet usage accounting: has accounting functions to keep track 

of frames forwarded by subnet intermediate systems, to produce 

billing information. 

 

In the network layer and the layers below, peer protocols exist 

between a node and its immediate neighbor, but the neighbor may 

be a node through which data is routed, not the destination 

station. The source and destination stations may be separated by 

many intermediate systems. 
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TRANSPORT LAYER 

 

The transport layer ensures that messages are delivered error-free, in 

sequence, and with no losses or duplications. It relieves the higher layer 

protocols from any concern with the transfer of data between them and 

their peers. The size and complexity of a transport protocol depends on 

the type of service it can get from the network layer. For a reliable 

network layer with virtual circuit capability, a minimal transport layer is 

required. If the network layer is unreliable and/or only supports 

datagrams, the transport protocol should include extensive error 

detection and recovery. 

 

The transport layer provides: 

 

 Message segmentation: accepts a message from the (session) layer 

above it, splits the message into smaller units (if not already small 

enough), and passes the smaller units down to the network layer. 

The transport layer at the destination station reassembles the 

message. 

 Message acknowledgment: provides reliable end-to-end message 

delivery with acknowledgments. 

 Message traffic control: tells the transmitting station to "back-off" 

when no message buffers are available. 

 Session multiplexing: multiplexes several message streams, or 

sessions onto one logical link and keeps track of which messages 

belong to which sessions (see session layer). 
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SESSION LAYER 

 

The session layer allows session establishment between processes 

running on different stations. It provides: 

 

 Session establishment, maintenance and termination: allows two 

application processes on different machines to establish, use and 

terminate a connection, called a session. 

 Session support: performs the functions that allow these processes 

to communicate over the network, performing security, name 

recognition, logging, and so on. 

 

PRESENTATION LAYER 

 

The presentation layer formats the data to be presented to the 

application layer. It can be viewed as the translator for the network. This 

layer may translate data from a format used by the application layer into 

a common format at the sending station, then translate the common 

format to a format known to the application layer at the receiving station. 

 

The presentation layer provides: 

 Character code translation: for example, ASCII to EBCDIC. 

 Data conversion: bit order, CR-CR/LF, integer-floating point, and so on. 

 Data compression: reduces the number of bits that need to be 

transmitted on the network. 

 Data encryption: encrypt data for security purposes. For example, 

password encryption. 
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APPLICATION LAYER 

The application layer serves as the window for users and application 

processes to access network services. This layer contains a variety of 

commonly needed functions: 

 

 Resource sharing and device redirection 

 Remote file access 

 Remote printer access 

 Inter-process communication 

 Network management 

 Directory services 

 Electronic messaging (such as mail) 

 Network virtual terminals 

 

Dial-Up Access: 

 

Refers to connecting a device to a network via a modem and a public 

telephone network. Dial-up access is really just like a phone connection, 

except that the parties at the two ends are computer devices rather than 

people. Because dial-up access uses normal telephone lines, the quality 

of the connection is not always good and data rates are limited. In the 

past, the maximum data rate with dial-up access was 56 Kbps (56,000 

bits per second), but new technologies such as ISDN are providing faster 

rates. An alternative way to connect two computers is through a leased 

line, which is a permanent connection between two devices. Leased lines 

provide faster through put and better quality connections, but they are 

also more expensive. 

http://www.webopedia.com/TERM/D/device.htm
http://www.webopedia.com/TERM/N/network.htm
http://www.webopedia.com/TERM/M/modem.htm
http://www.webopedia.com/TERM/D/data_rate.htm
http://www.webopedia.com/TERM/K/Kbps.htm
http://www.webopedia.com/TERM/I/ISDN.htm
http://www.webopedia.com/TERM/L/leased_line.htm
http://www.webopedia.com/TERM/L/leased_line.htm
http://www.webopedia.com/TERM/T/throughput.htm
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UNIT V
S.NO QUESTIONS OPTION 1 OPTION 2 OPTION 3 OPTION 4 ANSWER

1 All  of  the  following  are  considered  biometrics,  except:  Fingerprint  Retina  Password Voice Password
2 Which  is  the  most  important  component  of  IT?    Information     People  Information  technology Computers    People

3 Unsolicited  e‐mail  is  called  what?   Junk  mail    Spam  Extra  mail trash  Spam
4  What  is  the  name  of  the  new  anti‐Spam  bill?  No‐Spam  CAN‐Spam  Spam‐Away Stop  Spam  CAN‐Spam

5 What  is  the  legal  protection  afforded  an  expression  of  an  idea,  such  as  a  song,  video  game,  and  some  types  of
proprietary  documents?

 Ethics  Intellectual  property  Copyright  Fair  Use  Doctrine  Copyright

6  What  is  the  unauthorized  use,  duplication,  distribution  or  sale  of  copyrighted  software?    Fair  Use  Doctrine   Pirated  software   Counterfeit  software   Privacy   Pirated  software

7  What  is  a  fully‐equipped  computer  that  you  wear  as  a  piece  of  clothing  or  attached  to  a  piece  of  clothing  similar  to
the  way  you  would  carry  your  cell  phone  on  your  belt?

   Wearable  computer      GPS  Implant  chip Bluetooth  Wearable  computer

8  What is  a  technology‐enabled  microchip  implanted  into  the  human  body?   Wearable  computer  GPS   Implant  chip Bluetooth  Implant  chip
9  Smart  card  is  better  protected  than  other  cards  using                         Encryption   Firewall   Hub router  Encryption
10  Which  of  the  following  can  be  used  to  help  identify  people  in  a  crowd?                         Biochip  Implant  chip   Facial  recognition  software   Vision  chip   Facial  recognition  software
11  Which  one  is  also  known  as  plastic  money?                         Credit  card  Debit  card   Paper  cash Visa  Credit  card
12 E‐cheques  are  …………………                         Prepaid   Postpaid  Both  prepaid  and  postpaid Free      Prepaid

13  Digital  signature  is  a   Digital  id,send  as  an
attachment  to  a  web
page/e‐mail/message

   Is  used  for  verifying
the  attachments  send

using  web

   Both  a  and  b only A   Both  a  and  b

14  ‐‐‐‐‐‐‐‐‐‐‐‐‐‐ is  an  act  that  poses  danger  to  computer  assets.   Threat  Danger      Error tragedy   Threat

15  OTP stands for                         On  Time
Password

  On  Time  processing                         One  time  processor  One Time  Password   One Time  Password

16  Internet is  a local computer network  a world wide network of
computers

 an interconnected network of
computers

 a world wide interconnected
network of computers which use a
common protocol to communicate
with one another

 a world wide interconnected network
of computers which use a common
protocol to communicate with one
another

17 Internet requires  an international agreement to
connect computers

 a local area network  a commonly agreed set of rules to
communicate between computers

 a World Wide Web  a commonly agreed set of rules to
communicate between computers18 Each computer connected to the internet must  be an IBM PC  have a unique IP

address
 be internet compatible  have a modem connection  have a unique IP address

19  World Wide Web  is another name for internet  world wide connection
for computers

 a collection of linked information
residing on computers connected by the
internet

 a collection of world wide
information

 a collection of linked information
residing on computers connected by
the internet

20  A world wide web contains web pages  residing in many computers  created using HTML  with links to other web pages  residing in many computers linked
together using HTML

 residing in many computers linked
together using HTML

21  A search engine is a program to search  for information  web pages  web pages for specified index terms  web pages for information using
specified search terms

 web pages for information using
specified search terms

22  HTML stands for  Hyper Text Making Links  Hyper Text Markup
Language

 Higher Textual Marking of Links  Hyper Text Mixer of Links  Hyper Text Markup Language

23   ………. layer handles the physical addressing of communicating devices. Physical Logical Data-link Network Data-link
24 Which OSI layer deals with physical addressing of the device? Ethernet L. IP L. Address L. Data-link Data-link

25  Which of the following is a disadvantage for networks with bus topology?  Less cabling than ring  Needs a central device Cable faults down entire network It is collision-free Cable faults down entire network

26  Which of the following is not one of the seven OSI layers? Adaptation  Session Presentation Transport Adaptation
27 Which of the following is not one of the seven OSI layers?  Network Session Routing Transport Routing
28  The popular application of computer networks is ----------------  electronic mail or e-mail Browser IP Internet  electronic mail or e-mail
29 _________ topology is formed by connecting two or more topologies together. Mesh  Hybrid ring Bus  Hybrid
30  mesh topology is also called ___________ topology. complete Connection Hub Transform complete
31 _______ topology is a hierarchy of various hubs. Mesh  Hybrid Tree Bus Tree
32  In star topology all the nodes are connected to a central node called a_______.  hub Node Routing Bus  hub
33 ____________ to mean a collection of autonomous computers interconnected by a single Technology. Datalink URL  Computer network'' Internet  Computer network''
34  _______ topology defined as the logical connection of various computers in the network. Network Mesh  Hybrid Tree Network
35 In bus topology all the computers are connected to a long cable called a __________ Hub bus. Node router Bus
36 In________ topology, the computers are connected in the form of a ring. Mesh  Hybrid  ring Tree Ring

37 ______ are widely used to connect personal computers and workstations in company offices and factories to share resources LAN WAN MAN PAN LAN

38  Digitally enabled business transactions are called___________  E-Commerce.  E-Goverence.  E-Ticket.  E-University.  E-Commerce.
39  The word "E" in E-Commerce refers about  Email.  English.  Electronic communication.  Ever.  Electroni

40  Major transactions in E-Commerce is  Buying and Selling a product over
internet.

 A study of commerce in
internet.

 Electronic communication.  Giving Advice.  Buying and Selling a product over
internet.

41  B2B Stands for  Begin to Begin.  Buyer 2 Buyer.  Business to Buyer.  Business to Business.  Business to Business.

42  C2C stands for  Communication to
Communication.

 Cost to Cost.  Customer to Customer.  Customer to Cost.  Customer to Customer.

43  B2C Stands for  Buyer to Cost.  Business to Cost.  Basic to Customer.  Business to Customer.  Business to Customer.
44  P2P Stands for  Point to Point.  Public to Publi  Peer to Peer.  Purchase to Purchase.  Peer to Peer.
45 M-Commerce means  Mobile Commerce.  Multiple Commerce.  Money Commerce.  Managerial Commerce.  Mobile Commerce.

46  ____________ is derived from 'e-commerce' is conducting business on the Internet, but not just buying and selling but also
servicing customers and collaborating with business partners.

 E-Business.  E-Government.  Email.  E-Payment  E-Business.

47  _______ it deals with conducting the transactions with the help of mobile.  M-Commerce.  E-Commerce.  E-Business.  E-Transaction.  M-Commerce.
48  Compared to Internet users, the number of cell phone subscribers is _________.  about the same.  slightly fewer.  much fewer.  much larger.  much larger.
49 The world wide web was developed in the decade of the _______  1960s  1970s  1980s  1990s  1990s
50  _____________is used to transfer files on World Wide We  HTML.  XLS.  HTTP.  DO  HTTP.

51  EFT stands for  Electronic Fund Transfer.  Electronic Finance
Transmission.

 Emerging Fund Transaction.  Emerging Financial Technique.  Electronic Fund Transfer.

52   ___________ is a kind of "address" that is unique to each resource on the we  Uniform Resource Identifier.  Mail I  Server name.  client name.  Uniform Resource Identifier.

53  After sending e-mail, which of the following activities is most common among Internet users?  sending instant messages.  reading someone else's
blog.

 using a search engine to find
information.

 getting news.  using a search engine to find
information.

54  The most prevalent online payment method is ______.  PayPal.  checks.  credit cards.  debit.  credit cards.
55 The best products to sell in B2C e-commerce are_______  Small products  Digital products  Speciality products  Fresh products  Digital products
56  _________is a collection of information stored on the networked computers over the worl  WEB  INTERNET.  NETWORK.  EXTRANET.  WEB
57  The __________ is any computer process that requests services from the server.  object.  user.  hardware.  client.  client.
58  The most popular type of media in terms of total hours of consumption per year is _____.  television.  radio.  Internet.  newspaper.  television.
59  The top U.S online video site is ______.  MySpace.  YouTube.  AOL.  Google Video.  YouTube.

60  Which of the following is an advantage of e-books?  reduced transaction costs for the
user.

 requirement of
expensive devices to use.

 portability compared to print books.  copyright management.  reduced transaction costs for the
user.
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POSSIBLE QUESTIONS 

Part  A (1 MARK) 

(Online Examinations) 

Part  B (2 MARKS) 

 

1. What is a protocol? 

2. What is Web Browser? 

3. What is spam? 

4. Give two uses of Bus topology 

5. Define topology 

6. What is a Network 

7. List out the types of network 

8. What is Dial UP connection 

9. What is a search engine? 

10. What do you know about password policy? 

 

Part C (8 MARKS) 

1. Explain the advantages and limitations of E-Commerce 

2. Explain network topologies with a neat diagram 

3. What is E-mail?Explain the advantages and limitations of E-mail 

4. Explain the types of network with example. 
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5. List out the difference between reply and forward an E-mail 

6. Explain OSI layers with a neat diagram 

7. Explain conferencing in detail? 

8. Explain the types of Network topologies 

9. Explain the following 

i. Group communication 

ii. Bandwith 

iii. Modem 

 

10. Explain the Network Architecture in detail. 
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INSTRUCTION TO INFORMATION TECHNOLOGY   
 

PART –A (20*1=20 Marks)  
Multiple choice Questions  

1.b. Software  

2. d.RAM 

3. a.Arithmetic Logic Unit     

4.b. Wide Area Network 

5. d. Magnetic Ink Character Reader  

6. d. Central Processing Unit 

7. c.Cache   

8. a.All Input, Output and processing.    

9. a.Universal Serial Bus      

10. d. Input 

11. b.Software                          

12. d.RAM 

13. b.Storage                          

14.c.Printer                  

15.c.Program                 

16.c.Speaker                 

17.b.ROM                       

18.c.Keyboard                

19.b.Compressing the message  

20.c.Silicon  

 

 



 

PART –B (5*2=10 Marks)  

Answer All the question 

21. Define Computer. 

A computer is an electronic data processing device, which accepts and stores data 

input, processes the data input, and generates the output in a required format.If we look at it 

in a very broad sense, any digital computer carries out the following five functions: 

Step 1 - Takes data as input. 

Step 2 - Stores the data/instructions in its memory and uses them as required. 

Step 3 - Processes the data and converts it into useful information. 

Step 4 - Generates the output. 

Step 5 - Controls all the above four steps. 

 

 

 

22. What are the elements of computer? 

A computer system consists of hardware, the physical unit (parts) of the computer 

that are capable of computing and manipulating information and software (set of instructions 

or programs) that carries out predefined tasks to complete a given job. The computer 

performs operations like addition, subtraction, multiplication and division only when the user 

instructs it to do so. The user issues instructions and the CPU acts in accordance with the 

instructions. The sets of instructions, which control the sequence of operations, are known as 

programs, and collectively programs are called software. 

 

  



23. What do you mean by operating system? 

An  operating system (OS) is system software that manages computer hardware and 

software         resources and provides common services for computer programs. 

             

PART –C (5*6=30 Marks) 

Answer All the question 

24. a.Explain the components of computer 

COMPONENTS OF COMPUTER SYSTEM 

  A computer system is a combination of various components. It performs the 

system functions such as input, processing, output, storage and control. A computer system 

consists of the following components: 

 1. Hardware  

2. Software  

3. Human ware  

4. Firmware  

5. Bridge ware  

 

1. Hardware : The physical components of the computer, such as electrical, electronics and 

mechanical unit are known as the hardware of the computer. That is, the input units, output 

units and CPU are called hardware. Thus hardware is the equipment involved in the function 

of a computer. It consists of the components that can be physically handled. The function of 

these components is typically divided into three main categories: input, output, and storage. 

Components in these categories connect to microprocessors, output and storage. Components 

in these categories connect to microprocessors, specifically, the computer's central processing 

unit (CPU), the electronic circuitry that provides the computational ability and control of the 

computer, via wires or circuitry called a bus. 

 2. Software: The computer performs operations like addition, subtraction, multiplication and 

division only when the user instructs it to do so. The user issues instructions and the CPU acts 

in accordance with the instructions. The sets of instructions, which control the sequence of 

operations, are known as programs, and collectively programs are called software. The 

software can be broadly classified into two types.  They are:  

  

OPERATING  
SYSTEM 

 
 USER COMPUTER 

HARDWARE 



a. System Software  

b. Application software  

3. Human ware: The man-machine interface is called a human ware. The people who work 

with the computer are collectively called the human ware or livewire. 

 4. Firmware: The computer programs permanently stored in ROM or PROM are called 

firmware. These programs are provided by hardware manufacturer along with the computers. 

Generally these are booting programs which help in the starting of a computer. Such 

programs cannot be erased or overwritten. 

 5. Bridge ware: The computer components and programs used to translate instructions and 

information written for one type of computer into a format that another type of computer can 

understand is called bridge ware. This is necessary because different computers are made by 

different manufacturers. 

 

 b.What is input? Explain the output devices. 

 

Following are some of the important input devices which are used in a computer: 

 Keyboard 

 Mouse 

 Joy Stick 

 Light pen 

 Track Ball 

 Scanner 

 Graphic Tablet 

 Microphone 

 Magnetic Ink Card Reader (MICR) 

 Optical Character Reader (OCR) 

 Bar Code Reader 

 Optical Mark Reader (OMR) 

 

Keyboard 

Keyboard is the most common and very popular input device which helps to input data to the 

computer. The layout of the keyboard is like that of traditional typewriter, although there are 

some additional keys provided for performing additional functions. 



Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 

108 keys are also available for Windows and Internet. 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-control device havinga 

small palm size box with a round ball at its base, which senses the movement of the mouse 

and sends corresponding signals to the CPU when the mouse buttons are pressed. Generally, 

it has two buttons called the left and the right button and a wheel is present between the 

buttons. A mouse can be used to control the position of the cursor on the screen, but it cannot 

be used to enter text into the computer. 

Advantages 

 Easy to use 

 Not very expensive 

 Moves the cursor faster than the arrow keys of the keyboard 

Joystick 

Joystick is also a pointing device, which is used to move the cursor position on a monitor 

screen. It is a stick having a spherical ball at its both lower and upper ends. The lower 

spherical ball moves in a socket. The joystick can be moved in all four directions. 

The function of the joystick is similar to that of a mouse. It is mainly used in Computer 

Aided Designing (CAD) and playing computer games. 

Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a displayed menu item 

or draw pictures on the monitor screen. It consists of a photocell and an optical system 

placed in a small tube. When the tip of a light pen is moved over the monitor screen and the 

pen button is pressed, its photocell sensing element detects the screen location and sends the 

corresponding signal to the CPU. 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop computer, instead 

of a mouse. This is a ball which is half inserted and by moving fingers on the ball, the 

pointer can be moved.Since the whole device is not moved, a track ball requires less space 

than a mouse. A track ball comes in various shapes like a ball, a button, or a square. 

Scanner 

Scanner is an input device, which works more like a photocopy machine. It is used when 

some information is available on paper and it is to be transferred to the hard disk of the 



computer for further manipulation. Scanner captures images from the source which are then 

converted into a digital form that can be stored on the disk. These images can be edited 

before they are printed. 

 

Magnetic Ink Card Reader (MICR) 

MICR input device is generally used in banks as there are large number of cheques to be 

processed every day. The bank's code number and cheque number are printed on the 

cheques with a special type of ink that contains particles of magnetic material that are 

machine readable. 

This reading process is called Magnetic Ink Character Recognition (MICR). The main 

advantages of MICR is that it is fast and less error prone. 

Optical Character Reader (OCR) 

OCR is an input device used to read a printed text. OCR scans the text optically, character by 

character, converts them into a machine readable code, and stores the text on the system 

memory. 

Optical Mark Reader (OMR) 

OMR is a special type of optical scanner used to recognize the type of mark made by pen 

or pencil. It is used where one out of a few alternatives is to be selected and marked. It is 

specially used for checking the answer sheets of examinations having multiple choice 

questions. 

 

OUTPUT DEVICES: 

 Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 

 Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output device of 

a computer. It forms images from tiny dots, called pixels that are arranged in a rectangular 

form. The sharpness of the image depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 



 

Cathode-Ray Tube (CRT) Monitor:  

The CRT display is made up of small picture elements called pixels. The smaller the 

pixels,the better the image clarity or resolution. It takes more than one illuminated pixel to 

form a whole character, such as the letter ‘e’ in the word help. 

A finite number of characters can be displayed on a screen at once. The screen can be 

divided into a series of character boxes - fixed location on the screen where a standard 

character can be placed. Most screens are capable of displaying 80 characters of data 

horizontally and 25 lines vertically. 

There are some disadvantages of CRT: 

 Large in Size 

 High power consumption 

Flat-Panel Display Monitor:  

The flat-panel display refers to a class of video devices that have reduced volume, weight and 

power requirement in comparison to the CRT. You can hang them on walls or wear them on 

your wrists. Current uses of flat-panel displays include calculators, video games, monitors, 

laptop computer, and graphics display. 

The flat-panel display is divided into two categories: 

Emissive Displays - Emissive displays are devices that convert electrical energy 

into light. For example, plasma panel and LED (Light-Emitting Diodes). 

Non-Emissive Displays - Non-emissive displays use optical effects to convert 

sunlight or light from some other source into graphics patterns. For example, LCD 

(Liquid-Crystal Device). 

Printers 

Printer is an output device, which is used to print information on paper. 

There are two types of printers: 

 Impact Printers 

 Non-Impact Printers 

 

Impact Printers 

Impact printers print the characters by striking them on the ribbon, which is then pressed on 

the paper. 

 Characteristics of Impact Printers are the following: 



 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 

 There is physical contact with the paper to produce an image 

 These printers are of two types - 

 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at a time. 

These are further divided into two types: 

 Dot Matrix Printer (DMP) 

 Daisy Wheel 

Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. These printers are 

popular because of their ease of printing and economical price. Each character printed is 

in the form of pattern of dots and head consists of a Matrix of Pins of size (5*7, 7*9, 9*7 

or 9*9) which come out to form a character which is why it is called Dot Matrix Printer. 

Advantages 

 Inexpensive 

 Widely Used 

 Other language characters can be printed 

Disadvantages 

 Slow Speed 

 Poor Quality 

Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are like petals of Daisy 

(flower) which is why it is called Daisy Wheel Printer. These printers are generally used 

for word-processing in offices that require a few letters to be sent here and there with 

very nice quality. 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 



Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

Non-impact Printers:  

Non-impact printers print the characters without using the ribbon. These printers print a 

complete page at a time, thus they are also called as Page Printers. 

These printers are of two types - 

 Laser Printers 

 Inkjet Printers 

Characteristics of Non-impact Printers 

 Faster than impact printers 

 They are not noisy 

 High quality 

 Supports many fonts and different character size 

Laser Printers 

These are non-impact page printers. They use laser lights to produce the dots needed to 

form the characters to be printed on a page. 

Advantages 

 Very high speed 

 Very high quality output 

 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a single printing 

 

Inkjet Printers 

Inkjet printers are non-impact character printers based on a relatively new technology. 

They print characters by spraying small drops of ink onto paper. Inkjet printers produce 

high quality output with presentable features. They make less noise because no hammering is 

done and these have many styles of printing modes available. Color printing is also possible. 

Some models of Inkjet printers can produce multiple copies of printing also. 



Advantages 

 High quality printing 

 More reliable 

Disadvantages 

 Expensive as the cost per page is high 

 Slow as compared to laser printer. 

25.a.Describe the types of hardtware. 

Or 

 b.Explain the storage devices with suitable example. 

 

STORAGE  DEVICES: 

There are two types of storage devices. 

 a. Primary storage device  

b. Secondary Storage device. 

 

 a. PRIMARY STORAGE DEVICE OR RANDOM ACCESS MEMORY [RAM]: 

Primary storage is usually referred to as Random Access Memory [RAM] because it is 

possible to randomly select and use any location of this memory to directly store and retrieve 

data and instructions. It is also referred to as read/write memory because information can be 

‘read’ from a RAM chip also be ‘written’ into it. The Random Access Memory requires some 

times for accessing data and is considered to be the fastest memory. Each bit in a RAM stores 

information by means of electric charge, where the presence of an electric charge indicates 

‘1’ and the absence of an ‘0’. RAM is called Temporary storage, because data persists until 

the machine is on. 

 ROM : A Read Only Memory [ROM] is one in which information is permanently stored. 

The information from the memory can only be read and it is not possible to write fresh 

information into it. This is the reason why it is called ROM. When the power supply is 

switched off, the information stored inside ROM is not lost as it is in the case of a RAM chip. 

ROMs are mainly used by computer manufacturers for storing the micro programs so that 

they cannot be modified by the users.  

b. SECONDARY STORAGE DEVICES : 

 



This section of the memory is also referred to as backup storage because it is used to store 

large volume of data on a permanent basis which can be partially transferred to the primary 

storage as and when required for processing. The storage capacity of the primary storage of 

today’s computers is not sufficient to store the large volume of time handled by most data 

processing centres. As a result, additional memory, called auxiliary memory or secondary 

storage, is used with most computer systems. Hard Disk, Floppy Disk, Tape and Compact 

Disc are the main secondary storage devices. 

I) Hard Disk: The hard disk used in the PC is permanently fixed, hard disks with storage 

capacities of 8 GB, 10GB, 20GB, 40GB, are quite common, the CPU can use the hard disk to 

load programs and data as well as to store data We should operate the PC within a dust-free 

and cool room (Preferably air-conditioned) to prevent hard disk crash. 

ii). Floppy Disk:  Floppy disk is flexible circular disk of diameter 3.inches made of plastic 

coated with a magnetic material. This is housed in a square plastic jacket. The floppy disk can 

store 1.4 Mbytes of data [also called 1.44Mnytes, since it holds 1440Kytes]. Data recorded on 

a floppy disk is read and stored in a computer’s memory by a device called a floppy disk 

drive[FDD]. A floppy disk is inserted in a slot of the FDD. Some of the floppies have limited 

life time. The floppies have to be recycled periodically to keep them alive. A frequently 

recycled floppy. [i.e used] will have a life time of 3to 4 years to do recycling take out old 

floppies occasionally and try to read them once, at least the directory. 

iii). Compact Disk: CD-ROM [Compact Read Only Memory] uses a laser beam to record 

and read data along spiral tracks on a 51/4’’ disk. A disk can store around 650/00MB of 

information. CD-ROMs are normally used to store data as back up. Using a CD Writer, lot of 

information can be written on CD-ROM and stored for future reference. 

iv). Tape Drives: Even though tape drives are one of the oldest of storage technologies, they 

can still hold the most data on a single cartridge. A computer tape drive works similar to a 

tape recorder or a VCR. A plastic tape ribbon is coated with magnetic particles which are 

polarized by a magnetic field generated by the read/write head. Since tape is a sequential, and 

not a random- access media, a tape drive has to wind through a tape to locate a specific bit of 

data. This makes accessing data slow so tape is mainly used for system backups and regular 

archiving of files and records. Tape dives allow users to backup large amounts of data. Tape 

drives are capable of backing up a couple hundred megabytes to several gigabytes of 

information without having to spend large sums of money on disks.  

iv). DLT [Digital Linear Tape] :DLT drives are a robust and durable medium. The DLT 

segments the tape into parallel horizontal tracks and records data by streaming the tape across 



a single stationary head. Released in 1991 DLT drives are very reliable, high-speed, and 

high-capacity making the DLT drives an excellent use for Network backups. 

v). Micro Vault USB Storage Media: 

Micro Vault media plugs directly into the computer’s SB port – and acts just like another 

drive. It is small, light, Shock-proof and moisture – proof. This nifty flash memory storage 

device is compact and durable enough to carry in any pocket. The device is recognized 

automatically when we connect it to the computer. By connecting it via USB, the files can be 

transferred by dragging and dropping. There are no cables or adaptors needed, no power cord 

and no driver software to install. It’s compatible with both Macintosh and Windows operating 

systems, and even comes with software that password protects the contents of the device. 

Micro Vault They are perfect for sharing PowerPoint presentations, digital photos, MPEG 

video and MP3s, transporting files between work and home, or sharing files with friends and 

colleagues. 

 

26.a.What are the characteristics of computer? Explain. 

 

CHARACTERISTICS OF COMPUTERS: 

 The main characteristics of computers are:  

a) Speed  

b) Storage  

c) Accuracy  

d) Versatility  

e) Automation  

f) Diligence  

g) Reliability  

 

a) Speed : Computers are capable of carrying out the task with enormous speed. Today’s 

computers, according to their class, can perform from 4 MIPS (Millions of instructions per 

second) to 100 MIPS. What may take days for manual calculations may take only a few hours 

for computers to perform. Inside the computer the information signal travels at incredible 

electronic speed.  

b) Storage: Computers can store enormous quantity of information. Which is expressed in 

terms of Kilobytes (or) Mega Bytes (MB) or Gega Bytes (GB). It is achieved through its 

‘Main memory’ or ‘Primary storage’ and through ‘auxiliary storage’ or ‘Secondary storage’. 



The Hard disks Floppy disk, Compact Disc(CD) and Magnetic Tape storage are examples of 

secondary storages. These large volumes of storage occupy much lesser space compared to 

paper documents and this aspect of computers makes them more powerful. 

 c) Accuracy: The accuracy of a Computer is consistently high. In fact, this quality of the 

computers make them indispensable in various fields such as Scientific Research, Space 

Research, Weather Predictions and many other areas where precision of a high order is 

required. The accuracy of the computer is best achieved by programming them in the most 

efficient manner. When it comes to very complex mathematical or scientific problem the 

computer’s accuracy has no substitute.  

d) Versatility: Computers are versatile in that they can perform almost any task, provided 

they are given the appropriate logical steps. For example, they are capable of performing 

wide ranging tasks such as construction of a payroll, inventory management in a factory, 

hotel billing, hospital management, banking applications and any imaginable task in every 

walk of life.  

e) Automation: The biggest advantage of computers is that it is automatic in its operation. 

Once a programming logic is initiated the computer performs repeated operations without 

human interventions until program completion. 

 f) Diligence: Computers are machines and that do not get tired or ‘lose concentration’ like 

human beings. If a large number of calculations say million calculations are to be performed 

the resultant output will remain exactly the same even if operations are repeated any number 

of times. But when a human being is asked to do the same job this consistency cannot be 

achieved. Thus for those who want consistent and continuous standard output, computer’s 

‘diligence’ is of great help.  

g) Reliability: The computers give very accurate results with predetermined values. They 

correct and modify the parameters automatically, giving suitable signals. They give formatted 

results with high degree of precisions. 

 

b.classify the operating system  

TYPES OF OPERATING SYSTEM: 

There are Many Operating Systems those have be Developed for Performing the Operations 

those are requested by the user. There are Many Operating Systems which have the 

Capability to Perform the Requests those are received from the System. The Operating 

http://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system


system can perform a Single Operation and also Multiple Operations at a Time. So there are 

many types of Operating systems those are organized by using their Working Techniques. 

A) DESKTOP OPERATING SYSTEM 

The control program in a user's machine (desktop or laptop). Also called a "client operating 

system," Windows is the overwhelming majority while the Macintosh comes second. There 

are also several versions of Linux for the desktop. 

B) SERVER OPERATING SYSTEM: 

A server operating system, also called a server OS, is an operating system specifically 

designed to run on servers, which are specialized computers that operate within a 

client/server architecture to serve the requests of client computers on the network. The server 

operating system, or server OS, is the software layer on top of which other software 

programs, or applications, can run on the server hardware. Server operating systems help 

enable and facilitate typical server roles such as Web server, mail server, file server, database 

server, application server and print server. 

C) MAINFRAME OPERATING SYSTEM: 

Mainframe operating systems are sophisticated products with substantially different 

characteristics and purposes. The architecture is distinct from the physical design, and, in 

fact, different machine designs might conform to the same computer architecture. In a sense, 

the architecture is the computer as seen by the user, such as a system programmer. For 

example, part of the architecture is the set of machine instructions that the computer can 

recognize and execute. In the mainframe environment, the system software and hardware 

comprise a highly advanced computer architecture, the result of decades of technological 

innovation. 

D) MULTIUSER OPERATING SYSTEM:  A multi-user operating system extends the basic 

concept of multi-tasking with facilities that identify processes and resources, such as disk 

space, belonging to multiple users, and the system permits multiple users to interact with the 

system at the same time. 

E) MULTIPROCESSING OPERATING SYSTEM: The Multi-processing Operating Systems 

never use any cards because the Process is entered on the Spot by the user. But the Operating 

System also uses the Process of Allocation and De-allocation of the Memory Means he will 

provide the Memory Space to all the Running and all the Waiting Processes. There must be 

the Proper Management of all the Running Jobs. 



F) MULTITASKING OPERATING SYSTEM:A multi-tasking operating system allows more 

than one program to be running in concurrency. This is achieved by time-sharing, dividing 

the available processor time between multiple processes that are each interrupted repeatedly 

in time slices by a task-scheduling subsystem of the operating system. Multi-tasking may be 

characterized in preemptive and co-operative types. 

G) MULTITHREADING OPERATING SYSTEM:It allows different parts of a single 

program to run concurrently.Multithreaing is an ability of an operating system to execute 

different parts of a program called threads. 
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PART –A (20*1=20 Marks) 
Multiple choice Questions 

1. Rent outstanding is 
(a) liability (b) an asset (c) an income (d) Receivable 

2. Closing stock is shown in 
(a) Profit and loss account (b) Trading account and Balance sheet  
(c) Purchases                                      (d) Net profit or Net loss account 

3. Opening stock is shown in 
(a) Balance sheet (b) Profit and Loss account 
(c) Trading account                         (d) Sales 

4. Gross Profit is transferred to 
(a) Capital account (b) Profit and loss account 
(c) Balance sheet                                (d) Trading account 

5. Nominal account having debit balances represents 
(a) income/gain (b) expenses/losses (c) liability (d) invoice book 

6. Gross Profit is transferred to 
(a) Capital account   (b) Profit and loss account  
(c) Balance sheet         (d) Trading account 

7. Interest on capital is added to 
(a) Expense A/c (b) Income A/c  
(c) Capital A/c (d) Asset Account 

8. Interest on drawings is deducted from 
(a) Income A/c             (b) Capital A/c 
(c) Expense A/c (d) Profit and Loss account 

9. Hire purchase price – cash price = ________. 
(a) Total interest (b) first balance (c) total amount d) cash balance 

10. If the hire purchaser fails to make payment of any installment, it is called 
_______payment. 
(a) Installment price (b) hire price c) default d) cash price 

11. The hire vendor has the right to take array the goods sold on hire purchase in the 
event of default is termed as ________. 

 

(a) Default (b) Repossession (c) default and repossession (d) Fault 
 

12. The hire vendor may take away all the goods on which there is default of installment 
is known as _______. 
(a) Complete repossession (b) partial repossession 
(c) Repossession (d) get back 



13. Opening stock is shown in 

(a) Balance sheet (b) Profit and Loss account (c) Trading account (d) Sales 

14. Under the diminishing balance method, depreciation is calculated on_________ 

(a) Scrap value (b) On original value (c) On book value (d) Cost value 

15. The amount of depreciation charged on machinery will be debited _________ 

(a) Machinery a/c (b) Depreciation account (c) Cash account (d) Repair account 

16. Loss on sale of plant and machinery should be written off against_________ 

(a) Share premium (b) Depreciation fund account (c) Sale account (d) Profit & loss account 

17. The Profit and Loss account shows 
(a) Financial position of the concern              (b) Net profit or Net loss 
(c) an asset (d) Gross profit or Gross Loss 

18. Returns inwards are deducted from 
(a) Purchases   (b) Sales (c) Returns outward (d) Cash book 

19. Hire purchase act was passed in the year _______. 
(a)1980 (b)1978 (c)1975 (d)1972 

20. In hire purchase system, for paying down payment ________ A/c is debited. 
(a) hire vendor (b)hirer (c)cash (d)assets 

 

PART –B (3*2=6 Marks) 
Answer all the Questions 

21. What is Outstanding Expense?  
Expenses which have been incurred but not yet paid during the accounting period for which the 
final accounts are being prepared are called as outstanding expenses. 
Outstanding expenses will be shown 
i) On the debit side of Profit and Loss account by way of additions to the particular expenses 
and 
ii) On the liabilities side of the Balance Sheet. 
 
22. What is Hire Purchase? 
A hire purchase is a method of buying goods through making installment payments over time. 
The term "hire purchase" originated in the United Kingdom and is similar to rent-to-own 
arrangements in the United States. Under a hire purchase contract, the buyer is leasing the goods 
and does not obtain ownership until the full amount of the contract is paid. 
 
23. What is instalment purchase? 
Purchasing a commodity over a period of time. The buyer gains the use of the commodity 
immediately and then pays for it in periodic payments called installments. 
 
 
 
 
 
 
 
 
 
 
 
 



PART –C (3*8=24 Marks) 
Answer all the Questions 

 
24. (a) From the following balances as at 31st December 1994 of trader, prepare a 
Trading and Profit & loss A/c for the year 1994 and a Balance Sheet as on that date: 

Debit Balances Amount 
Rs. 

Credit Balances Amount 
Rs. 

Salaries 5,500 Creditors 9,500 

Rent 1,300 Sales 32,000 

Cash 1,000 Capital 30,000 

Debtors 40,000 Loans 10,000 

Trade expenses 600   

Purchases 25,000   

Advances 2,500   

Bank balance 5,600   

 81500  81500 
Adjustments: 
(i) The closing stock amounted to Rs. 9,000. 
(ii) One month’s Salary is outstanding. 
(iii) One month’s rent has been paid in advance. 
(iv) Provide 5% for doubtful debts. 
 

Trading and Profit and Loss Ac of a Trader for the year ended as on 31-12-1994 

Particulars Amount Amount Particulars Amount Amount 

Rs. Rs. Rs. Rs. 

To Purchases   25000 By Sales   32000 

      By Closing Stock   9000 

To Gross Profit C/d    16000       

            

    41000     41000 

            

To Trade expenses   600 By Gross Profit B/d   16000 

To Salaries 5500         

Add: Outstanding Salaries 500 6000       

            

To Rent 1300         

Less: Rent paid in Advance 118 1182       

            
To Provision for Bad and 
Doubtful debts   2000       

            

To Net Profit C/d   6218       

            

    16000     16000 
 



Balance Sheet a Trader as on 31-12-1994 

Liabilities Amount Amount Assets Amount Amount 

Rs. Rs. Rs. Rs. 

Capital 30000   Bank Balances   5600 

Add: Net Profit 6218 36218 Cash   1000 

Creditors   9500 Debtors 40000   

Loans   10000 
Less: Provision for Bad and 
Doubtful debts 2000 38000 

      Advances   2500 

Outstanding Salaries   500 Rent paid in Advance   118 

      Closing Stock   9000 

            

            

    56218     56218 
 

(Or) 
(b) On 1-1-86, X purchased Machinery on hire purchase system. The payment is to be 
made Rs.4,000 down (on signing of the contract) and Rs.4,000 annually for three 
years. The cash price of the machinery is Rs.14,900 and the rate of interest is 5%. 
Calculate the interest in each year’s instalment. 
Solution: 

Particulars 
Total cash 

price 
Instalment 

paid Interest paid 
cash price 

paid 

1 2 3 4 5(3-4) 
Rs Rs Rs Rs Rs 

cash price 14900       
down 
payment 4000 4000   4000 

  10900       

1st instalment 3455 4000 545 3455 

  7445   (10900*5%)   
2nd 
instalment 3627.75 4000 372.25 3627.75 

  3817.25   7445*5%)   

3rd instalment 3817.25 4000 182.75 3817.25 

      (4000-3817.25)   

  Nil 16000 1100 14900 
 

25. (a) X purchased a machine under hire purchase system. According to the terms of the 
agreement Rs.40, 000 was to be paid on signing of the contract. The balance was to 
be paid in four annual instalments of Rs.25, 000 each plus interest. The cash price 
was Rs.1, 40,000. Interest is chargeable on outstanding balance at 20% per annum. 
Calculate interest for each year and the instalment amount. 

 
 
 
 



Solution: 
 

Date of 
payment 

Total cash 
price 

Instalment 
paid Interest paid 

Cash price 
paid 

  Rs Rs Rs Rs 

1 2 3=4+5 4 5 

  140000       

down payment 40000 40000   40000 

  100000 45000 (100000*20%) 25000 

1st instalment 25000   20000   

  75000 40000 (75000*20%) 25000 
2nd instalment 25000   15000   

  50000   (50000*20%) 25000 

3rd instalment 25000 35000 10000   

  25000   (25000*20%) 25000 

4th instalment 25000 30000 5000   

  Nil 190000 50000 140000 
 

(Or) 
(b) Distinguish between Hire Purchase System and Instalment Purchase system. 

DIFFERENCE BETWEEN HIRE-PURCHASE SYSTEM AND INSTALMENT PAYMENT 

SYSTEM 

Instalment Payment System is system of purchase and sale of goods in which title of goods is 

immediately transferred to the purchaser at the time of sale of goods and the sale price of the goods 

is paid in instalments. In the event of default in payment of any instalment, the seller has no right to 

take back goods from the possession of the purchaser. He can file a suit for the recovery of the 

outstanding balance of the price of goods sold. The followings are the differences between Hire-

purchase system and Instalment payment system: 

 In Hire-purchase system, the transfer of ownership takes place after the payment of all 

instalments while in case of Instalment payment system, the ownership is transferred 

immediately at the time of agreement. 

 In Hire-purchase system, the hire-purchase agreement is like a contract of hire though later on it 

may become a purchase after the payment of last instalment while in Instalment payment 

system, the agreement is like a contract of credit purchase. 

 In case of default in payment, in Hire-purchase system the vendor has a right to back goods from 

the possession of the hire-purchaser while in case of Instalment payment system, the vendor has 

no right to take back the goods from the possession of the purchaser; he can simply sue for the 

balance due. 

 In Hire-purchase system, if the purchaser sells the goods to a third party before the payment of 

last instalment, the third party does not get a better title on the goods purchased. But in case of 

Instalment payment system, the third party gets a better title on the goods purchased. 



In Hire-purchase system the provisions of the Hire-purchase Act apply to the transaction while in 
case of Instalment payment system, the provisions of Sale of Goods Act apply to the transaction. 
 

26. (a )The following are the balances extracted from the books of Mrs.Nandhini as on 
31.03.2002. 

 

Debit Balances Rs. Credit Balances Rs. 

Drawings 

Cash in Hand 

40,000 

17,000 

Capital 

Sales 

2,00,000 

1,60,000 

Cash at Bank 

Wages Purchases 

Stock (1.4.2001) 

Buildings Sundry 

Debtors Bills 

Receivable Rent 

Commission 

General Expenses 

Furniture 

65,000 

10,000 

20,000 

60,000 

1,00,000 

44,000 

29,000 

4,500 

2,500 

8,000 

5,000 

Sundry Creditors 45,000 

4,05,000 4,05,000 

 
Adjustments: 
1. Closing stock Rs.40,000 
2. Wages yet to be paid Rs.1,000  
3. Rent Prepaid Rs.900 
Prepare Trading and Profit and Loss Account and Balance sheet as on 1.3.2002. 

 
Solution: 

Trading and Profit and Loss Account of Mrs.Nandhini for the year ended as 
on 31.03.2002 

Particulars RS Rs Particulars RS RS 

To Opening Stock   60,000 By Sales   1,60,000 

To Purchases   20,000 By Closing stock   40,000 

To Wages 10,000         
Add: Outstanding 
wages 1,000 11,000       
            

To Gross Profit c/d   1,09,000       

    2,00,000     2,00,000 

            

To Rent 4,500   
By Gross Profit 
b/d   1,09,000 

Less: Prepaid Rent 900 3,600       
To Commission   2,500       



To General Expenses   8,000       

            

To Net profit c/d   94,900       

    1,09,000     1,09,000 
 

Balance Sheet of Mrs.Nandhini as on 31.03.2002 

Liabilities RS RS Assets RS RS 

Capital 2,00,000   Cash in hand   17,000 

Add: Net Profit 94,900   Cash at bank   65,000 
  2,94,900   Buildings   1,00,000 

Less: Drawings 40,000 2,54,900 Furniture   5,000 

Sundry Creditors   45,000 Bills Receivable   29,000 
Wages Outstanding   1,000 Sundry Debtors   44,000 

      Closing Stock   40,000 

      Prepaid Rent   900 

    3,00,900     3,00,900 
 

(Or) 
(b) From the following Trial Balance of Senthur Traders, prepare Trading and Profit 

& Loss Account for the year ending December 31, 2006 and Balance sheet as on 
that date: 

 

Dr. Balance Rs. Cr. Balance Rs. 
Land & Building 60,000 Capital 96,000 
Plant and Machinery 33,000 Sundry Creditors 15,000 
Stock 12,000 Sales 60,000 

 

Investment 
 

15,000 
Provision for Bad & Doubtful 
Debts 

 

1,100 

Purchases 45000 Loan 20,000 
Wages 2000 Rent Received in advance 1,000 
Carriage 2000 Commission Received 3,000 
Salary 5000 Bills payable 15,000 
Rent 2,000   

Cash at Bank 3000   

Sundry Debtors 30,000   

Discount 300   

Bad Debt 500   

Sales Returns 1300   

 2,11,100  2,11,100 
 
 

Additional Information: 
1. Closing stock valued at Rs. 12,000. 
2. Bad Debt 500 and Provision for Bad & Doubtful Debts at 5%. 
3. Salary outstanding Rs. 1000. 
4. Commission Received in advance 1,000. 
5. Depreciate Machinery @ 3% & land and Builders @ 2%. 

 
 



Solution: Trading and profit and Loss A/c of Senthur Traders for the year ending as on 31-12-

2006 

Particulars Amount Amount Particulars Amount Amount 

  Rs. Rs.   Rs. Rs. 

To Opening Stock   12000 By Sales 60000   

To Purchases   45000 Less: Sales Returns 1300 58700 

To Wages   2000 By Closing Stock   12000 

To Carriage   2000       

            

To Gross Profit C/d   9700       

            

    70700     70700 

            

To Salary 5000   By Gross Profit B/d   9700 

Add: Salary 1000 6000 By Commission Received 3000   

To Rent   2000 
Less: Commission  
Received in Advance 1000 2000 

To Discount   300 

 
By Rent Received in 
Advance   1000 

To Bad Debts 500         

Add: Bad Debts 500         

  1000         
Add: Provision for Bad 
and Doutful Debts 1475         

  2475         
Less: Provision for Bad 
and Doutful Debts 1100 1375       

To Depreciation:           

        Plant and Machinery 990         

        Land abd Building 1200 2190       

            

To Net Profit C/d   835       

            

    12700     12700 
 

Balance Sheet of Senthur Trader as on 31-12-2006 

Liabilities Amount Amount Assets Amount Amount 

  Rs. Rs.   Rs. Rs. 

Capital 96000   Cash at Bank   3000 

Net Profit 835   Investment   15000 

    96835 Sundry Debtors 30000   

Outstanding Salary   1000 Less: Bad Debts 500   



Loan   20000   29500   
Commission Received in 
Advance   1000 

Less: Provision for Bad 
and Doubtful Debts 1475 28025 

Bills Payable   15000       

Sundry Creditors   15000 Land and Building 60000   

      Less: Depreciation 1200 58800 

            

      Plant and Machinery 33000   

      Less: Depreciation 990 32010 

      Closing Stock   12000 

            

            

            

    148835     148835 
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Answer keys 

Part A 

1. Commission 

2. Sales 

3. Consignor 

4. Normal Loss 

5. Nominal  

6. Premium method 

7. Full amount of policy 

8. Short 

9. Unavoidable 

10. Normal profit 

11. Average profit 

12. Super profit 

13. Normal profit 

14. Consignor’s personal a/c  

15. Nominal a/c 

16. Loss on account of bad debts 

17. Consignment  

18. Total sales 

19. Debited to capital a/c 

20. Credited  

 

Part B 

Answer keys 

21. Average profit= Total profit/ No. of years 

Normal profit= Capital employed x normal rate of return 

Super profit = Average profit - Normal profit 

Good will= Average profit*No. of year purchase 

 

22. Consignment is a business arrangement in which a business, also referred to as a 

consignee, agrees to pay a seller, or consignor, for merchandise after the item sells. 



Consignment businesses are typically retail stores that specialize in a particular type of 

consumer product. The business accepts items for sale and agrees to pay the seller a 

percentage of the proceeds if and when the goods do sell. 

23. A joint venture (JV) is a business arrangement in which two or more parties agree to pool 
their resources for the purpose of accomplishing a specific task. In a joint venture (JV), 
each of the participants is responsible for profits, losses and costs associated with it. 

 

Part C 

Answer Keys 

24 a) Answer key: 

Journal Enteries in the Books of Kumaran (Consignor) 

 Consignment to Bombay A/c Dr.  20,000 

  To goods sent on consignment A/c  20,000 

 Consignment to Bombay A/c Dr.  500  

  To bank a/c      500 

 Bills Receivable a/c Dr   10,000 

  To Gokale a/c      10,000 

 Bank a/c Dr     9850 

 Discount A/c Dr    150 

  To Bills Receivable a/c    10,000 

 Gokale A/c Dr     24,800 

  To consignment to Bombay a/c   24,800 

 Consignment to Bombay a/c Dr  750 

  Gokale A/c     750 

 Consignment to Bombay a/c Dr  1,488 



  Gokale A/c      1,488 

 Bank a/c Dr     12,562 

  To Gokale a/c     12,562 

 Consignment to Bombay a/c Dr  2,062  

  To P&L a/c     2,062 

 Goods sent to consignment A/c Dr  20,000 

  To Purchases A/c     20,000  

Journal Entries in the books of Gokale (consignee) 

 Kumaran A/c Dr    10,000 

  To Bills Payable A/c    10,000 

 Bank a/c Dr     24,800 

  To kumaran a/c    24,800 

 Kumaran A/c Dr    750 

  To Bank A/c      750 

 Kumaran A/c Dr    1,488 

  To commission A/c     1,488 

 Kumaran A/c Dr    12,562 

  To Bank A/c      12,562 

   

 b) Answer key:   

Revaluation Profit 

 A’s capital a/c 1,125 

    B’s capital a/c 375 



 Adjusted capital a/c 

    A’s capital =1,11,125 

    B’s capital =50,375 

    C’s capital =80750 

 New balance sheet of A,B,C = 3,22,250 

25 a) Answer Key 

Journal Entries in the books of Koshi 

 Joint Venture A/c Dr    10,500 

  To Purchase A/c    10,000 

  To Bank A/c           500 

 Joint venture A/c Dr    8,400 

  To Joshi A/c      8,400 

 Joshi A/c Dr     25,000 

  To Joint venture A/c     25,000 

 Joint Venture A/c Dr    1,250 

  To Joshi A/c      1,250 

 Joint Venture A/c Dr    4,850 

  To Joshi A/c     1,940 

  To P&L a/c     2,910 

 Bank A/c Dr     13,410 

  To Joshi A/c     13,410 

Journal Entries in the books of Joshi  

 Joint venture A/c Dr    10,500 



  To Koshi A/c     10,500 

 Joint Venture A/c Dr    8,400 

  To Purchases A/c    8,000 

  To Bank A/c         400 

 Bank a/c Dr     25,000 

  To Joint Venture a/c    25,000 

 Joint venture A/c Dr    1,250 

  To commission A/c    1,250 

 Joint venture A/c Dr    4,850 

  To P&L a/c     1,940 

  To Koshi a/c      2,910 

 Koshi A/c Dr     13,410 

  To bank a/c      13,410 

     b) Answer Key: 

  Total Profit= 3,10,800 

  Average Profit=1,03,600 

  Average Trading profit=91,600 

  Super Profit= 19,600 

  Goodwill= 19,600*3=58,800 

26 a) Answer key  

Revaluation Profit 

 A’s capital a/c 10,050 

 B’s capital a/c 3350 



 Adjusted capital a/c 

    A’s capital =40,050 

    B’s capital =23,350 

    C’s capital =20,000 

 New balance sheet of A,B,C = 1,28,400 

 

26 b)  

1. Sacrifice ratio is calculated at the time of admission of new partner but gaining ratio is 

calculated at the time of retirement of a partner.  

 

2. Total  of each old partner's Sacrifice will be equal to new ratio of new admitted partner. total 

of gaining share of each partner will be equal to the old ratio of retired partner. 

 

3. Goodwill will be distributed at the time of admission in sacrifice ratio. Goodwill will be 

distributed at the time of retirement in gaining ratio. 

 

4. Difference of old ratio and sacrifice ratio will be new ratio but total of old ratio and gaining 

ratio will be new ratio. 
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